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JPA  Designer basics 
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1 Introducing  JPA Designer 
 

 
 
 

 

Welcome to JPA Designer, the design and calculation program from JPA TL Ltd. JPA 
Designer can: 

 
• carry out SAP calculations to SAP versions 9.92, 9.90, 9.81, 9.80 and 9.70, to 

demonstrate compliance with the energy efficiency requirements of Building Reg- 
ulations and Building Standards1 and as part of Code for Sustainable Homes (CSH) 
assessments; 

• lodge On-construction Energy Performance Certificates (EPCs) for dwellings in Eng- 
land and Wales, Scotland and Northern Ireland; 

• assess PV and wind turbine output calculations for feed-in tariff installations; 

• calculate U-values for building elements; 

• carry out condensation risk analysis to BS EN ISO   13788; 

 
JPA Designer includes many features to make the calculation process easier: 

 
• Project-based file system enables you to keep all the calculations for one develop- 

ment in same project file; 

• U-value templates to speed up calculations. 

• Links between U-value and SAP calculations, so that SAP calculations are automat- 
ically updated when U-value calculations  change; 

• Calculation results can be produced as PDF files for  emailing; 

• A database of common materials to speed U-value calculations; 

 
We hope you find JPA Designer a useful calculation tool. We are always happy to receive 
comments, suggestions for improvements or proposals for enhancements to suit your specific  
needs. 

1In order to lodge and issue EPCs you will need to be a member of an accreditation scheme (England and 
Wales, Northern Ireland) or protocol organisation (Scotland). You can find details of our partner schemes 
at   www.techlit.co.uk/training/accreditation. 
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1.1 Conventions for the manual 

The manual uses the following conventions: 

 
• <angled brackets> for keys on the computer keyboard, e.g.  the <Enter> key. 

• the + sign indicates you should hold down one key while pressing another, e.g. 
<Alt+F> means ‘hold down the <Alt> key while pressing the <F>   key’. 

• Bold type indicates parts of JPA Designer’s screen displays, e.g. the Ventilation rate 
dialogue. 

• Menu>option indicates an option in a menu on the program’s menu bar, e.g. Select 
Edit>Primary heating system means click on the Edit menu and select Primary 
heating system from the list. 

 
This manual uses the following special terms: 

 
• Dialogue (dialogue box): a small window which displays text boxes or buttons for 

entering data. 

• Radio button: a set of two or more related buttons - you can only select one at a  time. 

• Tick box: a box which lets you turn a setting on (ticked) or off (not ticked). 

• Text box: an area on a dialogue in which you can type words or   numbers. 

• List: a box on a dialogue which can be expanded to show a number of pre-set 
options, usually by clicking an arrow on the right-hand side of the  box. 

 
Many functions of JPA Designer can be accessed using either the menus or the toolbars: also, 
some may also have  keyboard shortcuts.  To  avoid  repetition this manual refers only  to the 
menus. 

 
1.2 Getting help 

If you have a problem with the functioning of the software please follow these steps: 

 
• Download and install the latest version of JPA Designer from our web site  (see  section 

2.2 for instructions) and see if that resolves the problem. 

• Check the forum and FAQ on our web site (http://forum.techlit.co.uk) to see if the 
problem  is  addressed there. 

• If the problem persists, email details of the problem to support@techlit.co.uk. Please 
include details of your computer system and attach sample files or PDF outputs 
where possible.  We will respond as soon as we can. 

 
If you have difficulty using the program (for example, you are uncertain how to enter a 
layer in a condensation risk calculation) please follow these steps: 

http://forum.techlit.co.uk/
mailto:support@techlit.co.uk
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• Consult the program manual or on-line help system; 

• Check the forum and FAQ on our web site (http://forum.techlit.co.uk) to see if the 
query is addressed  there; 

 
If you are new to condensation risk calculations we offer distance learning and on-line training 
training courses,  which provide a thorough introduction to the software and its  use.  You  can 
find more details at   http://www.techlit.co.uk/training. 

http://forum.techlit.co.uk/
http://www.techlit.co.uk/training


 

 
 
 

2 Getting started 
 

 
 
 
 
 

 

This section of the manual describes how to install JPA Designer on your PC and explains 
how the user registration and on-line licence checking systems work. It also includes 
instructions on adding your company details and logo to reports. 

 
2.1 System requirements 

JPA Designer runs on Windows XP, Windows Vista, Windows 7, Windows 8 (see Tech- nical 
Note 2012/04) and Windows 10.  Apple Macintosh users can run JPA Designer on  a 
Windows virtual machine under Parallels Desktop or VMWare Fusion, or on a Win- dows 
installation using Boot Camp (we do not offer technical support for installing JPA Designer 
on such systems). 

Whatever computer you are using it will require an internet connection to check the 
validity of the licence, to update the BRE Product Characteristics Database for the SAP 
2012 module and to issue EPCs. 

 
2.2 Installation 

To  install JPA Designer on your  PC: 

 
1. Go to our web site at www.techlit.co.uk and right click on the link labelled down-   load 

JPA Designer: select Save link as or Save target as (the exact wording  will depend on 
which the browser you are     using). 

2. Save the installer file jsetup990.exe to your PC (we recommend downloading the 
file to the Desktop). The download is about 6.5  MB. 

3. When the download is complete double click on the file jsetup990.exe. The In- 
stallShield Wizard configures itself and, after a few moments opens. 

You may see a security warning that the publisher of the file could not be identified. 
If you do, click Run to continue the installation process. 

4. Click Next to continue with installation. The installer displays the Licence Agree- 
ment. To continue with the installation click I accept the terms of the licence agree- 
ment, then click  Next. 
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5. At the Customer information screen enter your name and company name and, 
using the radio buttons, select whether you want JPA Designer to be available to all 
user accounts on the computer, or just one. (We recommend you select all.) Click 
Next. 

6. At the Choose Destination Location screen we recommend you accept the default 
settings and install JPA Designer into the folder c:\program files\jpatl\jpa designer 
981. Click Next. The installer will now copy the JPA Designer files onto your 
computer. 

7. When installation has finished the Setup Complete screen is displayed. Tick the box 
labelled Launch the program and click Finish. The installer will close and JPA 
Designer will open, showing you the Project Manager  window. 

 
2.3 User registration 

In order to use JPA Designer you must enter valid user registration details and the program 
must be able to check the status of your licence against our licensing database. We supply 
the user name and key code when you buy a licence for a module. If you do not enter 
your details JPA Designer runs in demonstration mode and will not display the results of 
calculations. 

To enter license details for a module: 

 
1. At the Project Manager window (Figure 2.1) select Edit>User and Security Codes 

from the menu bar. The User Registration dialogue opens (section 2.3). 

2. In the section for the module (e.g. the U-value module) enter the company name – 
exactly as supplied in the registration email – in the box Your company name. 

The company name is case sensitive and should be entered exactly as shown in the 
email: so if, for example, you enter Limited, when the company name with the key 
code contained Ltd the program will not accept the key    code. 

3. Copy the key code from the registration email and paste it into the bottom box on 
the User Registration dialogue. 

4. Click the Apply … code button for the module. The program copies the code into 
the Key code boxes for the module. 

 
If you have bought several modules repeat the steps for each one. 

 
2.4 On-line licence checking 

JPA  Designer checks the validity of your licence for a module the first time you open     a 
calculation after the the program has started. It does this by contacting our on-line 
licensing database and checking the expiry date for module1. 

1The process only looks for the company name and checks the licence status and expiry date on the 
database. 
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Figure 2.1:  The Project Manager window 
 
 
 
 
 
 
 
 
 
 
 

 

Figure 2.2: The User Registration  dialogue 
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• If the check is successful and the licence is valid the module will open. (The pro- 
gram will record the date and time of that successful check). 

• If the program is unable to connect with the database (for example, because you 
are using your lap-top away from your office) it will look at the date of the last 
successful check: if that is less than seven days ago then the module will open. 

• If the program is unable to connect with the database and the last successful check 
is more than seven days ago then it will not open the module. 

• If the check is successful and the licence is not valid the calculation will not  open. 

 
If you often use JPA Designer away from the office there are two features you can use to 
prevent problems with the licence check: 

 
• The Project Manager tool bar displays the length of time since the last successful 

licence check:  provided the values shown are green the module will  open. 

• The Check licence on-line button on the tool bar will force a licence check and re-
set the time since the last check to zero. You should force a check if you expect not 
to have an internet connection for a few days. 

 
2.5 Updates 

JPA Designer is continually being developed to introduce new features: to get the best 
from the program it is worth making sure you are using the latest version. You can find 
the version number by selecting Help>About from the menu bar in JPA Designer and 
compare that with the version number shown on our web site2 (www.techlit.co.uk). 

Higher numbers and letters indicate later releases, with characters coming earlier in the name 
being more important that later ones:  so 4.05a1 will be more recent than 4.04c2,   and 4.05b1 
more recent than 4.04a4. The three digit Build number indicates a  minor change in a version.  
Figure 2.3 shows the About dialogue for JPA  Designer together with  the version number on 
the web site: in this case the software is up to date, as both version numbers are the  same. 

The process for updating the software is identical to that of originally installing it3 (see section  
2.2). 

You can find details of the changes in each version on the announcements section of our 
web forum4. 

You can set JPA Designer to check for updates automatically by ticking the Check for 
updates box on the General tab of the Options dialogue. Whenever you start the program 
it will check the program date stamp against that of the latest installer on our web site. If 
the program is more than a day older than the installer the program will prompt you to 
download the latest version from our web site. 

2www.techlit.co.uk 
3If you are using a version earlier than 5.02a3 you will have to uninstall the program using the Windows 

Add/remove programs or Uninstall programs control panel. 
4http://forum.techlit.co.uk/viewforum.php?f=13 

http://www.techlit.co.uk/
http://www.techlit.co.uk/
http://forum.techlit.co.uk/viewforum.php?f=13
http://forum.techlit.co.uk/viewforum.php?f=13
http://www.techlit.co.uk/
http://forum.techlit.co.uk/viewforum.php?f=13
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Figure 2.3: The About dialogue showing the version  number 

 
2.6 Opening and closing JPA   Designer 

To  open JPA Designer: 
 

• Select Programs>JPA Designer>JPA Designer from the Windows Start menu. 
 
 

 

Figure 2.4:  The New dialogue for JPA  Designer 

 
A splash screen appears when you open JPA Designer. The program can also be config- 
ured to show the New dialogue (Figure 2.4), which prompts you to create new calcula- 
tions or projects. 

If you do not want to use the New dialogue you can tick Don’t show this dialogue on start 
up. Alternatively, you can turn the option on or off in the Options dialogue (chapter 36). 

To  close JPA Designer: 
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• Select File>Exit from the JPA Designer menu bar. The program will prompt you to 
close any files which have not been saved. 

 
2.7 Uninstalling  JPA Designer 

To  uninstall JPA Designer: 

 
1. Open the Windows Add/Remove programs control panel (to access Control Panels 

select Settings>Control Panels from the Start menu). 

2. Select JPA  Designer in the Add/Remove Programs Properties dialogue and    click 
Add/Remove. Windows will uninstall the program files and remove its icons. 

Uninstalling the program will not remove any JPA Designer project files. 

 

2.8 Adding your company details to reports 

Most of the reports produced by JPA Designer can be customised to include your company 
name, address and logo. The details are added using Options dialogue from the main 
Project Manager window (see section 2.8). The logo must be a 256 colour BMP format 
file5. 

It is also possible to set up details for several different companies within JPA  Designer:   these 
sets of address details and logos are referred to as identities (see section 2.8).  You   can switch 
between identities to produce calculation reports with different addresses and logos. 

 
Setting up address details 

 
 
 
 
 
 
 
 

Figure 2.5: The Options dialogue - General tab 

To set up your company details and logo for reports: 

5If you have the company logo in a different format, such as a jpeg, tiff or png, you can use the free 
Paint program which comes with most versions of MS Windows™ to convert it to the right format and to 
set the correct colour depth. 
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1. In  the  Project  Manager  window,  select  Options  from  the  menu  bar.   The Options 
dialogue opens. 

2. In the General tab enter your company name, address, phone and email details in 
the Company name & address section (see Figure 2.5). 

3. Tick the Print Logo & Address  box. 

4. Enter the wording of any disclaimers which you want to appear at the bottom of U-
value and SAP reports in the U-value disclaimer and SAP  boxes. 

5. If you have entered wording for the U-value and/or SAP disclaimers tick the Print 
U-value disclaimer and/or the Print SAP disclaimer boxes. 

6. Click the Logo & Signature tab. 

7. In the Logo position section enter the location of the Top and Left sides of the logo, 
relative to the page, and enter the Width of the logo. All dimensions should be in 
millimetres. It will probably take some experimentation to get the logo position and 
size correct. 

8. Enter the name of the Logo file, including the .bmp extension, then click OK to close 
the dialogue. 

9. Copy or move the logo file to the folder containing the user data. On Windows 7 
this will be c:\ProgramData\JPA\JPA  Designer. 

Note: The Certificate signature position and associated settings are no longer in 
use. 

 
If you are a competent person under the TIMSA/BBA U-value competency scheme you 
can configure JPA Designer to add the scheme logo to your  calculations: 

 
1. Click the Logo & Signature tab. 

2. In the TIMSA logo position section enter the location of the Top and Left sides of the 
logo,  relative to the page,  and enter the Width of the logo.  All dimensions should   be  
in millimetres. 

It will probably take some experimentation to get the logo position and size correct. 

3. Enter the name of the Logo file, including the .bmp extension, then click OK to close 
the dialogue. 

4. Copy or move the logo file to the folder containing the user data. On Windows 7 
this will be c:\ProgramData\JPA\JPA  Designer. 

5. If you want the TIMSA logo to be used by default tick Default to print TIMSA logo. 

You  can always override the default setting in the Sections To  Print   dialogue. 
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Setting up identities 

The procedure for setting up identities is similar to that for setting address details: 

 
1. Enter the details for the first company as described in section 2.8. 

2. Re-open the Options dialogue. 

3. In the Identity list select the first blank identity (usually labelled Blank 1).         The 
Company name & address and disclaimer information will be  cleared. 

4. Enter the details for the second company, including the data in Logo and signature 
tab.  Click OK to close the dialogue and save the  data. 

5. Repeat steps 2–4 for any further   identities. 

 
As you add identities they will be added to the Identities list, using the Name of the 
company in the list. If you need to edit the data for any one of the identities, select it 
from the Identities list, make the changes and click OK. JPA Designer allows you to set up 
to twenty distinct identities. 

If you need to copy the address details in identities between different computers (this          is 
often done to ensure every user in a company has the same details set up) you can        use 
the Copy to clipboard and Paste from clipboard buttons to the right of the Identities 
dropdown in the Options dialogue (see Figure 2.5). 

When you come to create a PDF of a report or to print it you will be able to select one  of 
the identities to use the associated details in the header. Note that whichever identity you 
select when producing a report, the report footer will always show the name of the 
company or individual holding the  licence. 



 

 
 
 

3 Managing  projects  and calculations 
 

 

 

This chapter explains how JPA Designer stores calculations and describes how to work 
with project files and calculations. It describes how to use calculation templates to speed 
up the calculation process. 

 
3.1 The project file 

JPA Designer organises and saves calculations in project files, which have the  extension 
JDP. You can save multiple calculations in the same file. 

Calculations are created, saved and managed in the JPA Designer Project Manager win- 
dow (Figure 2.1), which lists all the calculations in the current project. 

 
3.2 Starting a new project 

Whenever you start JPA Designer the program creates a new blank project which you can 
use straight away. You can also create a new project at any time by selecting File>New 
Project from the main menu, or clicking the New Project button on the toolbar. 

You can change the default project name A blank project to something more useful: 

 
1. Click once on the project name and select Edit>Rename selected item. The Project 

name dialogue opens (Figure 3.1). 

2. Enter the new name for your project, then click OK. 

3. The project is renamed 

The project name does not affect the calculations in any   way. 

 
 

3.3 Adding project address details 

You  can enter client address and site details for a project, which you can then copy to  all 
the individual calculations within that project. You can enter and edit that informa- tion 
using the Project Address dialogue (Figure 3.2). You can also store client address 
information to reuse in other projects. 

To add client and project details: 
 

13 
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Figure 3.1: Changing the name of a  project 

 

Figure 3.2:  The Project Address dialogue 

 

1. From the menu bar select Edit>Project Address. The Project Address dialogue 
opens. 

2. Enter the data by typing it into the appropriate boxes. Use the <Tab> key to move 
between  boxes. 

Do not try to enter data in the top left hand box: this box is used for retrieving 
details you have previously stored. 

3. If you want to store the client details to re-use later click Add to clients. 

4. Click OK when you have entered all the data you  need. 

 
To copy the project address details to all the calculations in a project: 

 
1. Enter the address details in the Project Address dialogue. 

2. Click Pass down. 
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3. Click Yes at the confirmation  dialogue. 

4. Once the copying is done click OK. 

 
You can also copy project address details to individual calculations once you have opened 
the calculations (see section 4.1). 

To re-use existing client data simply click on the list at the top of the Project information 
dialogue and select a client name (Figure 3.3). 

If you need to edit the details held for clients click Edit clients list then make the changes 
in the Edit Clients dialogue. 

 

Figure 3.3: The client name and address  list 

 

 

3.4 Setting the calculation region 

JPA Designer is designed to carry out the thermal calculations required in different regions 
of the world. Some regions require U-value calculations, while others require R-value 
calculations: some regions only consider one-way heat flow while others require two- 
directional heat flow (see Table 3.1. The region settings also determine the climate data 
available for condensation risk analysis. 

 

Table 3.1: Regional calculation settings 
 

Region Calculation type Heat flow 

Asia U-value Heat-out 

Australia R-value Heat-in/heat-out 

Ireland U-value Heat-out 

Middle East U-value Heat-in/heat-out 

New Zealand R-value Heat-in/heat-out 

UK U-value Heat-out 

 

The calculation region can be set in the Project Address dialogue (see Figure  3.2): 

 
1. Select the Region in the list. 

2. Click Set as default. 

3. All new calculations will use that  region. 

 
You can override the region setting for individual calculations in the Project Information 
& Options dialogue. 
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3.5 Saving projects 

JPA Designer project are saved in the same way as any other file: 
 

1. From the menu bar select File>Save Project. The Save As dialogue opens. 

2. Select the folder into which the project should be saved, enter a name for the project 
file. 

By default JPA Designer will add the extension JDP to all file names. 

3. Click Save. JPA Designer saves the project and displays the file name on the program 
title bar. 

 

By default JPA Designer will save files into the JPA Designer user data folder (on Windows 
7 usually c:\ProgramData\JPATL\JPA Designer 981). You can specify a different default 
folder by specifying the startup folder using the Options dialogue). 

 
 
 
 
 
 
 

Figure 3.4: Startup folder controls in the Options dialogue 

To specify the startup folder: 
 

1. From the menu bar select Options. 

2. On the General tab click the Select button for the Startup folder (item 1 in Fig- 
ure 3.4). 

3. In the Browse For Folder dialogue select a folder and click OK. 

4. The folder will now be the default location for saving JPA Designer files and PDF 
files of calculation reports. 

 

We recommend you have a regular back-up schedule for your data. 

 
3.6 Opening projects 

To open an existing project: 
 

1. From the menu bar select File>Open project.  The Open dialogue opens. 

2. Select the file you want to work with, then click Open.      The project opens in the 
Project Manager window. 
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3.7 Adding calculations to a  project 

You can add new calculations to a project in the Project Manager window. 

To  add a new U-value calculation to a  project: 

1. From the menu bar select Insert>U-value calculation. The Description dialogue 
opens (Figure 3.5). 

2. Type a name for the calculation in the Description dialogue, e.g. warm roof, and 
click OK. The new calculation is added to the   project. 

 
 

 

Figure 3.5:  The Description dialogue 

 
To add a new SAP calculation to a project: 

 
1. From the menu bar select Insert>Dwelling/SAP (v9.92 2012) calculation>Single 

dwelling.  The Description dialogue opens (Figure 3.5). 

2. Type a name for the calculation in the Description dialogue, e.g.  Plot 23, and click 
OK. The new calculation is added to the  project. 

 
You can also use the Insert menu to insert calculations to versions 9.90, 9.81, 9.80 and 
9.70 of SAP, as well as SAP calculations for multiple dwellings. Follow the same basic 
procedure to add PV assessment and Psi-value assistant calculations to a project. 

When naming U-value and SAP calculations avoid using the Windows restricted char- 
acters ’ /\ : * ? < > |, otherwise you will have problems creating PDFs of calculation 
reports (see chapter 12 for a more detailed explanation. 

 
3.8 Using U-value calculation templates 

JPA Designer offers a range of standard U-value calculations, which you can use to speed 
up the calculation process and minimise repetitive work. We refer these standard calcu- 
lations as U-value templates. Each template contains the same information as a normal 
U-value calculation including element definitions, layers with bridging details and cor- 
rection factors. 

You can either use the template ‘as is’ without modifying it, or use it as a starting point to 
produce your own calculation, but whichever route you chose, the calculation process 
will  be quicker. 

There  are three types of U-value  template: 
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• standard templates for roofs, walls and floors. These are generic calculations which 
can be adapted by changing materials and thicknesses. They are supplied with the 
program. 

• manufacturers’ templates. A number of construction product manufacturers have 
supplied U-value templates for typical constructions featuring their products. The 
templates are supplied with the program1. 

• user-defined templates. These are calculations which you have previously per- 
formed and then saved as a template, enabling you to build up a library of com- 
monly used calculations. See section 3.8 for  instructions. 

 
Inserting a U-value calculation from a   template 

The  controls for inserting U-value calculations based on templates are at the bottom  of    the 
Project Manager window (Figure 3.6).  To  insert a new U-value calculation based on       a 
template: 

 

Figure 3.6: The template selection controls 

 
 

1. In the Categories list select the type of template you want. That may be a manufac- 
turer’s category, one of the default categories, or a template group you have created 
previously. 

2. In the Templates drop-down list pick the template you wish to use. 

3. Click New U-value from Template.  The Description dialogue  opens. 

4. Edit the name of the template to suit your project, or accept the default name. Once 
you are ready,  click OK. 

5. A new U-value calculation is added to the  project. 

6. You can now open and edit the calculation by double-clicking on its name in the 
Project Manager list. 

 
Creating user defined templates 

You can create templates from your own U-value calculations by saving them in JPA 
Designer template files, which have the file extension JTF. You can have several different 
template files which allows you to sort the calculations into groups: you might have one 

1If you are a manufacturers of construction materials you can add U-value calculations which include 
your materials into the set of templates which is distributed with JPA Designer. Offering U-value cal- 
culations with your materials makes it easier for designers to include them in U-value calculations and 
specifications and helps to ensure the materials are included in calculations correctly. Please contact JPA 
TL Ltd for information and current pricing. 
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for wall calculations and one for floor calculations, alternatively, you might divide them 
into masonry or timber framed calculations. 

The simplest way to create a template file is to use the Import U-value feature to collect 
all the existing U-value calculations you want available into one project then save the 
project as a template file. 

To import an existing U-value calculation to a  project: 
 

1. Start a new project in JPA Designer:  on the File menu click  New. 

2. On the File menu click Import U-value from another JPA Designer   project. 

3. In the Open window select the file which contains the  calculation. 

4. At the Import U-value from Project dialogue (Figure 3.7)select the U-value calcu- 
lation from the list and click  OK. 

5. The U-value calculation is added to the open  project. 

6. Repeat the process to import all calculations you want into the project. 
 
 

 

Figure 3.7:  The Import U-value dialogue 

 
You can, of course, create new calculations for the template if you want to. 

The name which appears in the Categories list is taken from the project name in the 
Project Manager window. So before you save a template file you should change the 
project name to something which will help you identify the calculations from the list 
(Figure 3.8)2. 

To set the project name: 

2The default A Blank Project will be no help at all a few weeks after you have created the template. 
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Figure 3.8: Changing the project name 

 

1. In the Project Manager window double click on the project name – the default 
value is A blank project. 

2. In the Project Name dialogue type a new name for the project. 

 
The  template file must be saved in the same folder as the other JPA  Designer user data   
files and in the JTF format.     To  save a project as a template: 

 
1. On the File menu click Save Project as  Template. 

2. Enter a File name. 

3. Set the folder to the user data folder (in Windows 7: c:\ProgramData\JPA\JPA 
Designer). 

4. Make sure Save as type is set to JPA Designer U-value Template (JTF) and click OK. 

5. Your template project is now included in the Categories list. 

 
3.9 Opening  and  closing calculations 

To open a calculation from the Project Manager window, either: 

 
• double click on the calculation name; or, 

• click once on the calculation name, then from the menu bar select Edit>Selected 
item. 

 
To close a calculation and return to the Project manager window click the Project man- 
ager button on the tool bar. 
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3.10 Duplicating calculations 

If you want to carry out a calculation which is very similar to an existing calculation in a 
project you can duplicate the calculation and then change the copy, leaving the original 
calculation untouched.  To  duplicate a calculation: 

 
1. In the Project Manager window click once on the calculation to select  it. 

2. From the menu bar select Edit>Duplicate item. The Description dialogue  opens. 

3. Type a name for the duplicate calculation and click OK. A copy of the original 
calculation is added to the project. 

When naming a calculation avoid using the Windows restricted characters ’ /\ : * ? 
< > |, otherwise you will have problems creating PDFs of calculation reports (see 
chapter  12)  for  a  more  detailed explanation. 

 
You can now work with the duplicate calculation in the usual way. 

 
3.11 Importing U-value calculations 

When you need to re-use an existing U-value calculation in a new project you can import 
a copy of the calculation from its original project into a new  one. 

To import a calculation into the current project: 

 
1. On the Program Manager File menu select Import U-value from another JPA De- 

signer project. 

2. In the Open dialogue select the project containing the original U-value calculation. 
Click  OK. 

3. In the Import U-value from Project dialogue click on the calculation to select it, 
then click OK. The U-value calculation is copied into the current project. 

 
Importing existing U-value calculations into a new project is a quick way of building a set 
of U-value templates (see section  3.8). 

 
3.12 Converting between SAP versions 

JPA Designer can convert SAP calculations carried out under one version of SAP to a later 
version of SAP or to an earlier one. You may need to do this when the Building Regulations 
compliance calculation is based on one version of SAP, but the EPC has to  be issued using 
the another version of SAP. The program takes a copy of the data from the original 
calculation and converts the copy to the required version, leaving the original calculation 
untouched. 

You  can convert: 

 
•  SAP 2001 (V9.70) to SAP 2005   (V9.80/9.81); 
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•  SAP 2005 (V9.81) to SAP 2009 (V9.90); 

•  SAP 2009 (V9.90) to SAP 2012 (V9.92); 

•  SAP 2009 (V9.90) to SAP 2005   (V9.81). 

•  SAP 2012 (V9.92) to SAP 2009   (V9.90). 

 
To  convert a calculation: 

 
1. Select the calculation in the project list by clicking on it once. 

2. From the Edit menu select the appropriate Copy selected … item. 

3. JPA Designer creates a copy of the original calculation in the new format. The copy 
has the same name as the original, but appended with the new format (for example, 
SAP version 9.92). 

 
Once you have carried out the conversion you should check the new calculation, partic- 
ularly when converting to a newer version of SAP, as there may be additional information 
which you need to enter. Where building services information has been taken from the 
boiler database (SAP 2001 and SAP 2005) or the Product Characteristics Data File (SAP 
2009 and SAP 2012) you should re-select the systems in the converted calculation. 

Finally, it is also possible to import SAP 1998 (9.60) calculations from JPA SAP v23 and 
convert them to SAP 9.70: 

 
1. From the menu bar select Import JPA SAP file into this Project. 

2. In the Open dialogue select the JPA SAP file you wish to  import. 

3. JPA Designer creates a copy of the original calculation as a SAP 2001 (V9.70) cal- 
culation. 

 
3.13 Renaming calculations 

To change the name of a  calculation: 

 
1. In the Project Manager window click once on the calculation to select  it. 

2. From the menu bar select Edit>Rename selected item. The Name dialogue opens. 

3. Enter a new name for the calculation and click OK. The Project Manager window 
shows the new name. 

When naming a calculation avoid using the Windows restricted characters ’ /\ : * ? 
< > |, otherwise you will have problems creating PDFs of calculation reports (see 
chapter  12  for  a  more  detailed explanation. 

 
Changing the name of the calculation will not affect the calculation results. 

3JPA SAP v2 was the precursor of the JPA Designer SAP module. 
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3.14 Deleting  calculations 

Calculations can be deleted from JPA Designer projects. 

WARNING: there is no way of recovering a deleted calculation. 

To  delete a calculation: 

1. In the Project Manager window click once on the calculation to select  it. 

2. From the menu bar select Edit>Delete selected item. JPA Designer asks you to 
confirm the deletion. 

3. Click Yes to delete the calculation or No to abandon the deletion.     If you click Yes 
the calculation is removed from the    project. 

 
3.15 Merging projects 

Using the Merge projects function you can copy all the calculations in an existing project 
into the currently open project. This can be useful if you have a number of standard 
calculations stored in different projects which you need to bring together for a particular 
job. Merging does not change the project you are copying from. 

To merge calculations from one project into another: 

 
1. In Project Manager open or create the project you want to receive the calculations. 

2. From the menu bar select File>Merge a project from disk into this Project.     The 
Open dialogue appears. 

3. Select the file which contains the calculations and click Open. JPA Designer adds the 
calculations to the current project and lists them in the Project Manager win- dow.  
You can now edit them without affecting the original project. 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Part II 

U-value  calculations 
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4 The JPA Designer U-value modules 
 

 
 
 
 
 

 

JPA Designer offers two U-value modules: 

 
• U-value 2014 calculates U-values for walls, roofs and intermediate floors using the 

combined method (BS EN ISO 6946: 2007) and also calculates U-values for ground 
floors to BS EN ISO   13370:2007. 

• U-value 2014 Professional has the functionality of U-value 2014 and also performs 
condensation risk analysis using the methods set out in BS EN ISO   13788:2012. 

 
U- value calculations are carried out in the U-value module  by: 

 
1. Entering project information (section 4.1). 

2. Setting key information about the construction as a whole, such as the element 
type (e.g.wall, floor, roof) and any special construction types (e.g. metal frame) 
(chapter 5); 

3. Defining the different layers which make up the element (chapter 7); 

4. Adding correction factors for factors such as mechanical fasteners and air gaps in 
insulation layers (chapter 8). 

5. Printing calculation results, or creating PDF files of the results for emailing (chap- 
ter 12). 

 
You can test the effect different materials have on the thermal performance of the element 
by using the variable layer  feature (section   9.4). 

The details of U-value calculation are shown in the main U-value window (see Figure 4.1). 
The window shows the layers which make up the construction: each layer has thermal 
and vapour data, and may have thermal bridge data. The results of the calculation are 
shown at the bottom of the window. 
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Figure 4.1:  The U-value  window 

 
4.1 U-value project information 

JPA Designer can store client and project details for each calculation and then add them 
to calculation reports. You can either the copy client and project details which you 
entered in the Project Information dialogue in the Project Manager window, or you  can 
enter new data in the U-value modules. You can also save and re-use client data (see 
section 3.3). In either case you can select the Region for the calculation (see section 3.4 
for an explanation of how region settings affect calculations). 

To copy project details from Project Manager: 

 
1. In the U-value module select Edit>Project Information from the menu bar.      The 

Project Information dialogue opens. 

2. Click the Inherit button. 

3. At the prompt choose whether you want the calculation to inherit the region settings 
for the project or  not1. 

4. Any information you entered in Project Manager is copied to the Project Informa- 
tion dialogue here. 

5. Click OK. 

1In most cases you will want to inherit the project region settings. 
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To enter new project details: 

 
1. In the U-value module select Edit>Project Information from the menu bar.      The 

Project Information dialogue opens. 

2. Enter project information by typing it into the appropriate fields.  Use the   <Tab> 

key to move between   fields. 

3. If you need to use a region other than the default, select the new Region in the list. 

4. Click OK when you have entered all the data you  need. 

 
To copy project details from the current calculation to all other calculations in  project: 

 
1. Enter the address details in the Project Information and Options dialogue. 

2. Click Pass down. 

3. At the Information dialogue click Yes. 



 

 
 
 

5 U-value Construction Dialogue 
 

 
 
 
 
 

 

The thermal performance of building element will be affected by the type of element and 
its position within a building. These conditions are set in the U-value Construction 
dialogue (Figure 5.1), which has three tabs: 

 
• Element Details: described below. 

• Unheated spaces: used to allow for the effect of unheated spaces on the thermal 
performance  of  building  elements.  See  section 8.7. 

• Print Report Notes: this tab allows you to add notes to the calculation which will 
appear on the PDF or print calculation report. Typically used to set out any as- 
sumptions made in the calculation. 

 
The Element Details tab accepts information on: 

 
• The Element type: that is, whether it is a floor, wall or roof, together with additional 

information for some elements (section 5.1). 

• The conditions at the internal and external surfaces (see section 5.2). 

• Details of any light steel frame construction (see section 9.1). 

• Details of twin-skin metal roofing or cladding (see section 9.2). 

• Corrections factors for mechanical fasteners (see chapter 8). 

 
To  enter data: 

 
1. From the menu bar select Edit>Construction type. The U-value Construction dia- 

logue opens (Figure 5.1). 

2. Enter your data and click  OK. 

For some constructions, such as those with mechanical fasteners, you may find it 
easier to enter some of the data in the construction dialogue after you have entered 
the layers of the element. 
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Figure 5.1:  The U-value Construction dialogue 

 
5.1 Element type 

JPA Designer recognises several types of element which have  to be treated differently in  the 
calculation process. Use the radio buttons in the Element type section to select the  type of 
floor, wall or roof. Some elements have options for entering additional informa-  tion. 

The available element types are: 

 
• Flat roof : a roof with a pitch typically less than 10°. There is an option to enter data  for 

an inverted roof (section   9.3). 

• Wall: any construction at an angle of more than 70° to the horizontal. There is an 
option to enter data for brackets and rails in rainscreen cladding (section 8.4), or 
for windposts supporting masonry (section 8.5). 

• Floor other than ground floor: a floor over an open space (e.g. a parking bay) or an 
unheated space (e.g.  an enclosed garage).  There is an option to enter brackets for     a 
cladding system on the   soffit. 

• Pitched roof with horizontal ceiling (legacy): typically a cold pitched roof with the 
insulation applied between and over the ceiling joists. You must enter the pitch 
(angle) of the roof, measured from the horizontal. There is an option to correct for 
the effect of the loft hatch, see section 8.6. 
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This element type represents the method of treating cold pitched roofs which was in 
use before the introduction of BR 443, as it contains a loft space with a fixed thermal 
resistance and will adjust the resistance of any layers above the loft for the pitch. 
New calculations to comply with BR 443 should use one of the BRE443 Pitched roof  
element types. 

• Pitch roof ceiling at rafter line: a warm roof with the insulation in the plane of the 
rafters. 

• BRE443 Pitched roof – insulation at ceiling level: a cold pitched roof with insulation 
applied between and over the rafters. The thermal resistance of all layers above the 
insulation is represented by a single layer selected from the Roof construction list, 
using thermal resistances taken from ISO 6946. There is an option to correct for the 
effect of the loft hatch: see section 8.6 

• BRE443 Pitched roof – insulation at rafter level, flat ceiling: warm roof, with the 
insulation applied at rafter line (between, below or above the rafters, or a combina- 
tion of those), but a horizontal ceiling. Specify the roof pitch in degrees (measured 
from the horizontal) to correct for the insulation being in a different plane to the 
ceiling. 

• Suspended ground floor: a floor with a ventilated space below the floor deck, such 
as a beam and block floor or timber joist floor. See chapter 10. 

• Solid ground floor: a floor which is contact with the ground across its whole area, 
such as groundbearing concrete slab. See chapter 10. 

• Basement wall:  a below ground wall of a heated basement.  See chapter 11. 

This calculation requires information about the basement floor construction. 

• Basement  floor.  See  chapter 11. 

 
You can also enter a description for the element in the Description box, or select one 
from the drop-down list. The description does not affect the calculation 

 
5.2 Internal and external surfaces 

U-value calculations take account of the heat flow at the internal and external surfaces of  an 
element by means of the internal and external surface resistances.  Those resistances    are 
affected by the direction of heat flow through the construction and the emissivity of    the  
exposed surfaces. 

The surface resistances used in the calculation are shown in the two Surface Resistance 
boxes. The program sets the surface resistances based on the element type (section 5.1)  and 
the emissivity of the surfaces,  using the values from BS EN ISO 6946 shown in Ta-        ble  5.1. 

The default emissivity setting is high emissivity which suits the great majority of facing 
materials1. You can, of course, replace the default resistances with your own values in 
the very rare cases where that is necessary. 

1There are very few conditions where it is necessary to set the emissivity to low. 
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Table 5.1: Surface resistances 
 

Heat flow Element Internal resistance (Rsi) External resistance (Rse) 

Horizontal Wall 0.13 0.04 
Upwards Roof 0.10 0.04 

Downwards Floor 0.17 0.04 

 

5.3 Light steel frame construction type 

U-values for light steel frame structures have to be calculated using a special method 
which allows for the high thermal conductivity of steel. The Light steel-frame Construc- 
tion Type section indicates whether the structure has a light steel frame, and if so, whether 
it is of warm or cold construction. 

For non-steel frame structures ensure Not a light steel frame construction is selected. For 
instructions for calculating U-values of light steel frame structures see section 9.1. 



 

 
 
 

6 Working  with layers 
 

 
 
 
 
 

 

Each U-value calculation is built up by inserting layers which correspond to the different 
materials in the construction. For example, a U-value calculation for a cavity wall would 
have a layer to represent each of: 

 
• the outside surface  resistance; 

• the outer leaf of brickwork; 

• the cavity; 

• the cavity insulation; 

• the inner leaf of  masonry; 

• the plaster finish; 

• the  internal  surface resistance. 
 
 

 

Figure 6.1:  The new layer will be inserted above the selected  layer 

 
You can add layers to the calculation by inserting materials from the program’s extensive 
database, which includes data for generic materials and cavities, as well as branded products 
from a number of manufacturers.  For many common constructions it is possible   to insert all 
the layers from the database.  If you cannot find a material in the database   then you can 
insert a blank layer and edit the information yourself. 

The  program always adds a new layer  directly above the currently selected layer,  so  in 
Figure 6.1 the new layer would be inserted above the polyethylene and below the 
plywood  sheathing. 
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When you start a calculation you should select the lowest layer (which will be the inside 
surface resistance for walls and roofs, and the outside surface resistance for floors) before 
beginning to add layers. Because layers are of this it is quicker to work from outside to 
inside for wall and roof calculations and from inside to outside for floor  calculations. 

 
6.1 Inserting layers from the Products database 

 

Figure 6.2:  The Products Database window 

 
The Products Database contains a wide range of  materials  and  cavities  for  use  in  U-  value 
calculations. By default it contains a range of manufacturers products and generic, unbranded 
materials. You can also add other products which you use frequently to the database. 
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The Products database is accessed using the Products Database window (Figure 6.2). The 
window has three main parts: 

 
• The Categories box, which is used to select the type of material you want to use. 

Categories of branded materials are shown in bold, categories of generic materials 
in normal text, user categories in italics (see chapter 13 for information on adding 
your own materials) and deprecated generic categories in red text. 

• The Products box, which you use to select a material from a particular category. 

• The Construction box which shows the order of layers in the construction. 

 
To insert layers using the Products Database: 

 
1. In the layers list select the existing layer which will be below the new layer (see 

Figure 6.1). 

2. On the Insert menu click Layer from database (or click the Database button on the 
toolbar). The Products Database dialogue opens. 

3. Use the scroll bar on the Categories box to find the manufacturer or type of material 
you need, then click on that category. The Products box shows the material in that 
category. 

4. Click on a material to select it, then click Add to construction (alternatively you can 
double click on the material in the Products box). The Thickness dialogue  opens. 

If the material has a set thickness the layer will be added without the Thickness 
dialogue opening. 

5. Enter the thickness of the layer then click OK. The Construction box now shows the 
new layer. 

6. You can now add more layers from the database, using the Construction box to 
control the position of the new layers. 

7. When you have finished adding layers click Close. The main U-value window now 
shows the calculation with the new layers added. 

 

 
The two buttons immediately below the products list can be used to download 
spreadsheets containing the source data for the new and original generic materials. 
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6.2 Inserting blank layers in a  calculation 

When you need to use a material which is not in the Products Database you should insert     
a blank layer then edit it to insert the correct data. 

To insert a new blank layer: 

 
1. Select the existing layer which will be below the new   layer. 

2. From the menu bar select Insert>Blank layer (alternatively you can press <Insert>). 
The new blank layer is added to the calculation above the existing   layer. 

3. Double click on the layer to open it for  editing. 

 
6.3 Managing layers 

Once you have added layers to your calculation you change their order, cut, copy and 
paste them, or delete them. 

 
• Moving a layer: 

– Click and hold the right-hand mouse button on the layer number at the left- 
hand side of the window. 

– Drag the layer to a new position. 

– Release the mouse  button 

• Cutting a layer: removes a layer from the calculation but keeps it available on the 
clipboard. 

 

– Click on the layer to select it. 

– Click the Cut button on the toolbar. 

– The layer is deleted from the calculation but remains on the clipboard for 
pasting. 

 

• Copying a layer: puts a copy of the layer on the  clipboard. 

– Click on the layer to select it. 

– Click the Copy button on the toolbar. 
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– The layer remains in place but is copied to the  clipboard. 

• Pasting a layer: places the layer on the clipboard into the  calculation. 

– Click on the layer which you want to be below the pasted   layer. 

– Click the Paste button on the tool bar. 

– The layer on the clipboard is placed in the calculation above the selected layer. 

• Deleting a layer: removes a layer permanently from the calculation. 

– Click on the layer to select it. 

– Click <Delete>. 



 

 
 
 

7 Working with materials 
 

 
 
 
 
 

 

The properties of layers are entered and edited in the Edit Material dialogue, which has 
three tabs: 

 
• General – used to set the basic characteristics of the material (section 7.1). 

• Repeating Thermal Bridges – used to set thermal bridging (section 7.4). 

• Correction factors – used to set correction factors for mechanical fasteners and air 
gaps (chapter 8). 

 
To  edit the properties of a  layer: 

 
1. Click on the layer to select. 

2. From the menu bar select Edit>Layer (alternatively, double click the layer, or press 
<Enter>). The Edit Material dialogue opens. 

3. Amend the data for the layer and click  OK. 

 
7.1 General characteristics 

The General tab (Figure 7.1) contains the basic data about the layer,  including: 

 
• Description: the name of the material or a description, which appears in the cal- 

culation. 

• Code and Category : used with the database to sort or enter materials – but not in 
general use. 

• Thickness: the cross-sectional thickness of the layer, measured in mm. 

• Thermal conductivity: the rate of conduction heat transfer through 1m of the ma- 
terial, measured in W/mK. Usually referred to as the lambda value. 

• Thermal resistance: the resistance to heat transfer provided by the layer, measured 
in m2K/W. 

• Vapour resistivity: the rate of transfer of water vapour through 1 m of the material, 
measured in MNs/gm. 
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Figure 7.1: Edit Material dialogue – the General tab 

 

• Vapour resistance: the resistance to water vapour provided by the layer, measured 
in MNs/g. 

 
The following two values are only required for κ-value calculations. 

 
• Density:  the mass per cubic metre of the material, measured in kg/m3. 

• Specific heat capacity: the amount of energy required to raise the temperature of 
one kilogram of the material by one Kelvin (equivalent to 1 degree Celcius). kJ/kg. 

 
The tab also includes the definition of the material Type (see section 7.2 and section 7.3). 

The two-directional heat-flow settings are not used for calculations in the UK. 

 

7.2 Types of material 

Layers within building elements have different combinations of thermal and hygrothermal 
properties, which have to be address in U-value and condensation risk calculations. JPA 
Designer use four types of solid material and three types of cavity (see section 7.3). In 
addition, the program distinguishes between materials which are thermal insulation and 
those which are not. The rest of this section describes those types of layer and cavity, and 
the data required for each one. 
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Normal 

Normal materials have the same composition all the way through, so the thermal resis- 
tance of a normal layer is calculated from the material’s conductivity and thickness, and 
the vapour resistance is calculated from the thickness and vapour resistivity. A normal 
material requires the following information: 

 
• Type: select Normal. 

• Description : type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal conductivity: enter in W/mK. 

• The program calculates the Thermal resistance in m2K/W. 

• Vapour resistivity: (only required if you will be carrying out condensation risk anal- 
ysis) enter in MNs/gm. 

• The program calculates the Vapour resistance in MNs/g. 

 
Composite materials 

For composite materials, for example insulation-backed plasterboard, there is no direct 
link between the conductivity, thickness and thermal resistance. You must therefore use 
the thermal resistance for the specific configuration of the material (this will usually be 
supplied by the manufacturer of the product). The same principle applies to the vapour 
resistance. 

A composite material requires the following information: 

 
• Type:  select Composite. 

• Description : type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal resistance: enter in m2K/W. 

• Vapour resistance: (only required if you will be carrying out condensation risk 
analysis) enter in MNs/g. 

 
Fixed vapour resistance materials 

Some materials – such as glass and metals – have vapour resistances which are effectively 
infinite, even if they are used in very thin layers. The fixed vapour resistance material type 
allows the thermal performance of these materials to behave in the same way as normal 
materials (changing according to the thickness), but allows their vapour resistances to be  set  
as  very  high  fixed  values  (typically 100 000 MNs/g). 

As materials with fixed vapour resistances behave the same way as normal materials in 
thermal calculations you need only use the type in condensation risk calculations. A fixed 
vapour resistance material requires the following information: 
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• Type: select Fixed vapour resistance. 

• Description: type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal conductivity: enter in W/mK. 

• The program calculates the Thermal resistance in m2K/W. 

• Vapour resistance: enter in MNs/g. 

 
Membranes 

Membranes, such as vapour control layers or vapour open roofing underlays, are treated 
as having no thermal resistance. The only property they have is their vapour resistance. 
Membranes require the following information: 

 
• Type:  select Membrane. 

• Description : type a description of the layer – this will appear on the report. 

• Vapour resistance: enter in MNs/g. 

 

 

Thermal insulation 

The European product standards  for  factory  manufactured  thermal  insulation1  require  the 
thermal resistance values of the applicable insulants be rounded down to the nearest 
0.05 m2K/W2. To comply with that requirement JPA Designer rounds down the thermal 
resistance of all layers which are marked at thermal insulation. 

To mark a layer as thermal insulation tick the is thermal insulation box in the Edit mate- 
rial dialogue. The original value for thermal resistance will appear in the Edit material 
dialogue (e.g. 2.348 m2K/W) while the U-value window will show the rounded value (e.g.  
2.30 m2K/W). 

By default, rounding is on: this is indicated by red text in the status bar of the U-value 
window. However, as there may be occasions when you need to carry out calculations 
without rounding, the feature may be turned off and on: 

1The series runs from BS EN 13162:2001 Thermal insulation products for buildings. Factory made 
mineral wool (MW) products. Specification to BS EN 13172:2001 Thermal insulating products. Evaluation 
of conformity. There is one standard for each major thermal insulation material 

2The standards state: the value of thermal resistance, R90/90, shall be …rounded downwards to the 
nearest 0.05 m2K/W, and declared as RD  in levels with steps of 0.05  m2K/W. 
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Figure 7.2:  Controls for rounding of thermal    resistance 

 
1. On the Project Manager menu bar select Options. 

2. Click on the Other  tab. 

3. (Figure 7.2). 

4. Untick Round down thermal resistance to turn rounding off. 

 

7.3 Types of cavity 

JPA Designer recognises five types of cavity: 

• clear cavities: cavities with limited air exchange with outside, and no thermal bridg- 
ing. 

• bridged cavities: cavities with limited air exchange with outside and which are 
thermally bridged. 

• well vented cavities: cavities with substantial air exchange with outside. 

• slightly vented cavities: cavities with some air exchange with outside. 

• vented cavities: a type of well-vented cavity originally intended for use with con- 
densation risk analysis.  Not widely used. 

Although the thermal resistance of a cavity can be calculated in JPA  Designer (see sec-     tion 
7.3) it is usually entered as a default value appropriate for the direction of heat flow and the 
thickness range. The Product Database contains standard resistance values taken from  BS  EN  
ISO 6946. 

 
Clear cavities 

A clear cavity is an unvented cavity which has openings to outside of less than 500 mm2/m. 
For  example,  a cavity in a cavity wall will be classified as an unvented cavity because  
the openings provided by the weep holes will be less than 500 mm2/m limit. 
Clear cavities require the following information. 

• Type: select Clear cavity. 

• Description : type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal resistance: enter in m2K/W. 

• Vapour resistance: cavities have a vapour resistance of 0.00 MNs/g. 
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Bridged cavities 

Bridged cavities, such as those in some timber framed constructions, are treated the same 
as unvented clear cavities, but with bridging details added (section 7.4). Bridged cavities 
require the following information. 

 
• Type: select Bridged cavity. 

• Description : type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal resistance: enter in m2K/W. 

• Vapour resistance: cavities have a vapour resistance of 0.00 MNs/g. 

 
You will also need to enter the bridging details (section 7.4). 

If the width of the cavity is less than ten times its thickness you should use the Airspace 
Resistance Calculator to determine its thermal resistance (see section 7.3). 

 
Well vented cavities 

A well vented cavity has large ventilation openings between the cavity and the outside 
air, resulting in the conditions within the cavity being virtually the same as outside. A 
cavity is considered well vented if it has ventilation openings greater than 1500 mm2/m 
(BS EN ISO6946):  typically, the cavity behind rain-screen cladding will be well    vented. 

When well vented cavity is included in a calculation: 

 
1. The  thermal resistance of the cavity is set to   zero. 

2. The thermal resistances of all layers to the outside of the cavity are also set to zero. 

3. The external surface resistance is set to match the internal surface resistance. This 
allows for the inner face of the cavity (which is effectively now the external face of  the 
construction) being sheltering from the    wind3. 

 
Well vented cavities require the following information: 

 
• Type: select Well vented cavity. 

• Description : type a description of the layer – this will appear on the report. 
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Figure 7.3:  Entering data for a slightly vented    cavity 

 

Slightly vented cavities 

A slightly vented cavity has openings which are larger than those of an unvented cavity 
but smaller than those of a well vented cavity (500–1500 mm2/m).  As it is not possi-  ble 
to calculate the cavity resistance directly, JPA Designer calculates the resistance of the 
construction with an unvented cavity and also with a well vented cavity then calcu- lates 
an average resistance, weighted according to the area of openings (the procedure is 
described in ISO 6946:2007 section   5.3.3). 

Slightly vented cavities require the following information: 

 
• Type:  select Slightly vented  cavity. 

• Description: type a description of the layer – this will appear on the report. 

• Slightly vented cavity opening area mm2/m: this is the area of openings in each 
linear metre of the cavity (see Figure 7.3). 

• Cavity details: if the cavity has one or more low emissivity surfaces, or the width is 
less than ten times the thickness use the Cavity details button to open the Airspace 
Resistance Calculator (see section 7.3). 

 
Vented cavities 

A vented cavity is a special cavity type used in condensation risk analysis. When a cavity 
is defined as a vented cavity the vapour resistances of all layers to the outside of the cavity 
are set to zero. This is intended to model the effect of ventilation removing moisture from 
the cavity (for further information see section 17.4)4. Vented cavities require the following 
information: 

 
• Type: select Vented cavity. 

• Description : type a description of the layer – this will appear on the report. 

• Thickness: enter in millimetres, mm. 

• Thermal resistance: enter in m2K/W. 

• Vapour resistance: cavities have a vapour resistance of 0.00 MNs/g. 

3If the inner face of the cavity is a low emissivity surface you will need to adjust the resistance to take 
account  of that. 

4The methodology was described in BS 5250:1989, but is not included in later versions of the standard: 
the vented cavity type is included mainly for backward compatibility. 
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Low emissivity cavities 

A cavity with one or more faces lined with a material of low surface emissivity will have 
a lower rate of heat transfer by radiation than a cavity with conventional, high emissivity 
faces. Including such a ‘low emissivity cavity’ within a construction will reduce the overall 
rate of heat loss through the construction, in some cases by as much as 10%. 

There are several types of material with low emissivity surfaces: 

 
• insulation boards with reflective surfaces, such polyisocyanurate boards; 

• plastic films with aluminium foil  facing; 

• membranes with metalised faces; 

• ‘multi-foil’ insulants. 

 
To be effective, each low emissivity surface must face a cavity, which should usually be  at 
least 25 mm wide. 

Although the U-value calculation methods implemented in JPA Designer cannot directly 
assess the effect of reducing radiation heat loss, it is possible to account for the effect of 
such materials by adjusting the thermal resistance of a cavity which has a low emissivity 
material to one or more faces. 

The thermal resistance value for a low emissivity cavity must be obtained by a valid test 
method, which considers only the effect of the material upon the overall conduction heat 
losses through an element.  Values  should have  third party certification,  such as  in BBA 
Agrément certificates. If you are not supplied with certified values, use the de- fault value 
for a low emissivity cavity of 0.44 m2K/W for walls, 0.34 m2K/W for roofs and 0.50 
m2K/W for floors (see BR 443 paragraph 4.8.2). If you know the emissivity of the facing 
material you can also use the Airspace Resistance Calculator (section 7.3) to calculate 
the resistance. 

 
Calculating cavity resistances 

The default resistances for cavities are not valid for cavities with one or more low emissiv- 
ity surfaces, or those with a width which is less than ten times the thickness. You should 
therefore use the Airspace Resistance Calculator to calculate the correct resistance. 

To calculate an airspace resistance: 

 
1. Set the Type of layer to Clear Cavity or Bridged Cavity. The Airspace Resistance 

Calculator button appears beside the thermal resistance (see square 1 in Figure 7.4). 

2. Click the button.  The Airspace Resistance Calculator is displayed (Figure 7.4). 

3. Set: 

• Air space thickness, d, in mm. This is measured in the direction of heat  flow. 

• Airspace width, b, in mm. This is the width measured at right angles to the 
heat flow. For a wide cavity, such as that in a cavity wall enter a value at least 
ten times greater than the thickness. 



CHAPTER 7.  WORKING WITH MATERIALS 45 
 

 

 

 
 

Figure 7.4: The Airspace Resistance Calculator: 1 shows the button on the Edit material 
dialogue; 2 shows the calculated resistance. 

 

• Black-body radiative coefficient, hr0, in W/m2K.  Take  the  value  from  the  table 
on the right, for the mean temperature.  For the UK a mean temperature   of  10ºC  
is  usually appropriate. 

• The emissivities of the two surfaces of the cavity. Most materials have an emis- 
sivity around 0.90, but foil facings to insulation, and metalised membranes 
have much lower emissivities, typically  0.03–0.05. 

• The heat flow direction. 

4. The program now displays the resistance for the airspace (see square 2 in Figure 7.4). 

5. Click OK. The calculated resistance is transferred to the Thermal resistance box of 
the Edit Material dialogue. 

 

For two-directional heat flow cavities you should use the pair of resistance calculators 
adjacent to the heat-in and heat-out resistances. 

 
7.4 Repeating thermal bridges 

Thermal bridges are formed where the material in a layer is interrupted by a second ma- 
terial with different thermal conductivity, for example, insulation in a timber framed wall 
being interrupted (bridged) by the timber studs. In most cases thermal bridging increases 
heat loss through the bridged layer5. The effect of thermal bridges which occur regu- larly 
throughout a layer (repeating thermal bridges) is included in U-value calculations by 
added the details of the thermal bridge to each bridged layer using the Repeating 
Thermal Bridges tab of the Edit Material dialogue (Figure 7.5). 

JPA  Designer offers three different methods of entering thermal    bridging: 
5Hence the commonly used term ’cold bridge’. However, mortar in stone walls will usually reduce the 

rate of heat loss. 
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Figure 7.5: The Repeating Thermal Bridges tab 

 

• Using one of the built-in defaults to set the bridging fraction and material6; 

• Setting the bridging fraction and bridging material directly; 

• Entering the bridging dimensions and material. 
 
 

 

Figure 7.6: Using one of the default thermal bridging conditions 

 
To use a default thermal bridge: 

 
1. Set the Bridge type to 1 dimensional. 

2. From the Thermal bridge Type list select one of the default bridging conditions (these 
are described in Figure 7.6). 

3. The  program sets: 

6For R-value calculations the default bridging conditions may not match standard construction param- 
eters. It may well be easier to set bridging using the second of the three methods. 
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Table 7.1:  Default bridging fractions 
 

Construction Material Conductivity Fraction 

Mortar joints, 440 x 215 mm blocks, , external Mortar 0.94 0.067 

leaf (BR 443 4.2)    
Mortar joints, 440 x 215 mm, blocks, internal Mortar 0.88 0.067 

leaf (BR 443 4.2)    
Steel studs, 1.2 mm, 600 mm   centres Steel 50 0.002 

Steel studs, 1.2 mm, 400 mm   centres Steel 50 0.003 

Timber-framed wall, prefabricated panels, Prefab panels 0.12 0.150 

default fraction (BR 443 4.5.1)    
Timber-framed wall, prefabricated panels, Prefab panels 0.12 0.125 

lower fraction (BR 443 4.5.1)    
Site-formed timber-framed wall,  default Softwood 0.13 0.150 

fraction (BR 443 4.5.1)    
Site-formed timber-framed wall, lower   fraction Softwood 0.13 0.125 

(BR 443 4.5.1)    
Ceiling, trussed rafters 35 mm, 600 mm cc + Softwood 0.13 0.068 

1% other timbers (BR 443 4.6.1)    
Ceiling, 50 mm joists, 400 mm cc + 1%   other Softwood 0.13 0.135 

timbers (BR 443 4.6.1)    
Ceiling, default: 48 mm, 600 mm cc + 1% Softwood 0.13 0.090 

other timbers (BR 443   4.6.1)    
Timber floor, default:  38 mm, 400 mm cc + Softwood 0.13 0.110 

1% other timbers (BR 443 4.6.2)    
Plasterboard battens, 47 mm, 600 mm cc + Softwood 0.13 0.118 

rails (BR 443 4.7.2)    
I-beam flanges, 38 mm wide, default fraction Softwood 0.13 0.150 

(BR 443 4.5.2)    
I-beam flanges, 38 mm wide, lower fraction Softwood 0.13 0.125 

(BR 443 4.5.2)    
I-beam flanges, 48 mm wide, default fraction Softwood 0.13 0.170 

(BR 443 4.5.2)    
I-beam flanges, 48 mm wide, lower fraction Softwood 0.13 0.145 

(BR 443 4.5.2)    
I-beam web, 4 to 8 mm (BR 443  4.5.2) OSB 0.13 0.040 
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• The bridge material; 

• The thermal conductivity of the bridge; 

• The fractional area of the bridge (referred to in JPA Designer as the Proportion 
bridged). 

4. Check the Bridge Thickness: by default this is set to Follows material thickness, so 
the bridge will have the same thickness as the layer itself. You can set the bridge 
thickness to a different value using the Fixed at box. 

 
To set the bridging material and proportion directly: 

 

Figure 7.7: Setting the bridging proportion directly 

 
 

1. Select the bridging Material (which sets the thermal conductivity of the bridge). 

2. Tick the box Specify proportion (Figure  7.7). 

3. Enter  the  Proportion bridged. 

4. Check the Bridge Thickness: by default this is set to Follows material thickness, so 
the bridge will have the same thickness as the layer itself. You can set the bridge 
thickness to a different value using the Fixed at box. 

 

 

 

Figure 7.8: Entering thermal bridging using dimensions 

 
To enter thermal bridging details using dimensions: 

 
1. Use the Bridge type radio buttons to determine whether the bridging is 1 dimen- 

sional or 2 dimensional: 
 

• one-dimensional e.g. timbers running in one direction; or, 

• two-dimensional e.g. mortar joints which run vertically and vertically. If you 
are not sure whether the bridging is one or two dimensional clicking the Help 
button will open a guidance window: the annotation on the help diagrams 
match those on the data entry  boxes. 
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2. In the Thermal bridge section of the dialogue (Figure 7.8) select the bridging ma- 
terial from the Material drop-down. The program sets the Bridge thermal conduc- 
tivity. 

If you are using an unusual bridging material you can enter your own description, 
then  enter  the  conductivity manually. 

3. Enter the Bridge width in mm. 

4. Enter the Non-bridge width in mm. 

5. For two-dimensional bridging enter the Non-bridge height in mm. 

6. Set the bridge thickness by selecting Follows material thickness, or selecting Fixed 
at then entering thickness in mm. 

 
In some constructions – notably built up metal roof and wall cladding – there are two 
sets of thermal bridges. To enter details of a second bridge: 

 
1. Enter the details for the first  bridge. 

Note: You must specify the first bridge using dimensions. The second bridge option 
is not available if you have used Specify proportion. 

2. Click the Second bridge box.  The Optional second bridge section is  displayed. 

3. Select the bridging material from the Bridge description drop-down. The program 
sets the Bridge thermal conductivity. 

 
If you are using an unusual bridging material you can enter your own description, then 
enter the conductivity manually. 

 
1. Enter the Bridge width in mm. The software uses the Non-bridge width for the first 

bridge to calculate the Proportion bridged. 

Non-bridge width = centre-to-centre distance - (bridge 1 + bridge  2). 

2. When the bridging material is air you can use the Small airspace resistance button 
to calculate the thermal resistance of the bridge: enter the thickness of the airspace 
and its width – both in mm – then click OK. The resistance is displayed in the Bridge 
thermal resistance box. 

 

 
Many of the default values for cavities in the Products Database are for cavities without 
a set thickness, for example, a wall cavity with a thickness greater than 25 mm. Where 
such a cavity is being bridged you must either enter a thickness for the cavity on the 
General tab (which will not affect the resistance), or you must set the Bridge thickness 
using the Fixed at box. Without those, the program is unable to calculate the correct 
resistance of the    bridge. 



 

 
 
 

8 Correction factors and adjustments 
 

 
 
 
 
 

 

Although the rate of heat loss through a building element depends on the thermal resis- 
tances of the materials of which it is composed and the extent of any thermal bridging, 
other features of the construction will also affect it. Such features are addressed in the 
U-value calculation by the use of correction factors: the most important ones address: 

 
• Mechanical fasteners which penetrate insulation, dUf (section 8.1); 

• Air gaps in insulation layers, dUg (section 8.2). 

• The effect of rainwater cooling on inverted roofs, dUr (section 8.3); 

• Brackets and rails in wall and soffit cladding systems (section 8.4); 

• Wind posts in masonry (section 8.5); 

• Loft hatches in pitched roofs (section 8.6). 

• Insulation compression in built up metal roofing and cladding, dUp (section  9.2). 

 
The correction factors are calculated separately from thermal resistances of the layers, 
then added to the raw U-value. However if the total value of the correction factors is less 
than 3% of the raw U-value they are ignored. The values for correction factors are 
displayed in the main U-value window, next to the final  U-value. 

U-value calculations should also be adjusted for the beneficial effect of an unheated 
space (such as a garage or corridor) to the cold side of the construction (section 8.7). 

 
8.1 Mechanical fasteners 

Where a layer of thermal insulation is penetrated by metal fasteners, such as screws and 
wall-ties, there is additional heat loss through the insulation which must be allowed for 
using the mechanical fatteners correction factor, ∆Uf. The correction factor is required 
for common constructions such as: 

 
• Cavity walls with partial or full-fill cavity  insulation. 

• Warm pitched roofs where insulation is laid over the rafters and restrained by coun- 
terbattens fixed back to the rafters. 
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• Warm flat roofs where the insulation and/or the waterproof membrane is mechan- 
ically  fixed  to  the deck. 

There is no need to apply a correction: 

• to constructions without fasteners, e.g. solid masonry walls; 

• for fasteners with both ends in contact with metal    sheets; 

• for wall ties across an empty    cavity; 

• for wall ties between a masonry leaf and timber studs; 

• where the thermal conductivity of the fastener, or part of it, is less than 1W/mK 
(such as plastic ties). 

The mechanical fasteners correction can be applied: 

• once to a calculation, using the U-value Construction dialogue (see Figure 8.1; This 
method must be used for light steel frame  elements. 

• to several layers in the construction, using the Edit Material dialogue for the affected 
layers. 

 

 

 

Figure 8.1: Data entry boxes for the mechanical fasteners correction 

 
The methods of entering data are similar whether the correction is applied to once to the 
construction or to individual layers.  Corrections can be applied by: 

• using a point thermal transmittance value; 

• calculating the correction based on the fastener dimension and materials1. 

Irrespective of the method being used, you should always enter the mechanical fasteners 
correction after you have entered the layers of the construction. 

The calculated correction factor is displayed on the status bar as the dUf value and is 
included on the U-value report. 

1All versions of JPA Designer from 4.04b1 build 025 onward use the method in BS EN ISO 6946:2007.  
It is possible to use the method in BS EN ISO 6946:1997 by unticking the Mechanical fasteners box on the 
Other tab of the Options dialogue, but there is little reason to do so. 
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Correcting using a point thermal   transmittance 

The point thermal transmittance is a measure of the additional heat loss resulting from a fixing 
or bracket.   A value quoted for a particular fixing is valid only for that fixing and      may well 
only be valid for a specified thickness of insulation. 

 

Figure 8.2:  Entering details of the point thermal    transmittance 

 
To apply a point thermal transmittance once in a whole calculation: 

 
1. Open the U-value Construction dialogue in the General  tab. 

2. Select the Layer bridged by mechanical fasteners (Figure 8.2). 

3. In the Mechanical fasteners section tick Use point thermal transmittance. 

4. Enter the number of fasteners per m2  in No.  per   m2. 

5. Enter the Point  thermal transmittance. 

 
To apply a point thermal transmittance to one layer: 

 
1. Open the Edit Material dialogue for the insulation layer, then select the Correction 

factors tab. 

2. In the Mechanical fasteners section tick Use point thermal transmittance. 

3. Enter the number of fasteners per m2  in No.  per   m2. 

4. Enter the Point  thermal transmittance. 

 
Correcting using fastener  data 

In most constructions the point thermal transmittance of the fastener is not known,  so     the 
effect of fasteners is calculated from the dimensions and performance of the fasteners (see  
Figure  8.1), using: 

 
• the number of fasteners per square metre, labelled No.  per    m2; 

• the thermal conductivity of the fasteners, in W/mK, labelled Fastener lambda (typ- 
ically this will be 17 W/mK for stainless steel and 50 W/mK for mild  steel); 

• the alpha constant, this is 0.8 for most constructions, but 1.6 for light steel frame 
constructions: the value will be entered automatically by the software; 

• the cross-sectional area of the fastener, in millimetres, labelled Cross-section. 
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• for fixings which are recessed and do not penetrate the whole of the insulation 
layer, for example, screws fitted with mushroom caps, the depth of the recess, in 
millimetres. 

 
JPA Designer includes a number of standard fastener configurations which you can use 
to speed up data entry. 

To add a fastener correction once per calculation: 

 
1. Open the U-value Construction dialogue at the General tab. 

2. Select the Layer bridged by mechanical fasteners. 

3. Either: 

• Enter the fastener data, as described above;   or, 

• Select one of the standard configurations from the Mechanical fasteners box. 

 
To add a fastener correction to a layer: 

 
1. Open the Edit Material dialogue for the layer at the Correction factors tab. 

2. Either: 

• Enter the fastener data, as described above;   or, 

• Select one of the standard configurations from the Mechanical fasteners box. 

 
Saving fastener configurations 

If you frequently use a configuration of fasteners which is not in the Mechanical fasteners 
list you can add your configuration to the list, making it easy to access it. 

 

Figure 8.3: Naming a new mechanical fasteners configuration 

To create a new configuration: 

1. Open the Edit Material dialogue Correction factors tab, or the U-value  Construc- 
tion dialogue General tab. 
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Figure 8.4: Defining a new default configuration for mechanical fasteners 

 

2. Click the New button which is next to the Mechanical fasteners list.. 

3. In the New Mechanical Fastener Correction dialogue enter a description of the con- 
figuration (Figure 8.3). This is the description which will appear in the Mechanical 
fasteners list. 

4. In the Correction for mechanical fasteners dialogue (Figure 8.4) enter: 

• Fasteners per square  metre. 

• Any recess figure. 

• Fastener lambda – the thermal conductivity of the   fastener. 

• The Fastener cross-sectional area. 

• Alpha should be 0.8, except for cold or hybrid light steel framed constructions 
when it should be 1.6. 

5. If you are using a point thermal transmittance, tick the box then enter the transmit- 
tance and number of  fasteners per square   metre. 

 
You can also edit an existing configuration: 

1.Select an entry in the Mechanical fasteners list. 

1. Click Edit. 

2. In the Correction for mechanical fasteners dialogue edit the values to match your 
requirements. 

 
8.2 Air gap correction 

Air movement through and around an insulation layer will reduce its thermal perfor- 
mance. The effect of that reduction is included in the U-value calculation by a correction 
factor, dUg, which is derived from the relative thermal resistances of the insulation layer 
and the construction as a whole, and from a coefficient dU”, which represents the size 
of gaps in the insulation layer.  Values for dU” are: 

 
• Where no air gaps penetrate the insulation layer and no air circulation is possible 

on its warm side, dU” = 0.00 W/m2K. 
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• Where some air gaps penetrate the insulation layer and no air circulation is possible 
on its warm side, dU” = 0.01 W/m2K. 

• Where some air gaps penetrate the insulation layer and some air circulation is pos- 
sible on its warm side, dU” = 0.04  W/m2K. 

 
A value for dU” must be set for every insulation layer.  By default JPA Designer sets dU“ 
to zero. 

 
 

 

Figure 8.5: Correcting for air gaps in insulation layers 

To correct for air gaps: 

 
1. In the Edit material dialogue select the Correction factors tab. 

2. Select the Level (and associated value for dU”) in the dU” box (see Figure 8.5). 

Click the Help button to view the standard values for dU”. In many cases the default 
value of zero is  appropriate. 

 
8.3 Rainwater cooling 

Inverted roofs – or protected membrane roofs – have some or all of the thermal insulation 
installed over the top of the waterproof membrane where it is restrained by aggregate       or 
other ballast. Rainwater falling on inverted roofs can percolate between  insulation boards to 
the waterproofing membrane, where it will increase the rate of heat loss. The reduction in 
performance is represented within a U-value calculation by the rainwater cooling  correction  
factor,  dUr,  which  is  calculated from: 

 
• The average rate of rainfall during the heating season, p (mm/day); 

• A drainage factor, f, which represents the fraction of p which reaches the water- 
proofing membrane; 

• A factor for increased heat loss caused by rainwater flowing on the membrane,   x 
(Wday/m2Kmm). 

 
In JPA Designer the data is entered using the U-value Construction dialogue Figure 8.6). 
As you have to indicate which layer is affected by the rainwater cooling it is best to add 
the correction factor after you have defined the layers in the construction. 

To enter rainwater cooling data: 

 
1. From the menu bar select Edit>Construction Type. 

2. In the Element type section select Flat   roof. 
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Figure 8.6: Setting the rainwater cooling correction for an inverted roof 

 

3. Tick the Inverted roof box. 

4. In the External insulation layers box tick the layer(s) is affected by the rainwater 
cooling. 

 
Where a low U-value is required there may be more than one insulation layer   affected. 

 
1.  Enter values for f.x and p.  Click  OK. 

 
If you do not have project-specific values you can use the default values for f.x and   p. 

 

8.4 Cladding brackets and  rails 

When calculating U-values for walls which include rainscreen cladding the results have to 
be adjusted to account for the effect of fixing brackets or rails which support the cladding 
and also penetrate the insulation. The same method can also be used for soffit fixings on 
exposed floors. 

JPA Designer uses the methods in BR 443 section 4.9.5 to correct for the effect of one or 
more sets of fixing rails and   brackets. 

For rails systems, the calculation requires: 

 
• the linear thermal transmittance of the rail, \(\psi\, psi); 

• the area of the wall,  A; 

• the total length of bracket,  L. 

 
For  bracket systems, the calculation   requires: 

 
• the point thermal transmittance of the bracket, \(\chi\, chi); 

• the number of brackets per square metre,   n. 

 
The values for ψ and χ depend on the type of fixing and should be obtained from the 
fixing manufacturer. 

The data is entered in the U-value Construction dialogue. 

To correct for rails and brackets in rainscreen cladding: 
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Figure 8.7:  Data for rainscreen cladding correction 

 
1. Set the Element type to Wall    or Floor other than ground floor. 

2. Tick the bracket systems box. 

3. For the first fixing system use the dropdown to specify whether it is a Rail or Bracket 
system. 

4. Enter a Description of the system. This will usually include the manufacturer’s 
reference. 

5. Enter details of the system,  either: 

• Bracket system: point thermal transmittance value, χ and number of fixings 
per square metre; or 

• Rail system:  linear thermal transmittance  value,  ψ, wall area and  total length  
of rail. 

6. If there is a second system, repeat steps   2–4. 

 

8.5 Windposts 

In walls where masonry is restrained by vertical windposts or supported on horizontal 
brackets the posts and brackets can penetrate thermal insulation, reducing its effective- ness.  
Where that occurs the U-value calculation must be corrected for the presence of      the posts 
or brackets. 

 
 
 

 

Figure 8.8: Setting the windpost correction 

The correction is entered in the U-value construction dialogue: 

1. Set Element Type to  Wall. 

2. Tick Windposts penetrate an insulation layer (see Figure 8.8). 

3. Enter the length, L, of the posts or brackets in   metres. 

4. Enter the area, A, of the wall in square   metres. 

5. Enter the linear thermal transmittance, ψ, in    W/mK. 
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8.6 Loft hatches 

The  presence of a loft hatch in a pitched roof with insulation at ceiling level will reduce     the 
thermal performance of the roof.   The  extent of the reduction depends on the area      of the 
roof hatch relative to the roof and the insulation (if any) on the hatch.  BR 443  section 4.9.7  
includes an approximate method for correcting for loft hatches based on      the thickness of 
insulation on the hatch. In JPA Designer the correction is entered in the U-value  construction  
dialogue  (see  Figure 8.9). 

 

Figure 8.9: Correcting for loft hatches 

To set the loft hatch correction: 

1. Set the Element Type to  either: 

• Pitch roof, horizontal ceiling (legacy); or 

• BR443 Pitched roof - insulation at ceiling  level. 

2. In the Loft hatch insulation list select the closest matching value. 

 
8.7 Elements separating heated and unheated spaces 

The rate of heat loss through an element which separates a heated space from an unheated 
space will be lower than that through an identical element which separates a heated space 
from outside, as the relatively warm air within an unheated space acts as a thermal buffer. 

The  combined method for calculating U-values allows for this effect by assigning a ther-   mal 
resistance to the unheated space.  The  resistance is based    on: 

 
• the surface areas of the elements which separate the heated space from the unheated 

space, Ai, measured in   m2; 

• the surface areas and U-values of the elements which separate the unheated space 
from outside, Ae, measured in m2and Ue, measured in W/m2K; 

• The  volume of the unheated space, V, measured in    m3; 

• The ventilation rate, n, measured in air changes per hour (ach). 
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Figure 8.10:      Data entry for elements separating heated and unheated spaces 

 

When measuring Ai and Ae, you should include walls and intermediate floors (such as      
that over an integral garage) but exclude ground    floors. 

To allow for unheated spaces: 

 
1. In the U-value Construction dialogue click the Unheated Spaces tab (Figure 8.10). 

2. Enter: 

• The area, Ai ; 

• The ventilation rate, n; Use a ventilation rate of 3 ach if the actual ach is not 
known. 

• The  volume of the unheated space,   V. 

3. For each of the elements separating the unheated space from outside enter: 

• The area, Ae,k; 

• The U-value, Ue,k. 

Ue,k can be calculated in a separate calculation in JPA Designer.      Use a value of 
2 W/m2K if the details of the element is not  known. 

 
Using the pre–2007  method 

The 1997 edition of BS EN ISO 6946 included a different method to calculate the resis- 
tance of an unheated space. It is possible to use the older method in JPA Designer: 

 
1. In the Edit Construction dialogue select the Unheated spaces tab. 

2. Tick Use BS 6946 pre–2007  method. 
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3. In the Ai box enter the total area of all elements separating the internal environment 
from the unheated space. 

4. In the Ae for BS 6946 Pre 2007 method box enter the total area of all elements 
separating the unheated space from   outside. 



 

 
 
 

9 Advanced calculations 
 

 
 
 
 
 

 

9.1 Light steel framed structure 

The high thermal conductivity of steel means the combined method must be modified 
for elements where some or all of the insulation is bridged by light steel framing. JPA 
Designer uses the modified calculation method which was published in BRE Digest 465. 
U-values for light steel-frame construction. 

There are three different forms of light steel-framed   structures: 

 
• Warm frame constructions: all the insulation is outside the steel framing. 

• Hybrid constructions: some insulation is fitted between the steel studs and ad- 
ditional insulation placed on the outside of the studs to reduce thermal bridging 
through the steel. 

• Cold frame constructions: all of the insulation is included within the thickness of 
the steel components and is bridged by it. 

 

 

 

Figure 9.1:      Setting the type and details of light steel frame construction 

 
The procedure for calculating the U-value of a light steel-framed element using JPA De- 
signer is the same as for any other element, but with the following modifications: 

 
1. Identify the element as light steel-framed and enter the framing details (Figure 9.1). 

• In the Uvalue Construction dialogue use the light steel-frame radio buttons to 
define is as warm or cold/hybrid. 
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• For a Cold or Hybrid construction enter the stud spacing, stud depth and 
flange width. Use the offered default values if you do not know the stud depth 
and spacing. 

 

2. Enter the layers of the construction in the main Uvalue window. 

• For cold and hybrid elements some of the layers will be bridged by steel: see 
section 7.4 for guidance on entering bridged layers. Any airspace behind the 
insulation and between the studs should be entered as a bridged cavity. (Do 
not include the flanges of the steel studs when entering bridging details.) 

• In warm elements the air space between the studs should be entered as a bridged 
cavity,  with steel as the bridging    material. 

3. Enter corrections for any mechanical fasteners which penetrate the insulation by 
completing the Correction for mechanical fasteners section in the Uvalue Con- 
struction dialogue (section 8.1). 

Use the first drop box to indicate which layer is bridged by the mechanical fasteners, 
then enter the fasteners’ dimensions and spacing. The alpha coefficient is 0.8 for 
warm constructions and 1.6 for cold/hybrid constructions. 

 
9.2 Twin skin metal cladding and  roofing 

 

 

Figure 9.2:  Built-up metal wall or roof cladding 

 
The additional heat loss resulting from thermal bridging in twin-skin metal roofing and 
cladding systems formed with rails and brackets requires a modification to the standard 
combined method. JPA Designer uses the method described in the Steel Construction 
Institute research paper SCI P312, which takes account of: 

 
• The bridging effects of the rail and the air spaces around the rail. 

• The point bridging produced by the brackets. 

• The compression of the insulation by a shallow-profiled liner (profile depth less 
than 25 mm). 

 
To  calculate U-values for twin-skin metal roofing or  cladding: 
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1. Create and open a new U-value  calculation. 

2. Enter any project information. 

3. In the U-value Construction dialogue select either wall or flat roof. Do not tick the 
Built up metal roof/wall box at this stage.  Click OK. 

4. Enter the layers in the construction in the main U-value window. Enter the insulation 
in two layers: the uppermost layer being the insulation which is bridged by the rails 
and the underneath that which is penetrated only by the brackets. 

For example, a 170 mm layer of insulation in a construction with 40 mm deep rails 
should be divided into one layer 40 mm thick and one layer 130 mm thick. You will 
find later parts of the calculation easier if you give the two layers distinctive names. 

5. Enter the bridging details for the layer of insulation bridged by the rails (section 7.4 
for details). In the Edit Materials dialogue select one dimensional bridging to show 
the thermal bridging details. Enter the details of the rails: bridge material – steel 
studs, bridge width, non-bridge width. The software sets the bridge thermal con- 
ductivity. The program will show the proportion bridged and the thermal resistance 
of the bridge. 

For ‘L’ shaped sections the bridge width will usually be the thickness of the steel, 
but for ‘C’ and ‘U’ sections, where the rail penetrates the insulation layer twice, use 
double the thickness of the steel as the bridge   width. 

6. Enter the bridge details for the air spaces caused by the rail. Tick the Second bridge 
box.  The Optional second bridge section is displayed. 

7. Enter the bridge material (air) and bridge width (in mm): use twice the rail width 
to allow for the compression of the insulation around the rails. 

The program calculates the proportion bridged using the data from the first bridge, 
so the non-bridged width = (Centre-to-centre distance of rails) - (bridge thickness  1 
+ bridge thickness 2). 

8. To calculate the thermal resistance of the air space click the Small airspace resis- 
tance button. The Airspace Resistance Calculator dialogue opens (see Figure 7.4). 

9. Enter the thickness and width of the air space. The thickness will be the same as 
the rail depth. The width should be twice the rail thickness. Leave the emissivity 
values at 0.9. 

10. Enter the air gap correction, dU”, for both insulation layers (section 8.2): use the 
value  0.01.  Click OK. 

11. From the menu bar select Edit>Construction Type. 

12. In the U-value Construction dialogue tick Built up metal roof/wall. 

13. In the Built-up metal roof/wall cladding section enter the Rail spacing and Rail 
width (Figure 9.2). Use the drop-down to select the Layer bridged by rail. 

14. If the liner profile compresses the insulation and the depth of the profile is 25 mm 
or less tick the box Insulation is compressed by inner or outer sheet. Four new data 
boxes appear. 
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15. Enter the Sheet profile width, Sheet profile depth and Sheet profile centres in mm. 
In the drop box select the layer of insulation which is not bridged by the  rails. 

If the liner profile is deeper than 25 mm ignore the check box and change the thickness 
of the insulation layer by subtracting the profile depth from the original thickness 
(e.g. for a 30 mm profile with 130 mm actual depth of insulation use a value of 100 
mm). 

16. Enter the details for the brackets in the Correction for mechanical fasteners section. 
Enter: 

• The thermal conductivity of the brackets (usually 50.00 W/mK for mild steel); 

• The number of brackets per square metre (calculated by dividing the total 
number of brackets by the total element   area) 

• The cross sectional area of the brackets (measured at the thickest point). 

• The value of alpha, 1.6, is the default setting for these constructions. 

17. Select the Layer bridged by brackets. 

 

9.3 Inverted roofs 

In inverted roofs (often known as protected membrane roofs) some or all of the thermal 
insulation is applied above the waterproof membrane and restrained by aggregate or other 
ballast. Rainwater falling on the roof can percolate to the waterproofing membrane and 
increase the rate of heat loss. To allow for that a rainwater cooling correction factor, dUr, has 
to be applied to inverted roof calculations ( the rainwater cooling factor is described     in  
section 8.3). 

As the correction factor requires you to select the layers affected by rainwater cooling it 
is best to add the correction factor after you have defined the layers in the construction. 

 
 
 
 

Figure 9.3: Inputting data for rainwater correction 

To  enter an inverted roof: 

1. From the file menu select Edit>Construction type. The U-value Construction dia- 
logue opens. 

2. In Element type select Flat roof. Insert an Element description then click OK. 

3. Add the layers of the construction (chapter    6). 

4. Open the U-value construction dialogue again and in Element Type tick the In- 
verted box. The dialogue shows three data boxes (Figure 9.3). 

5. Enter the values for f.x and p and in the box select the layers of insulation above 
the waterproof membrane. Click OK. 
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9.4 Using variable layers 

The variable layer feature of JPA Designer helps you compare the performance of different 
materials in a construction, or of different thicknesses of the same material. 

 

Figure 9.4:  U-value calculation with a variable  layer 

 
A calculation with a variable layer  has a place-holder layer  in the main window (item    1 
in Figure 9.4, and has the additional Variable layer pane which accepts a number of 
different layers (item 2). Each of those layers shows the results of the U-value calculation 
as if that layer replaced the place-holder layer in the main calculation (item 3). 

To use a variable layer: 

 
1. In the main U-value window click the layer below the position for the variable layer. 

2. On the Insert menu click Variable layer. The program inserts a variable layer in the 
calculation and displays the Variable layer pane (see Figure 9.4). 

3. Select the blank layer in the Variable layer pane and add layers from the database, 
or by add and edit blank layers. The U-values for the constructions with the variable 
layer are shown alongside the variable layer materials: no U-value appears in the 
status bar. 

When using the database, you must be ensure the contents of variable layer pane 
are showing in the Construction box of the Products Database dialogue. 

 
Once you have identified a configuration which gives the result you require you can 
convert the variable layer calculation into a standard U-value  calculation: 

 
1. Click the layer in the variable layer pane which you want to use in the standard 

calculation. 

2. On the Edit menu click Move selected variable layer into construction. 

3. The variable layer is deleted and the selected layer is inserted as a standard layer. 
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Figure 9.5:  The Tapered Areas dialogue 

 
9.5 Tapered layers 

Tapered insulation layers are commonly found on flat roofs, to create drainage falls on 
an otherwise flat deck. Because the thickness of the insulation varies across the roof the 
average U-value of the roof has to be calculated using the method in Annex C of BS EN 
ISO  6946:2007.1. 

The method requires the roof to be divided into a series of blocks, which will be of: 

 
• rectangular plan, with their greatest thickness on one side, and least at the other 

other; 

• triangular plan which have their thickest part at the one corner and slope down to 
the other corners; 

• triangular plan which have their thickest part along one side, and slope down to 
the other corner. 

 
Each block in the calculation has a minimum thickness of insulation, d0, and a taper 
height, t. Depending on its size a roof may have several blocks of each type, each with 
different areas and, in some cases, different minimum thicknesses. 

In JPA Designer a tapered layer calculation is entered in two parts; 

1Note that simply calculating the U-value based on the average thickness of insulation will substantially 
over-estimate the thermal performance of the  roof. 
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• all layers except the taper are added to the calculation; 

• the individual blocks of the tapered layer are defined in the Tapered Areas dialogue 
(Figure 9.5). 

 
The Tapered Areas dialogue requires three items of general information: 

 
• a description of the layer: you can use the name or type of insulation. 

• the minimum tapered layer thickness: that is, the minimum depth of the insulation 
layer which is continuous across all parts of the roof, measured in mm. 

• the conductivity of the insulation, lambda: this is entered in W/mK. 

 
The data on the different roof blocks is entered in the three tables , with each block having 
its own entry, in the appropriate section, with the following data: 

 
• an optional Description which is useful for identifying sections of the roof; 

• the taper depth, t, in  mm. 

• the area of the block, in m2; 

 
If a block has a different minimum depth compared to the rest of the roof, or has insulation 
with a different thermal conductivity you can insert a different value for d0 and lambda. 

Figure 9.6 shows a roof with tapered insulation laid with falls towards the perimeter. To 
calculate the U-value the tapered layer should be divided into eight blocks, with two (a 
and e) being rectangles sloping from the centre line to the perimeter and the remainder 
being triangles, in each case sloping from the highest corner at the centre line to the 
lowest side at the perimeter (b, c, d, f, g and h). 

To enter a tapered layer in an existing U-value  calculation: 

 
1. Divide the roof into blocks and calculate the minimum thickness, block areas and 

taper thicknesses. 

2. On the Insert menu click Tapered  layer. 

3. Enter the data for the minimum thickness and the conductivity of the insulation. 

4. Enter the data for each block in turn, making sure each block goes into the appro- 
priate table. 

You can use the Total area figure at the bottom right of the dialogue to check you 
have entered all the sections of the   roof. 
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Figure 9.6: A typical roof with tapered insulation 



 

 
 
 

10 Ground  floor U-values 
 

 
 
 
 
 

 

The standard method of calculating U-values has to be modified for ground floors and 
basements to take account of the thermal resistance of the ground using the method is 
set out in ISO 133701. This section describes the general procedure for calculating the 
ground floor U-value, whilst the following sections describe the individual parts of the 
calculation. 

To  calculate a ground floor U-value: 

 
1. Create a new U-value calculation in the Project Manager window and open it for 

editing (section 3.7). 

2. Enter any project information in the Project Information dialogue. 

3. In the U-value Construction dialogue select Solid ground floor or Suspended ground 
floor, enter a description for the construction, then click OK. The Ground Floor 
Details dialogue opens. 

4. Enter the data for the ground (section 10.1). Click OK. 

5. Add the remaining layers of the floor construction. 

 
Include layers to represent: 

 
• Screed; 

• Insulation; 

• Flooring, such as particle board. 

 
Omit: 

 
• Hardcore beneath a groundbearing slab. 

• Groundbearing concrete slabs with density greater than 1800 kg/m3. 

• Thin floor coverings such as vinyl or  carpet. 

 
For further guidance refer to the BR 443 Conventions for U-value calculations. 
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Figure 10.1:  The  Ground Floor Details  Dialogue 

 
10.1 Ground floor details 

The Ground Floor Details dialogue contains the data which describes the ground and  
the floor structure (Figure 10.1) and has five sections: 

 

• Floor type (section 10.1–1).  The choice of floor type will determine how other parts   
of  the  dialogue appear. 

• Floor dimensions (section 10.1–2). The size of the floor. 

• Deck (section 10.1–3). The construction of a suspended floor  deck. 

• Suspended ground floor details (section 10.1–4). Additional information for sus- 
pended floors. 

• Edge insulation (section 10.1–5). Details of any separate perimeter insulation. 

 
Floor type 

JPA Designer recognises three types of ground floor: 
 

• Solid: a floor which bears directly on the ground with no void between the floor 
structure and the ground, for example, a ground-bearing concrete slab; 

1Do not use this method to calculate U-values of floors over open or unheated spaces such as car parks 
or garages; instead select floors other than ground floors in the Construction dialogue and proceed as usual. 
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• Suspended block and beam: with a void between the floor deck and the ground, with 
the deck formed from pre-cast concrete beams infilled with concrete blocks or 
proprietary insulating units; 

• Suspended: a floor with a void between the floor structure and the ground, with a 
timber deck supported on timber   joists. 

 
If you have selected solid ground floor in the U-value Construction dialogue the Floor 
Type buttons will be greyed out.  If you have selected suspended ground floor you will  be 
able to chose between Suspended block and beam and    Suspended. 

 
Floor dimensions 

The thermal resistance of the ground for a particular floor is affected by the ratio of its 
perimeter and area. The perimeter length (expressed in metres) is measured along the 
finished internal surfaces of exposed and semi-exposed walls. The area (expressed in 
square metres, m2) is measured between the finished internal wall surfaces. Unheated 
spaces outside the insulated fabric should be excluded when calculating the perimeter 
and area. 

To enter the Floor dimensions: 

 
• If you have calculated the Perimeter/Area ratio you can enter it directly in the P/A 

box. 

• Alternatively, tick the Calculate it box and enter the Perimeter and Area dimen- 
sions. 

 
Deck 

The data required for this section depends upon the type of construction specified in the 
Floor Type section: 

 
• Solid floor: no deck data required. 

• Suspended block and beam floor (Figure 10.2): the program calculates the resis- 
tance using the following data: 

– The block Width, Thickness and  Conductivity. 

– The beam Web width and Beam conductivity. 

– The Screed depth and Screed conductivity. 

You can set the default thermal conductivity of the screed in a beam and block floor 
construction on the Other tab of the Options dialogue in Project Manager. 

• Suspended floor: you can enter a resistance for the deck, or select a material from 
the database (Figure 10.3) by clicking the database button (the procedure for select- 
ing the material is the same as described in section 6.1. The deck in a suspended 
floor will typically be timber boards or particleboard: insulation between joists 
should be entered as a separate layer, bridged by timber (section 7.4). 
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Figure 10.2:  Defining a beam and block  deck 
 
 
 

 

Figure 10.3:  Set the deck resistance for a suspended    floor 
 
 
 

 

Figure 10.4:      Entering the details for a suspended ground floor 
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Suspended ground floor details 

In a suspended ground floor heat will be lost through the floor deck and ground; it will 
also be lost through the walls of the sub-floor void and as a result of ventilation of that 
void. JPA Designer calculates those latter heat losses using the data in Suspended Ground 
Floor Details section (Figure 10.4). The values required are: 

 
• E - the area of ventilation openings in the walls of the sub-floor void, measured in 

square metres per metre (m2/m). 

• h - the height of the upper surface of the floor above external ground level, in metres. 
The default value of 0.225 m represents three courses of brickwork 

• w the thickness of the walls at the floor perimeter in metres. 

• Uw - the U-value of the walls of the sub-floor void, calculated according to BS EN 
ISO 6946, in W/m2K. This value can be obtained from a separate calculation in 
JPA Designer. 

• fw - the wind shield factor, see Table 10.1.  This converts the average wind  speed, 
V, into the wind speed at ground level. 

• Lambda - the conductivity of the type of ground:  use 1.5 W/mK for clay or silt, 
2.0 W/mK for sand or gravel and 3.5 W/mK for homogeneous rock. 

• V - the average wind speed at 10 m above ground level, in m/s. (BR 443 recom- 
mends a default value of 5 m/s for the UK.) 

 
Where some or all of these details are unknown you should use the default values. If you edit 
the values then want revert to using the defaults click the Default button. 

The surface resistances of the underside of the suspended deck and of the ground surface 
of the sub-floor void are included in the calculation. These are entered in Deck underside 
surface resistance and Subfloor ground surface resistance.        In most cases a value of 
0.17 m2K/W is suitable, however, if the underside of the deck has a low emissivity surface 
(for example the foil facing of an insulation board), then a higher resistance may be used. 

The resistance of any thermal insulation on the ground surface of the sub-floor void, Rg, 
should be entered at Resistance of insulation on ground (This insulation should not be 
entered as a normal layer in the calculation.) 

 

 
The  U-value calculation for solid ground floors requires three pieces of data from    the 
Suspended ground floor details section: the height of the floor surface above the ground 
(h), the width of the walls (w) and the conductivity of the ground (Lambda). 
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Table 10.1:  Windshield factor 
 

Location Example Fw 

Sheltered City centre 0.02 
Average Suburban 0.05 

Exposed Rural 0.10 

 
Edge insulation 

Installing insulation horizontally around the perimeter of the floor – edge insulation – will 
reduce thermal bridging at the perimeter and improve the floor’s overall thermal 
performance2. Edge insulation can be: 

 
• Horizontal:  insulation installed around the perimeter of the floor in the same plane   

as  the floor3. 

• Vertical: insulation installed at the perimeter of the floor, at right angles to the plane 
of the floor. 

 
Use the radio buttons to select the type of edge insulation present: none, horizontal or 
vertical then enter the details of any insulation (if you have selected none leave the rest 
of this section blank). 

 
• Insulation name. 

• Insulation thickness: board thickness, in mm. 

• Insulation conductivity:  the lambda value, in W/mK. 

• Insulation width or depth (depending upon whether the insulation is laid horizon- 
tally or vertically): the board width, in mm. 

• Description: optional description of the insulation. 

 
You can also use the Products Database to enter details of the insulation by clicking on 
the button by the Insulation name box. 

Further information on edge insulation may be found in BRE Information Paper 7/93. 
 
 
 
 
 
 
 

 
2For suspended floors edge insulation refers only to insulation applied at the base of the subfloor void: 

insulation around the edge of the deck should not be included as edge insulation. 
3Horizontal edge insulation was commonly used to reduce thermal bridging and cold spots on larger 

floors which did not require a complete layer of thermal insulation. However, the lower U-values now 
required by Building Regulations usually require a full layer of insulation, making the use of horizontal edge 
insulation unlikely. 



 

 
 
 

11 Basement U-values 
 

 
 
 
 
 
 

JPA  Designer calculates U-values for basement walls and floors using the methods in    in 
BS EN ISO 13370.  As the calculations for a basement’s  walls and floor are linked, with 
each calculation requiring data about the other element, it is beset to calculate the 
basement floor U-value first. 

 
11.1 Basement floors 

 

Figure 11.1:  Entering data for basement   floors 

 
To complete a basement floor U-value calculation you will need to know: 

 
• The floor’s Perimeter/Area ratio:  P/A; 

• The thickness of the basement walls: w (metres); 

• The average depth from the external ground surface to the basement floor: h (me- 
tres); 

• The thermal conductivity of the ground: lambda, λ, in W/mK (see Table 11.1 and 
annex G of BS EN ISO   13370). 

 
To calculate a basement floor U-value: 

 
1. Create a new U-value calculation in the Project Manager window and open it for 

editing. 

2. In the U-value Construction dialogue set the Element Type to Basement Floor, enter 
an Element description then click  OK. 

3. In the Ground Floor Details dialogue (Figure 11.1) enter: 

• the Perimeter/Area ratio, P/A, or check the box labelled ‘calculate it’ and enter 
the Perimeter and Area  separately; 
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• the wall thickness, w; 

• the basement depth, h;  and, 

• the thermal conductivity of the ground. 

4. Enter the layers which make up the floor construction. 

 
Include layers to represent: 

 
• Screed; 

• Insulation; 

• Flooring, such as particle board. 

 
Omit: 

 
• Hardcore beneath a groundbearing slab. 

• Groundbearing concrete slabs with density greater than 1800 kg/m3. 

• Thin floor coverings such as vinyl or  carpet. 

 

Table 11.1: Thermal conductivity of the  ground 
 

Category Description Thermal conductivity, (W/mK) 

1 clay or silt 1.5 

2 sand  or gravel 2.0 

3 homogeneous rock 3.5 

 

11.2 Basement walls 

To  complete a basement wall U-value calculation you will need to  know: 

 
• The floor’s Perimeter/Area ratio:  P/A; 

• The thickness of the basement walls: w (metres); 

• The average depth from the external ground surface to the basement floor: h (me- 
tres); 

• Details of the insulation in the basement floor. 

• The thermal conductivity of the ground: λ, in W/mK) (see Table 11.1 and annex G 
of BS EN ISO  13370). 

 
To  calculate a basement wall U-value: 
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Figure 11.2: Entering data for a basement wall calculation 

 

1. Create a new U-value calculation in the Project Manager window and open it for 
editing. 

2. In the U-value Construction dialogue set the Element Type to Basement Wall, enter 
an Element description then click OK. The Ground Floor Details dialogue opens 
(Figure 11.2). 

3. Enter the Perimeter/Area ratio, P/A, or check the box labelled ‘calculate it’ and enter 
the Perimeter and Area   separately. 

4. Enter the wall thickness, w, the basement depth, h, and the thermal conductivity of the  
ground, lambda. 

5. Enter the details of insulation in the basement floor. Either enter the name, thickness 
and conductivity of the insulation, or use the database button to select the insulation 
from  the  Products Database. 

6. Add the layers of the construction in the main U-value window. 



 

 
 
 

12 Creating reports 
 

 
 
 
 
 

 

You can print calculation reports or produce a PDF file which can be opened on any 
computer with the free Adobe Reader software installed. PDF files are ideal for emailing 
to people who need to see the results of the calculation but do not have JPA Designer. 
For both print and PDF the report includes: 

 
• Project information; 

• Details  of  the construction; 

• The U-value and any correction factors. 

 
To print results: 

 
1. On the File menu click Print (or click the Print button on the tool bar). The Sections 

To Print dialogue opens (Figure 12.1). 

2. If you have several user identities (see section 2.8) select the one you want to use 
in the Identities list. 

3. Use the tick boxes to select whether to print an additional page showing the details 
of the bridging calculations. You can also choose whether to include the ISO mois- 
ture table for condensation analysis, and whether the calculation should show the 
logo of the BBA/TIMSA U-value accreditation scheme. 

4. If you want to include a watermark over the calculation tick Print watermark text.   
You can also modify the wording, angle and font size of the default text. 

5. Click OK. The Print preview window opens. 

6. Use the buttons on the tool bar to view successive pages of the print out, then click 
the Print button to print the pages (Figure   12.2). 

 
To create a PDF calculation report: 

 
1. On the File menu bar select Create PDF (or click the PDF button on the toolbar).   

A dialogue asks if you want to open the PDF when it is  created. 

2. Select Yes or No.  The Sections To  Print dialogue opens (Figure 12.1). 
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Figure 12.1:  Sections To  Print dialogue 
 
 
 
 
 
 
 
 
 
 

 

 

Figure 12.2: Print preview controls 
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3. Use the tick boxes to select whether to print an additional page showing the details 
of the bridging calculations, tapered layers and, for condensation risk analysis, the 
ISO moisture table for condensation analysis. If you are a member of the BBA/ 
TIMSA U-value accreditation scheme you can add the scheme logo to your reports. 

4. If you want to include a watermark over the calculation tick Print watermark text.   You 
can also modify the wording, angle and font size of the default text. 

5. If you have several user identities (see section 2.8) select the one you want to use 
in the Identities list. 

6. Click OK. The Print preview window opens. 

7. Use the buttons on the tool bar to view successive pages of the print out, then click 
the Print button to print the pages (Figure 12.2). The program will then create a 
PDF file of the  calculation. 

The name of the PDF file will include the JPA Designer file name and the calculation 
name, so the calculation tile hung wall in a project The Meadows will be called The 
Meadows.JDPtile hung wall.PDF. 

8. The file will be saved into the JPA Designer program folder or in the start-up folder 
you have specified (see section 3.5). 

Note: as Windows does not allow certain characters to be used in file names you 
should ensure the calculation names in JPA Designer do not contain those charac- 
ters, otherwise PDF creation will fail.  The restricted characters are:  ’  /\ :  * ?  < > 

|. 

You can change the printer settings by selecting File>Printer setup from the menu bar. It  
is also possible to produce PDF reports of all the U-value calculations at once.   In         
the Project Manager window on the File menu click Print all U-value calculations in 
this project to PDFs. The program will then offer the Sections to Print dialogue before 
creating the PDFs. 

 

12.1 Adding notes to reports 
 
 

 

Figure 12.3: The Print Report Notes tab in the U-value Construction  dialogue 

 
You can add notes to the report of a calculation, which can be used to explain particular 
features of the calculation or to highlight assumptions made within it. 
To add notes open the U-value construction dialogue and click on the Print Report Notes 
tab. You can then enter your wording (Figure 12.3). The notes text will appear between 
the layers list and the final result. 
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12.2 Customising reports 

You can control many aspects of the appearance of JPA Designer’s calculation  reports: 

 
• Selecting the printer: In the U-value  module  select  File>Printer  setup.  You  can select 

the printer and paper source. It is possible to set the page orientation to landscape 
rather than portrait, but the reports are not designed for landscape format. 

• Changing the font used in reports: In the U-value module select File>Font. Then in 
the Font dialogue. set the typeface, style and size. The default is Arial regular, 10 pt. 
Larger sizes may cause problems on the page with columns overflowing. Note also, 
that some fonts are wider than others, even at the same point size, so it worth testing 
font settings. 

• Page margins: These are set in the General tab of the Options menu. There are two 
Top settings, one for the first page and one for the second page. This is to allow you 
to print calculations onto headed paper, with printing on the first sheet starting 
lower down the page. 

• Adding your logo and address: You can add your logo and contact details to cal- 
culation reports: see section 2.8. 

• Adding a disclaimer to be shown at the bottom of calculation reports: Enter the 
disclaimer text in the U-value disclaimer box on the Options dialogue General tab. 

• Including the total construction thickness in the calculation report: In the Other tab 
of the Options dialogue tick Print total thickness on U-value report. The total 
thickness will then appear on calculation reports below the layer list. 



 

 
 
 

13 Editing the Products database 
 

 
 
 
 
 

 

To  make U-value calculations easier all JPA  Designer U-value modules include the Prod-  ucts 
database, which provides key data on generic construction materials and cavities,as well as 
data on branded products from a number of manufacturers. This section explains how you 
can add frequently used products to the database. 

The  materials within the database are organised into three    categories: 

 
• Branded products from manufacturers, shown in bold in the categories list; 

• Generic materials, shown in normal type in the categories list; 

• User-defined materials, shown in italics in the categories list. 

 
Whilst you can create, edit and delete user-defined categories and materials, you can not 
edit or delete branded or generic categories or materials.  However, you can clone   a 
generic or branded material and make changes to the cone, leaving the original un- 
touched. 

To make changes to the Products database you must first open the Edit database dialogue 
(Figure 13.1) by selecting Edit>Database from the main menu. 

To add a user defined category: 

 
1. Click the New category button. 

2. Enter the name of the category in the New category dialogue. 

3. Click OK. The  new category is  created. 

 
To rename an existing user defined category: 

 
1. Select a category by clicking on  it. 

2. Click the Edit category button. The Edit category dialogue  opens. 

3. Enter a new name then click OK. The category is  renamed. 

 
To  clone a category: 

 
1. Select the category to clone by clicking on  it. 

 

82 



CHAPTER 13.   EDITING THE PRODUCTS DATABASE 83 
 

 

 

 
 

Figure 13.1:  The Edit Database dialogue 

 

2. Click the Clone category button.  The Clone category dialogue  opens. 

3. Enter a name for the new category and click OK. 

4. A new category will be created, containing copies of the original  materials. 

 
To delete a user defined category: 

 
1. Select the category to  delete. 

2. Click the Delete category button. An Information dialogue asks you to confirm the 
deletion. 

3. Click Yes to delete the category, No to keep it. 

 
To insert a new material in a user-defined category: 

 
1. Select the category in which you want to create the new material. 

2. Click the New product button. The Edit material dialogue  opens. 

3. Complete the Edit material dialogue (chapter 7). 

4. Click OK. The new product is added to the  category. 

 
To edit an existing user defined material: 
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1. Select the product you wish to   edit. 

2. Click the Edit product button. The Edit material dialogue  opens. 

3. Make the changes in the Edit material dialogue (chapter 7). 

4. Click OK. The product information is  updated. 

To clone an existing product in a user defined category: 

1. Select the product and click the Clone product button. A copy of the product will 
be inserted in the category. 

2. Click on the clone to edit  it. 

To delete a product from a user-defined category: 

1. Select the product you wish to   delete. 

2. Click the Delete product button. The product is  deleted. 
 
 

 

Figure 13.2:  The Search Database dialogue 

 
You  can search the database to find specific products: 

1. Click the Search button. The Search Database dialogue opens (Figure  13.2). 

2. In the Search Database dialogue enter the text you want to search for and the di- 
rection the program should search through the database (forwards or backwards). 

3. Tick the Ignore case box if you want the search to ignore capitals and lower-case 
letters. 

4. Click Find first to start the search. The program will display the first matching 
product in the Products pane. 

5. Click Find next to go on to the next matching product. 

6. When you have found the product you want click Close to close the Search dia- 
logue. 

When you have finished working on the database, click the Close button to return to the 
main   U-value  window. 
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13.1 Short codes 

You can assign codes to user defined materials as you enter them in the database. The 
short codes can then be used for rapid data entry using the Products database. You can 
also use short codes to determine the order in which products and materials are presented 
within categories, to speed up data entry for common constructions. 

To sort the database by short codes you must first assign short codes to the materials; use 
a numbering system which matches the order in which you want the materials to appear. 
Once you have assigned short codes you should click on the Sort on short code tick box 
in the Products database dialogue (Figure 6.2). 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Part III 

Thermal mass calculations 
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14 Thermal mass in JPA Designer 
 

 
 
 
 
 

 

The thermal mass of a building element is an expression of the amount of heat which     it 
can store. Elements with high thermal mass store more energy than those with lower 
thermal mass. The thermal mass of a whole building will affect its energy  efficiency. 

The JPA Designer U-value modules can be used to carry out the two main thermal mass 
calculations for constructions: 

 
• κ-value (kappa-value) calculations, which give a steady-state measure of thermal 

mass.   -values are used in SAP calculations from SAP 2009 onwards (see sec-   tion 
21.1 for further information on    -values). 

• admittance calculations, which give transient measures of thermal mass which can 
be used in dynamic simulation modelling (DSM) when assessing the energy perfor- 
mance of whole buildings. 

 
Each calculation is carried out along side the U-value calculation, provided the necessary 
data is available for every layer in the construction. This section describes the additional 
data and how to produce a thermal mass report. 

 
14.1 Additional data for thermal mass calculations 

In addition to the standard data for each layer required for U-value or R-value calculations 
(thickness and thermal conductivity), thermal mass calculations require: 

 
• density, in kg/m3; 

• specific heat capacity, in  J/kgK. 

 
Generic materials in the revised product database have values for density and specific 
heat capacity. 
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Figure 14.1: Thermal mass results showing in the status bar 

 
14.2 Thermal mass results 

The results of thermal mass calculations are displayed in the status bar of the U-value 
module  (see  Figure 14.1). 

The figures shown are: 

 
• admittance: a measure of how rapidly heat passes between the surface of an ele- 

ment and the building interior. 

• decrement factor: the ratio of the temperature range at the internal surface of an 
element to the temperature range at the external  surface. 

• decrement delay:  the time taken for heat to travel  from on side of the structure to  
the other. 

• κ-value:  the steady-state measure of thermal  mass. 

 
The results are updated whenever the layer data is changed. 

 
14.3 Thermal mass report 

A report of the thermal mass calculation can be printed or exported to PDF in the same 
way as other reports from the U-value module, by ticking the Thermal mass box in the 
Sections To  Print dialogue. 

The report shows the κ-value calculation and the results of the admittance calculations. 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Part IV 

Condensation risk 
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15 The problem of  interstitial 
 

condensation 
 

 
 
 
 
 

 

Condensation occurring within building elements – interstitial condensation – can cause 
substantial damage to the building fabric and reduce the effectiveness of thermal insu- 
lation1. By carrying out condensation risk analysis (CRA) you can identify constructions 
which are likely to be at risk of condensation and, where necessary, make modifications 
to the design. 

JPA Designer assesses the risk of interstitial condensation using the steady-state method 
defined in ISO 13788:20122, which uses mean monthly temperatures and relative hu- 
midities to assess the risk of interstitial condensation over a twelve month period. The 
method provides a general assessment of suitability of the construction, but does not ad- 
dress air movement within the construction, nor does it take account of the effects of 
capillary moisture transfer. 

1For further information on the causes and effects of condensation, and guidance on reducing problems 
see BS 5250:2011.  Code of practice for control of condensation in  buildings. 

2ISO 13788:2012 Hygrothermal performance of building components and building elements – Internal 
surface temperature to avoid critical surface humidity and interstitial condensation – Calculation methods. 
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16 Condensation risk analysis in JPA 
 

Designer 
 

 
 
 
 
 

 

Condensation risk analysis determines whether condensation is likely to occur at the 
interfaces between the layers of material which make up the construction1. Using the 
hygrothermal properties of the materials (section 16.1) and the environmental conditions 
(section 16.2) the program looks at each interface in the construction and calculates: 

 
• the amount of condensate deposited or evaporated during each month of a year; 

• the maximum amount of moisture   deposited; 

• the accumulated mass of water compared to total evaporation during the year; 

• the annual moisture balance. 

 
You can then use the results to assess the suitability of the construction for that environ- 
ment. 

To carry out condensation risk analysis: 

 
1. Define the element in the same way as you would for a thermal calculation (sec- 

tion 16.1). 

2. Set the environmental conditions (section 16.2); 

3. View  the  results  (section 16.3). 

 
16.1 Defining  the construction 

To carry out condensation risk analysis you must set the thermal resistance and vapour 
resistance of each layer which makes up the element, using the appropriate methods for 
each type of layer: 

 
• Normal materials: Enter the thickness, thermal conductivity and vapour resistivity. 

JPA Designer will calculate the thermal resistance and the vapour resistance. 

1The module can not carry out condensation risk analysis for ground floors, basements nor construc- 
tions containing variable layers; neither will it calculate the risk of surface condensation. 
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• Composite materials: Enter the thermal resistance and vapour resistance. Although 
the thickness is not required for the calculation, setting the thickness ensures the 
Dewpoint graph (Figure 16.3) looks right. 

• Fixed vapour resistance materials: These are designed to be used in condensation 
risk analysis to represent materials such as metals which have very high resistances 
even when used in thin layers. Enter the thickness, thermal conductivity and the 
vapour resistance. 

• Membranes: Enter the vapour resistance. 

• Cavities: Enter the thermal resistance. The vapour resistance of a cavity is always 
zero. Enter the thickness to ensure the the appearance of the Dewpoint graph. 

 
The data for each type of material and cavity is described in more detail in chapter 7.     If 
you have already carried out thermal calculations on the same construction you need 
only check that the vapour resistivity or resistance figures are correct. 

 
Units of vapour resistance and  resistivity 

JPA Designer uses the vapour resistivity with units of MNs/gm and vapour resistance with 
units of MNs/g. If material data is quoted as µ or sd values, multiply by five to obtain the 
resistivity or resistance respectively. You can find guidance on converting  from European 
units and from permeability and permeance figures in Annexes E.7 and E.8 of BS  
5250:2011. 

 
16.2 Environmental conditions 

The condensation risk calculation requires mean monthly data for: 

 
• External Temperature (Ext T) and External Relative Humidity (Ext RH); the external 

conditions depend upon the building’s location. JPA Designer includes external 
temperature and humidity data for a number of weather stations around the UK 
and Ireland, allowing you to select the nearest location to the project site2. Pick the 
nearest weather station to your site. 

To view a map of locations click View location of Google Maps3. For a ‘worst case’ 
scenario  select Eskdalemuir. 

• Internal relative humidity (Int RH); for buildings which are heated and naturally 
ventilated this is determined by the external relative humidity and moisture load 
generated by the activities taking place within the building. ISO 13788 defines five 
occupancy types with different humidity characteristics: BS 5250:2011 suggests 
relative humidity ranges for those types, see Table 16.1. 

2The UK data is taken from Meteorological data 1961 –1990 published by the World Meteorological 
Office, while the data for the Republic of Ireland comes from the Met Éireann. 

3Map courtesy of Andrzej Niedzielski. 
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Figure 16.1:  The Environmental conditions dialogue 

 

• Internal temperature (Int T); the design temperature inside the building, in degrees 
Celsius. The default for analysis is to use the same internal temperature throughout the 
year.  If no project temperature has been specified use 20ºC as a default value    for  a  
UK building. 

For fully conditioned buildings it is appropriate to use design internal  conditions, 
rather than derive them from the external conditions and moisture load. 

• Risk level: As the available climate data is based on mean values averaged over 
thirty year periods, there will be some years which have better conditions than  the 
mean and some years which will have worse. It is possible that constructions which 
are predicted to be free of condensation in average conditions will suffer 
condensation in colder and more humid years. BS 5250:2011 gives a method for 
testing the likely effect of worse than average years by means of risk years, with 
corrections to replicate the worst conditions likely over five, ten, twenty and fifty 
years. The appropriate return period for a calculation will depend on the sensitivity 
of the project to condensation: for example, a computer data centre might require 
a fifty year return period, while a house might only merit a five year return period. 

Environmental conditions data is entered using the Environmental conditions dialogue 
(Figure 16.1): 

1. On the Edit menu click Environmental conditions. 
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2. Make sure the Use 2003 Condensation Method is ticked (see chapter 17 for a de- 
scription of the previous method). 

3. Select the location of the building from the Building location list. The Ext T and Ext 
RH columns will be completed. If you have site specific data you can type values 
directly into the table. 

4. For a naturally ventilated building: 

• Tick Calculate internal conditions based on external conditions. 

• Set the Climate to  Maritime. 

• Select the humidity class in the Internal humidity class list. The Int RH column 
is completed. 

• Enter the internal design temperature in the  Internal temperature box.   The  Int 
T column displays the values. If you wish to vary the internal temperature 
throughout the year you can type values directly into the Int T column for each 
month. 

• Set the Risk level from the list. Selecting a return period will make the external 
conditions more onerous, with longer periods being harsher than shorter ones. 

5. For a conditioned building: 

• Tick Use design data for internal conditions. 

• From the list select a set of internal conditions. If you cannot find a suitable 
dataset in the list you may need to create the dataset before beginning analysis 
(see section 37.1. 

6. Click OK to accept the data and close the  dialogue. 

 
Table 16.1: Humidity classes 

 

Class Building type Relative humidity (%)  

  15ºC 20ºC 25ºC 

1 Storage areas <50 <35 <25 

2 Offices, shops 50–65 35–50 25–35 

3 Dwellings with low occupancy 65–80 50–60 35–45 

4 Dwellings with high occupancy, sports halls, 80–95 60–70 45–55 

5 Special buildings, e.g. laundry, swimming >95 >70 >55 

 pool    

 
 

16.3 Viewing results 

You can view the results of condensation risk analysis in three formats: 

• As month by month data, in the ISO Condensation Table (section  16.3). 

• As a graph, in the Dewpoint graph (section 16.3). 

• In summary form, in the Results table (section 16.3). 
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ISO Condensation Table 

The ISO Condensation Table shows the amount of condensate predicted at each interface 
in the construction, and is the most accurate means of viewing the results of an analysis 
to  ISO 13788. 

To view the ISO Condensation Table: on the View menu select ISO Condensation Tabler. 
 

Figure 16.2:  ISO 13788 Condensation  table 

 
The upper part of the window (Figure 16.2) shows the interfaces within the construction. 
When you select an interface by clicking on it, the lower half of the table shows the 
amount of condensation predicted at that interface. It shows the amount of condensate 
deposited or evaporated each month, gc, and the accumulated condensate at the end of 
each month, Ma, both measured in g/m2. A negative amount of condensate indicates 
the amount of moisture predicted to evaporate in that month. 

The results always start with the first month in which condensation is predicted: if no con- 
densation is predicted in any month results start with January. Guidance on interpreting 
results is given in ISO 13788 and BS   5250. 

 
The  Dewpoint graph 

In condensation risk analysis the dew point is the temperature at which air would be 
saturated with vapour. Condensation occurs when the temperature at a point with in the 
construction drops below dew point and the air cannot support all the water vapour, 
resulting in some of the excess being deposited as liquid water. 

The Dew point graph is a visualisation of the relationship between the predicted temper- 
ature through an element and the dew point. The orientation of the Dew point graph is 
determined by the building element: walls are shown with layers running vertically and 
roofs with layers running horizontally. 

The graph shows two lines: 
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• the temperature gradient through the construction, calculated for each interface, 
shown in red; and, 

• the dew point at each interface, shown in blue. 

 
The lines are plotted for the month with the worst condensation conditions. 

Where the two lines do not touch the actual temperature is above dew point and no 
condensation is predicted at those interfaces. Condensation is predicted at any interface 
where the two lines touch (see Figure 16.3). Note that the actual temperature will never 
be lower than the dewpoint and the lines will never cross. 

 

Figure 16.3: Dewpoint graph for a roof with condensation predicted at the interface 
between layers 4 and 5 

 
To open the Dewpoint graph: 

 
• on the View menu select Dewpoint graph; or, 

• click the Dewpoint graph button on the tool bar. 

 
To view the results for the month with the greatest evaporation, click the Summer button 
in the Results to show section. 
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The Results table 

The Results Table shows the headline results for each interface in the construction. To 
view the Results table: on the View menu click Results Table. When the table is open 
click the Always on top box to keep it visible on screen while you continue to work on 
the calculation.  When you have finished, click Close to close the Results  Table. 

For calculations to ISO 13788 the significant columns  are: 

 
• ISO - Winter worst build up:  the month in which the highest amount of condensate   

is predicted to be  deposited; 

• ISO - Winter peak build up: the month which sees the highest cumulative amount 
of condensation. 

 
For each column the amount of condensate is shown in grams per square metre g/m2. 
The result n/a means no condensation is predicted at that interface. You can see more 
detailed results in the ISO Condensation table. 

 
Producing reports 

The results of condensation risk analysis can be printed or produced as PDF files in the 
same way as the results of thermal calculations (chapter 12). 

 

Figure 16.4: The Sections To Print dialogue for condensation risk reports 

The main differences are: 

1. Before starting to print or create a PDF, tick the Condensation risk box on the status 
bar at the bottom of the main U-value    window. 

2. In the Sections To Print dialogue review whether you want to print the summer-time 
condensation results and the ISO moisture table and tick the appropriate boxes. 



 

 
 
 

17 Using the BS 5250:1989 calculation 
method 

 

 
 
 
 
 

 

The  BS 5250:1989 Appendix D method is based on the same underlying principles as  the 
method set out in ISO 13788, but analyses condensation risk for a 60 period rather than 
the whole year and reports results in a different way. The Appendix D method is no longer 
referred to by building regulations and standards, but is still available within JPA Designer. 

To use the BS 5250: 1998 calculation method open the Environmental conditions dia- 
logue and untick Use 2003 condensation method. The dialogue box will now show the 
environmental data for the BS 5250:1989 method. 

 
17.1 External conditions 

The program sets standard values for external environmental conditions, following BS 
6229:1982 and BS 5250:1989, which   are: 

 
• summer  temperature: 18ºC. 

• winter temperature:  5ºC. 

• summer relative humidity: 65%. 

• winter relative humidity: 95%. 

 
If you need to calculate condensation risk for other external environments you can change 
the standard values by typing new values into the text boxes. To return to the default 
values for external environmental conditions click the Default button. 

Build-up of condensate is assessed over a standard 60 day winter period: that value can 
be changed using the Condensation build up period box. 

 
17.2 Internal conditions 

The internal temperature and relative humidity values will be determined largely by the 
building use. You can enter design data or measured values in the four boxes, or select 
one of the pre-defined building use groups listed in Building Use, which are taken from 
BS 5250 and BS 6229, Table   7. 
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17.3 BS  5250:1989 results 

Once you have set the environmental conditions you can view the calculation results 
using the Results table (section 16.3) and the Dewpoint graph (section 16.3). On the 
results table the important columns are: 

 
• Winter buildup which shows the build up of condensate over the 60 day winter 

period; and, 

• Annual buildup the amount of condensate carried over into the next year. A nega- 
tive figure indicates there is no condensation carried forward. 

 
Both figures are given in g/m2. 

 
17.4 Calculation options 

The BS 5250:1989 method does not allow for the removal of moisture by air movement, 
however, the standard suggests some indication of the effect of vented cavities can be 
obtained by assuming the air in the cavity is at outside  conditions.  This  can  done  by setting 
to zero the vapour resistances of the materials to the outside of a cavity. 

For an explanation of the limitations of this technique please refer to BS 5250: 1989 page 
76. 

To use this option in JPA  Designer: 

 
1. In the Options dialogue go to the Other tab. 

2. Tick Set vapour resistance of layers above vented cavity to zero. 

3. Open the condensation risk calculation. 

4. Double click on the cavity  layer. 

5. In the Edit material dialogue set the cavity type to vented cavity. 

 
The program will set the vapour resistance of the layers outside the cavity to zero. 
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18 The JPA Designer SAP 2012 module 
 

 
 
 
 
 

 

18.1 Overview of the SAP 20012  module 

The JPA Designer SAP 2012 module enables you to carry out calculations to demonstrate 
a dwelling complies with the requirements of Part L 2013 (England), Part L 2014 (Wales) 
and Section 6, 2015 (Scotland)1. The module also lets you issue energy performance 
certificates (EPCs) for new dwellings2, whilst the results of calculations may be used as 
part of assessments under the Code for Sustainable Homes. 

The SAP 2012 module uses the SAP 9.92 methodology  to: 

 
• calculate the Target Fabric Energy Efficiency (TFEE) and Dwelling Fabric Energy 

Efficiency (DFEE); 

• calculate the Target Carbon Dioxide Emission Rate (TER) and the Dwelling Carbon 
Dioxide Emission Rate  (DER). 

• check for compliance against a number of other criteria set out in Approved Doc- 
ument L1A and in the Domestic Building Services Compliance    Guide. 

 
Whilst this section of the manual gives instructions on how to enter data into the program 
it does not offer authoritative guidance upon SAP 9.92 nor the Building Regulations. We 
suggest you use this manual in conjunction with the government’s guide to SAP (available 
from the BRE web site - www.bre.co.uk/sap2012) together with the appropriate Approved 
Document  or Technical  Handbook. 

 
18.2 Preparing to carry out a SAP 2012   calculation 

Before starting a SAP calculation you should ensure you have all the input data, including: 

 
• dwelling floor area; 

• the ventilation strategy; 

1For Northern Ireland you should continue to use SAP 2009 - V9.90, which is described in the JPA 
Designer 5.01 user manual. 

2In order to issue an EPC you will need to be a member of a government approved accreditation 
scheme. You can find more information on suitable accreditation schemes on our web site. 
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• the design or achieved air permeability; 

• U-values, κ-values (kappa-values) and areas of external, and party, walls, roofs and 
floors (you can carry out the U-value and κ-value calculations using one of the JPA 
Designer U-value modules); 

• κ-values and areas of internal walls and floors; 

• ψ-values (psi-values) for junctions and the lengths of junctions; 

• U-values, areas, orientation and glazing details of windows, doors and rooflights; 

• the water heating system; 

• the primary and secondary heating systems; 

• details of any photovoltaic cells or other low carbon technology. 

 
18.3 Carrying out a SAP 2012 calculation 

Carrying out a SAP 2012 calculation  using  JPA  Designer  is  straight  forward.  The  main  SAP 
window shows the on-going results of the calculation and the compliance status of    the 
dwelling, while you enter data in  the  SAP  Worksheet  Values  dialogue.  Once  you have 
finished entering data you can print off the results or make adjustments to the data. The  main 
steps are: 

 
1. Create a new SAP 2012 calculation (section  3.7). 

2. Open the calculation in the SAP module (section 3.9). 

3. Enter the Project Information (section 18.5). 

4. Open the SAP Worksheet Values dialogue  and enter  the dwelling  data  (section 18.6). 

5. Check the compliance status on the main SAP window (section 18.4) and make any 
necessary changes. 

6. Produce print-outs or PDF files of the calculation reports (section 29.2). 

7. Save your project (section 3.5). 

 
18.4 The SAP window 

The SAP window lets you access the SAP menus and tool bar and displays the results of 
calculations (Figure 18.1). The main features are: 

 
1. The menu bar. 

2. The  SAP 2012 toolbar:  the buttons give direct access to key program functions and   
to the tabs on the SAP Worksheet Values     dialogue. 

3. The status indicators which show how much data you have entered for each section 
of the calculation (see below for a more detailed description). 
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Figure 18.1:  The main SAP window.  1 – Menu bar.  2 – Toolbar.  3 – Status indicators.   4 
– SAP version. 5 – Calculation name. 6 – Fabric Energy Efficiency results. 7 – Dwelling 
emissions results. 8 – Fabric U-values. 9 – Overheating assessment. 10 – SAP rating.   11 
– Compliance status. 
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4. The SAP version – in this case SAP 9.92, SAP    2012. 

5. The calculation name, as entered in the Project Manager window. 

6. The TFEE and DFEE results. 

7. The TER and DER  results. 

8. Fabric U-values for opaque elements (floors, walls, roofs) and for openings. In each 
line the first number shows the worst (highest) U-value and the second the area- 
weighted average. 

9. Overheating risk assessment. 

10. Carbon dioxide emission and SAP results, including the average Heat Loss Param- 
eter (HLP). 

11. Compliance zone. This shows green for a pass and red for a fail. If the dwelling does 
not comply you can hold your mouse cursor over this zone to show a tool-tip 
identifying the primary cause of failure (Figure 18.2). Double clicking on the zone 
will open the Compliance  Checklist. 

 
 

 

Figure 18.2: Tool tip showing the primary cause of  failure 
 

 

 

Figure 18.3: The SAP toolbar: 1 – Return to Project Manager. 2 – Print. 3 – Exit JPA 
Designer. 4 – Project information (section 18.5). 5 – Dimensions tab (chapter 19). 6 – 
Ventilation tab (chapter 20. 7 – Walls, roofs and floors tab (chapter 21). 8 – Openings tab 
(chapter 22). 9 – Hot water tab (chapter 23). 10 – Primary heating tab (chapter 24). 11 – 
Secondary heating tab – (chapter 25). 12 – Overheating tab (chapter 26). 13 – 
Photovoltaic and alternative technologies tab (chapter 28). 

 
The  toolbar buttons are shown in Figure 18.3;  the majority of them open the SAP 9.92  2012 
Worksheet Values dialogue at different tabs. The coloured status indicators below many of 
the toolbar buttons indicate the status of the data you have supplied for that part  of  the 
calculation: 

 

• Red: There is none or very little data in that section. 
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• Orange: Most of the data is there, but one or two items in that section are still 
missing. 

• Green: All the data necessary for completing the SAP calculation has been entered. 

 
The indicators provide a quick way of seeing how far you have come in a calculation. 
However, you must remember the indicators refer only to the extent of data you have 
entered and have nothing to do with whether a dwelling will comply with regulations. 

 
18.5 Project information in SAP 

A SAP 2012 calculation requires general information about the project (such as the name 
and address of the client), the project address and basic information about the dwelling 
itself. All this information is entered in the Project Information dialogue (Figure 18.4), 
which is opened by selecting Edit>Project Information from the menu bar. 

 
Address details 

The  client and project address details are shown on calculation worksheets and reports.  The  
location of the dwelling, which affects some parts of the SAP calculation, is set using  the 
project address  details. 

The client name and address, and the dwelling address should be typing into the appro- 
priate fields (items 1, 2 and 3 in Figure 18.4) . Use the <Tab> key to move between fields. 
You can also use the Inherit button to use the address details for the project in the current 
calculation (see section 3.3 for instructions.) The Pass down button can be used to copy 
the address details to all other calculations in the project. 

You can add plot numbers and drawing references to link the calculation to a set of 
drawings or a naming scheme. Note the Date (Figure 18.4 item 3) is used in an EPC 
lodgement as the survey date. 

It is essential to enter a post code for the dwelling, as the EPC recommendations are based 
on local climate conditions, set by post code. Where the dwelling does not have a full 
post code – perhaps because it has not been assigned yet – you need only enter the first 
block, e.g. BT25. (However, the UPRN box and the get UPRN and clear UPRN buttons  are 
only used when preparing to issue an EPC.) 

 
Dwelling details 

Project Information contains general information about the dwelling: 

 
• Building type (Figure 18.4 item 7): this is used in the Energy Performance Certificate. 

Select the closest matching value from the drop-down.  It is particularly important      to 
select the correct option for  flats. 

• Country: the regional authorities in the UK have implemented SAP in slightly dif- 
ferent ways. You must use the Country drop-down to select the correct location to 
ensure the dwelling is tested against the appropriate regulations. If the country and 
the location (see below) do not match, the program will give a warning. This can be 
overridden using the Relax country check box (see section 18.5). 
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Figure 18.4: The Project Information dialogue 
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• EPC language (Figure 18.4 item 8): sets the language in which the EPC is produced. 

EPCs in England, Scotland and Northern Ireland must be produced in English. EPCs 
in Wales may be issued in in English or   Welsh. 

• Location (Figure 18.4 item 9):  this is used to in the overheating assessment and   in 
SAP calculations for dwellings with space cooling.  To  set the Location enter   the 
Post code (Figure 18.4 item 3) , then click Look-up (Figure 18.4 item 10). The 
program then sets the region. There is a map of SAP regions in Table 10 of the SAP 
2012 document. 

Where the dwelling does not have a full post code – perhaps because it has not been 
assigned yet – you need only enter the first block – e.g. BT25 – for the Location 
look-up to work. 

• Project type (Figure 18.4 item 11): defines whether the  calculation  is  for  a  new build,  
existing dwelling  or conversion. 

• Related party disclosure (Figure 18.4 item 12): overrides the default disclosure for 
EPCs for that calculation. 

 
SAP calculation options 

The bottom of the Project Information dialogue contains several calculation options: 

 
• Treat low e glass coating as ‘soft’ (Figure 18.4 item 13): this is a legacy setting which 

affected calculations in SAP 9.70 and 9.80/1. It has no effect on SAP 2012 
calculations. 

• Enter gross opaque element areas (Figure 18.4 item 14): the SAP 2012 calculation uses 
the net areas of walls and roofs, after the areas of openings (doors,  windows  and 
rooflights) have been removed). If you select  this  option  you  can  enter  the gross 
areas of walls and roofs, and the program will determine the net areas, by subtracting 
the areas of windows and rooflights as they are specified. 

If you change the setting of this box the software then close the Project Informa-   tion 
the program asks if you want to use that setting as the default value for future 
calculations. 

You can only change this setting before you have started to enter data in the SAP 
Worksheet dialogue. Once you have entered data the tick box will be greyed-out 
and inaccessible. This is to prevent the setting being changed halfway through a 
calculation and so avoid errors. 

• Boiler comes under the exception procedure allowed in Part L (Figure 18.4 item 
12): The Domestic Building Services Compliance guide requires new or replace- 
ment gas or oil boilers to have efficiency levels which can only be achieved by con- 
densing appliances. A non-condensing boiler may be be permitted if the situation 
meets the conditions in the government’s Condensing boiler installation assessment 
procedure for dwellings3. You may therefore only tick this box if the conditions of 
the assessment procedure are satisfied. 

3Guide to the Condensing Boiler Installation Assessment Procedure for Dwellings.  DCLG. 2005. http:/ 
/www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_CONDBOILER.pdf 

http://www.planningportal.gov.uk/uploads/br/BR_PDF_PTL_CONDBOILER.pdf
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• Relax country check: by default JPA Designer checks to see the selected country 
and region match, using the Post code for the dwelling. However, there are some 
post code areas which cross country boundaries, resulting in erroneous warning 
messages. Ticking this box disables the check between region and country, allowing 
the country to be set correctly. 

 
Once you have entered all the necessary data, click   OK. 

 
18.6 Entering information about the dwelling 

The data for the SAP calculation is entered using the SAP 9.92 2012   Worksheet Values 
dialogue. The dialogue has a series of tabs, each covering one part of the SAP input data: 

 
• Dwelling dimensions: the basic configuration of the dwelling, including the pro- 

portion of low energy lighting (chapter 19). 

• Ventilation: air infiltration rates, ventilation strategy and system efficiency (chap- 
ter 20). 

• Walls, roofs and floors: heat loss and thermal mass of the opaque building fabric 
(chapter 21). 

• Openings: heat loss, solar gain and daylighting information for windows, doors and 
rooflights (chapter 22). 

• Water heating: the source of domestic hot water, its efficiency and fuel type, in- 
cluding details of any solar panels (chapter 23). 

• Primary heating: the main heating system, controls and fuel (chapter 24). 

• Secondary heating: any additional heating system (chapter 25). 

• Overheating and cooling: details for summer overheating, and any fixed cooling 
systems (chapter 26 and chapter 27). 

• PV & Alt Tech: Photo-voltaic panels, wind turbines, and new renewable technolo- 
gies (chapter 28). 

 
To open the dialogue at the start of a calculation, click on the Dwelling dimensions button 
on the toolbar or on the Edit menu click Dwelling dimensions. 

The tabs are listed at the top of the dialogue in the same order as they appear in the Edit 
menu (Figure 18.5). To move between sections simply click on the tabs. We recommend 
you work from left to right, starting with Dwelling Dimensions and finishing with PV & 
Alt Tech. 

 

Figure 18.5: Tabs on  the  SAP  9.92  2012  Worksheet Values  dialogue 

At the bottom of the dialogue are a series of buttons (Figure 18.6): 
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Figure 18.6: The buttons on the SAP Worksheet Values  dialogue 

 

• OK: Revises the calculation taking account of any changes you have made to the 
data, and closes the dialogue. 

• Cancel: Closes the dialogue but ignores any changes you have made to the calcu- 
lation. 

• Apply: Revises the calculation, taking account of any changes you have made to 
the data, but leaves the dialogue open. 

With a monitor set to 1024 by 800 pixels or higher, it is possible to see the main SAP 
window and the SAP 9.92 2012 Worksheet Values at the same time. By using the 
Apply button you can see the effect of design changes upon the calculation 
immediately. 

• Help:  Gives you access to the government’s  SAP guidance and an on-line version       
of  this manual. 

• Last: Takes you to the previous tab. 

• Next:  Takes  you to the next  tab. 



 

 
 
 

19 Dwelling dimensions 
 

 
 
 
 
 

 

The Dimensions tab (Figure 19.1) is used to enter data on the: 

 
• area and volume of the dwelling; 

• living area of the dwelling 

• low energy lighting; 

• dwelling orientation. 

• position of a flat or maisonette in a block (Scotland only). 
 
 

 

Figure 19.1:  The Dimensions tab 
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19.1 Dwelling area and volume 

The area and volume of the dwelling each storey are used throughout the SAP calculation, for 
example, to determine hot water and lighting usage and the rate of heat loss through 
ventilation. 

The calculation requires the floor area of each storey and the average storey height. 

 
• Floor areas are measured to the internal surfaces of the walls bounding the dwelling, 

and shouldinclude built-in cupboards accessible from the occupied area of the 
dwelling and all porches and conservatories which are heated and form part of  the 
habitable space. (Exclude porches and conservatories which are unheated and 
thermally separated from the living space.) 

• The average storey height for the lowest floor of a dwelling is measured from fin- 
ished floor surface to ceiling surface. For every other storey, the height is measured 
from the ceiling of the floor below to its own ceiling. This convention ensures that 
the volume of the floor structure is included within the calculation. For room in the 
roof constructions you will need to determine an average storey height. 

 
For each storey enter the floor area, in m2, and the average room  height,  in m),  against  the 
appropriate row in the list. JPA  Designer  will  calculate  and  display  the  volume  of each 
storey, the total floor area of the dwelling and the  total volume  of  the  dwelling.  Note that: 

 
• Values must be entered against the appropriate storey. This is particularly important 

for flats: do not use ground floor unless it actually is a ground floor flat. Assigning 
floor area to the wrong floor will not affect the results of the SAP calculation, but 
incompatibilities between storey and party floor values will prevent lodgement of 
the EPC. 

• Enter data for storeys on the fourth floor and higher on the final line. 

• Where a floor has a different occupancy beneath it (such as another flat, maisonette, or 
retail unit) tick the party box on that    row. 

• For party storeys on the fourth floor or higher enter the floor number in Party floor 
storey. The storey number is the floor number plus one:  for example, the second  floor 
has a storey number of  three. 

• The two lines for Ground floors, allow for dwellings which have a double height 
lounge. 

• The Exposed floor line may be used for floors of apartments which are over garages, 
parking  bays  or walkways. 
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19.2 Living area 

The SAP 2012 calculation divides a dwelling into two parts: 
 

• the living area which is the part of the dwelling presumed to be used most frequently; 
and, 

• the rest of the  dwelling. 
 

The living area is defined as the the room marked on the plan as the lounge or living room, 
or the largest public room. The area of other rooms which are not separated from the 
living room by doors should also be included. However, the living area cannot extend over 
more than one storey. 

Enter the living area, in (m2), in Total floor area which is living area. JPA Designer will 
calculate the living area fraction. 

 
19.3 Low energy lighting 

The proportion of low energy lighting is used in the calculation of electricity consumption 
for lighting, with a higher proportion of low energy lighting resulting in lower electricity 
use and a lower DER. The proportion of low energy lighting is also used to test compli- 
ance with the minimum efficiency standards for fixed building services, which currently 
require at least 3 out of 4 light fittings (a fraction 0.75) to be low energy. Enter: 

 

• the total number of lighting units, in Total fixed lighting outlets; 

• the number of lighting units which count as low energy lighting, in Low energy 
lighting units. 

 

JPA Designer displays the Fraction of low energy lighting. 

At the design stage, when it is unlikely that the exact number of lighting units will be  known,  
the simplest strategy is to set the total number of units to 10 or 20,  then set         the number 
of low energy units to give the correct proportion: 15 out of 20 will give a proportion of 0.75.  
An accurate value is required for the EPC submission. 

 
19.4 Orientation 

The orientation of the dwelling is used with the data on openings for solar gain and 
overheating calculations. 

To set the orientation, select a direction in the Front of dwelling faces list: 
 

• For a house, it is usually easiest to treat the elevation containing the front door as 
the front face. 

• For an block of flats it may be better to treat the front of the block as the front face  
for all flats, rather than setting different front orientations for each   flat. 

 

The Application date is used in the EPC submission as the date on which the final EPC 
assessment was performed. Clicking the down arrow will open a calendar. 
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Figure 19.2:  Entering position in block for Scotland 

 
19.5 Position in block 

The TER calculation for section 6 in Scotland calculates the output of solar panels on the 
notional dwelling from the roof area of the actual dwelling. For flats and maisonettes that 
notional output is divided by the total number of dwellings beneath the roof area.In order 
to carry out this calculation the number of dwellings above and below a flat or maisonette 
must be entered in the Non-domestic premises in the same building are treated as one 
dwelling. 

When the calculation region has been set to Scotland the Dimensionstab includes two 
addition boxes for the Number of dwellings above and Number of dwellings below boxes 
(Figure 19.2). JPA Designer will check the values entered into the two boxes against the 
definition of the flat or maisonette in the Project Information dialogue. It will warn you 
if the values are incompatible (e.g. a top floor flat with one or more flats above, or a mid 
floor flat with no flats above). 



 

 
 
 

20 Ventilation 
 

 
 
 
 
 

 

SAP determines the heat loss produced from air movement between the inside and out- 
side of a dwelling by  considering: 

 
• air infiltration through the building fabric. 

• details of the ventilation  arrangements. 

 
Data for air movement is entered using the Ventilation tab (Figure 20.1). 

 

Figure 20.1: The Ventilation tab 
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20.1 Air infiltration 

Air infiltration represents unplanned air movement. It is expressed as the volume of air 
which passes in one hour through a square metre of the surface of the building envelope: 
m3/hm2. The value is is often referred to as the q50 value, after the calculation result in 
BS  EN 13829. 

There are three methods to enter the air infiltration data into the    software: 

 
• Using the results of pressure  testing. 

• On developments of one or two houses, using an assumed value.. 

• Allow the software to calculate the infiltration rate from the construction type and 
building size. 

This final method is not valid for demonstrating compliance under building regula- 
tions. 

 
Pressure  test data 

Where air infiltration is being measured by pressure testing, the initial SAP calculation 
uses a design air permeability value, which is replaced by a final assessed permeability 
value once the dwelling has been completed. 

To enter design stage air permeability: 

 
1. At Source of q50 value select Pressure test. 

2. Enter the air permeability in the Design q50 box. 

3. Set the radio buttons to as   designed. 

4. Tick This dwelling has been pressure tested. 

 
The pressure testing regime set out in Approved Document L1A requires a proportion of 
dwellings on any site to be pressure tested1. The assessed air permeability used in the as-
built SAP calculation depends on whether or not the dwelling in question has been tested 
itself: 

 
• dwellings which have been tested: the assessed air permeability is the result from 

testing. 

• dwellings which have not been tested: the assessed air permeability is the average 
results for that dwelling type, increased by two. 

 
To  enter as-built air pressure test data for a tested   dwelling: 

 
1. Enter the measured air permeability in the Design q50 box. 

2. Set the radio buttons to as   designed. 

1There are similar, but  not  identical  requirements  in  place  for Wales  and  for Scotland 
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3. Tick This dwelling has been pressure tested. 

 
To enter as-built air pressure test data for a dwelling which has not been tested itself: 

 
1. Enter the average air permeability for the dwelling type in the Design q50 box. 

2. Set the radio buttons to  as-built. 

3. Do not tick This dwelling has been pressure tested. JPA Designer will increase the 
entered pressure test value in the SAP and DER calculations by two. 

 
Small developments 

Pressure testing is not required for developments of one or two houses, provided the DER 
calculation is carried out using an air permeability of 15 m3/hm2: 

 
1. At Source of q50 value select Assumed value. 

2. Tick the Small development box, which indicates the dwelling is part of a develop- 
ment of one or two   dwellings. 

If you do not tick the box the dwelling will fail its compliance  checks. 

 
The Design q50 box is now fixed at  15 m3/hm2. 

 
Using a calculated air permeability   rate 

Where a dwelling is not subject to the air pressure testing requirements of Part L an air 
permeability value can be estimated from basic details of the construction and configu- 
ration of the dwelling. This is suitable for calculations for existing dwellings to Approved 
Document L1B. 

 
1. At Source of q50 value select Calculated. The tab shows additional text boxes. 

2. Specify: 

• the Type  of  construction; 

• whether there is a draught   lobby; 

• the  floor construction; 

• the number of storeys. 

 
The software then calculates an air permeability rate based on the SAP defaults. 
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20.2 Ventilation openings 

In the Ventilation section enter details of the ventilation openings for the dwelling. Use 
the boxes to enter the numbers of: 

 
• Chimneys: vertical ducts for combustion gases with diameter greater than 200 mm. 

• Flues: vertical ducts for combustion gases with diameter less than 200 mm. 

Chimneys and flues should be assigned to the main or secondary heating systems, 
or another appliance. There is no need to enter room-sealed and balanced flues to 
heating appliances, as they do not affect air movement in the occupied space. 

• Flueless gas fires2. 

 
20.3 Sheltered sides 

The rate of air infiltration resulting from the wind is affected by the number of exposed 
sides of the dwelling. SAP 2012 therefore adjusts infiltration according to the number of 
sheltered sides a dwelling has. 

A sheltered side is: 
 

• a party wall; 

• a side which is sheltered by neighbouring buildings. The exact conditions are de- 
scribed in section 2.5 of the SAP 2012  document. 

 
The number of sheltered sides is entered in the Sheltered sides box. If the local conditions 
are unknown, use a default value of two sheltered sides. 

 
20.4 Ventilation type 

There are two steps to defining the ventilation arrangements for the dwelling: 
 

1. Use the Ventilation Type radio buttons to specify the type of ventilation in the 
dwelling (see section 2.6 of the SAP document for details of the different ventilation 
systems). 

2. Specify the details of the   system. 
 

For all ventilation systems leave the box 100% draught-stripping ticked. 

The additional performance data for systems that require it can be set in three different 
ways: 

 
• Use the Default performance values built into the SAP specification. 

Although this is a valid option for calculation, the defaults values will give signifi- 
cantly poorer results than the other options. 

2Although the gas fires themselves are flueless, building regulations require specific ventilation provi- 
sion for each appliance which will result in heat loss through air  exchange. 
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Figure 20.2: Setting the source of mechanical ventilation data 

 

• User defined: allows you to enter your own performance values, such as those 
supplied  by  product manufacturers. 

• Database: performance values from the Product Characteristics Data File (PCDF) 
maintained by BRE. 

The PCDF values should be used wherever possible, as they will be most accurate. 

 
Default  performance values 

To use default values select Default at Source of mechanical ventilation parameters. This will 
give a poor result for the dwelling as the default values are significantly worse than 
manufacturers’ data. 

If the ventilation system consists of intermittent extract fans or passive vents in bathrooms 
and toilets, enter the number of intermittent fans or passive    vents. 

 
Use-defined  performance data 

To  enter user-defined performance  data: 

 
1. Select User defined at Source of mechanical ventilation parameters 

2. Click Enter details. 

3. Complete the details required for the specified system in the User Defined Mechan- 
ical Ventilation dialogue. 

 
The parameters required for each ventilation type are: 

 
• For balanced whole house mechanical ventilation (Figure  20.3): 

– Brand and model of   system; 

– Duct type and whether or not the duct is insulated; 
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Figure 20.3: User defined data for balanced whole house mechanical  ventilation 

 

Figure 20.4: User defined data for decentralised mechanical whole house extract venti- 
lation 

 
– Specific Fan Power (SFP); 

– Number of wet rooms excluding the kitchen; 

– Efficiency of heat recovery. 

• For positive input ventilation from outside: 

– The duct configuration. 

• For positive input ventilation from the loft: 

– No additional data. 

• For centralised mechanical extract ventilation (MEV): 

– The Specific Fan Power  (SFP); 

– whether the ducting is rigid or flexible. 
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• For decentralised mechanical whole house extract ventilation (Figure 20.4: 

– The Specific Fan  Power (SFP) and number of fans; differentiating between fans  in 
the kitchen and other wet rooms, and between in room, in duct and through wall 
fans. 

 
Using the Product Characteristics Data File 

 

Figure 20.5: The Mechanical Ventilation Database dialogue 

To select value from the database: 

1. Select Database at Source of mechanical ventilation parameters . 

2. Click Lookup. 

3. In the Mechanical Ventilation Database dialogue (Figure 20.5) select the Manufac- 
turer. The list of available products appears. 
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4. Select a product by clicking on  it. 

5. Specify the number of Wet rooms excluding kitchen. 

6. If the ductwork is insulated tick the Insulated duct box. 

7. For decentralised mechanical whole house extract ventilation, instead of steps 5 and 
6, enter the number of fans in kitchens and other wet rooms (Figure 20.4) agains 
the appropriate fan type. 

8. Click the Use the selected system button. The dialogue closes and the summary of 
the system is displayed next to the Database radio button. 

 
If the ventilation system consists of mechanical extract ventilation (MEV) or balanced 
whole house ventilation with heat recovery (MVHR) which feeds an exhaust air heat 
pump you must tick the MEV or MVHR is part of exhaust air heat pump before opening 
the database, otherwise the products will not be displayed. 

 
Ducted systems 

 

Figure 20.6: The MVHR Duct dialogue 

 
The configuration of ductwork will affect the efficiency of ducted systems, as rigid ducts 
are more efficient than flexible ducts: this is reflected in the in-use factors for ductwork. 
Semi-rigid duct should be treated as flexible ducts, unless they have been demonstrated 
to work as well as rigid ducts and are listed in the  PCDF. 

To add a semi-rigid duct to the  calculation: 
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• Tick Duct from database (Figure 20.2). 

• Click Lookup. The MVHR Duct dialogue opens (Figure 20.6). 

• Select  the Manufacturer. 

• Select a duct from the list shown for that    manufacturer. 

• Click Use the selected duct. 

• The duct is now shown in the Ventilation tab. 

 
Approved installation schemes 

Theoretically, a ventilation system fitted under an approved installation scheme will be 
more efficient than one fitted without quality control. Therefore, ticking Approved instal- 
lation scheme improves the efficiency of a whole house ventilation system. However, at 
the time of writing (2015–11–02) there is no such scheme in place and consequently no 
reason to tick the box. 



 

 
 
 

21 Walls, roofs and floors 
 

 
 
 
 
 

 

The data on the opaque building fabric — walls, roofs and floors — is used to  calculate: 

• the rate of fabric heat loss for the dwelling through building elements; 

• the rate of heat loss through junctions between   elements; 

• the thermal mass of the   dwelling. 

The  data  is  entered  using  the  Walls,  roofs  &  floors  tab  of  the  SAP  Worksheet values 
dialogue (Figure 21.1). 

 

21.1 Defining building elements 

SAP 2012 requires data for all elements of the building fabric, including: 

• Exposed elements which separate the building interior from outside, or from an 
unheated space, or from an adjacent occupancy with a different heating pattern. 

• Party elements which separate the dwelling from another space with a similar heat- ing 
pattern. 

• Internal walls and floors. 

The data required for each element depends on its function: the principle items being: 

• Area: the surface area of the element, in m2, which should be measured to the 
boundaries of internal finished surfaces. If you have chosen to use gross areas for 
opaque elements there is no need to subtract the areas of openings from wall or 
roof areas. 

When adding internal walls, the areas of both sides of the wall should be measured. 

• U-value: the rate of heat transfer through the element. U-values should be calcu- 
lated to BR 443 Conventions for U-value calculations. The JPA Designer U-value 
module may be used for this. The requirements for U-values for different elements 
are summarised in Table 21.2. Note that for party walls between dwellings the U-
values must be taken from Table 21.1. 

• κ-values (kappa-values): this is the heat capacity of the element, which expresses 
the amount of energy required to raise its temperature. Table 1e of the SAP docu- 
ment contains additional information about κ-values. 
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Figure 21.1:  The Walls, Roofs and Floors tab 

 
 
 
 
 
 
 
 
 

Table 21.1:  U-values for party walls 
 

Party wall construction U-value (W/m2K) 

Solid 0.0 
Unfilled cavity with no effective edge sealing 0.5 

Unfilled cavity with effective edge sealing 0.2 

A fully filled cavity with effective sealing 0.0 
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Table 21.2: U-values for building elements 
 

Element U-value Notes 

Exposed element As calculated  

Semi-exposed As calculated Ru adjustment to U-value 

Party wall between dwellings 

Party wall – similar heating pattern 

From Table 21.1 

0.00 W/m2K 

 

Party wall – different heating pattern 

Party floor – similar heating  pattern 

Half calculated value 

0.00 W/m2K 

 

Party floor – different heating pattern 

Party  ceiling – similar heating  pattern 

Half calculated value 

0.00 W/m2K 

 

Party ceiling – different heating  pattern Half calculated value  
Internal wall N/A Take  area of both sides 

Internal floor N/A  
Internal ceiling N/A  

 

The Element dialogue 

The  Element Dialogue is used to enter data on each of the dwelling’s  opaque elements   
(see Figure 21.2):  it takes the following   data: 

 
• Element: Use the drop-down to set the type of element from the list. The element type 

is used for checking average U-values, so it is important to set the right element type. 

• Curtain wall:  Tick this box if the wall element consists of curtain  walling. 

Curtain walling has to be treated differently from normal walls in order to obtain the 
correct values for heat loss and solar gains. The area of wall should be entered as 
normal, but the U-value set to that of the whole curtain wall system. The window 
area should also be that of the whole facade, with the same U-value. 

• Construction: the drop-down lists a number of common constructions for the spec- 
ified element type, and offers a quick way of setting the heat capacity for the ele- ment. 
Alternatively, you can leave the construction blank and enter the heat ca-  pacity  
directly. 

• Party wall type: this drop-down is only displayed if the Element is a party wall. 
Select the appropriate construction: that will also set the U-value. 

• Storey: this box is only displayed if the Element is a party floor or internal floor. Set the 
storey number, relative to the building (not just the dwelling) The storey number   is the 
floor number plus one: for example, first floor is storey 2. 

• When Element is set to internal floors the program displays the Ceiling below drop- 
down: select the internal ceiling which forms the other part of the internal floor 
construction. 

You should therefore define the internal ceiling elements before you enter the inter- 
nal floors. 

• Heat capacity: enter the heat capacity (κ-value) for the element: if you have se- 
lected a Construction its default heat capacity will already be entered. 
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Figure 21.2:  ElementDialogue 

 
• Area:  Enter the area of the element. 

If you have chosen to use gross areas the text above the Area box will read Enter areas 
INcluding doors, windows rooflights. If it reads EXcluding doors, windows rooflights 
you must enter net   areas. 

• U-value: Enter the U-value in the text box. If you have already carried out the U-
value calculation in the same JPA Designer project you can select it using the Link 
to this U-value calculation drop-down: that creates a permanent link between the 
element in the SAP calculation and the U-value calculation; the software will update 
the SAP calculation if the U-value  changes. 

• Effective thermal resistance of unheated space (Ru): The Ru coefficient is used to 
adjust the U-value of an element to allow for the beneficial effect of an enclosed but 
unheated space to its exterior. The commonest unheated spaces are integral garages 
in houses and access corridors to apartment blocks: some parts of room-in-the-roof 
constructions are also treated as unheated spaces. Click Select Ru to open the 
Effective Thermal Resistance dialogue, then pick the garage configuration in the 
dialogue. Further values for are given in section 3.3 of the SAP 2012  document. 
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• Description: An optional text description of the element can be entered in the 
Description text box. A description makes it easier to distinguish between several 
elements of the same type when editing a calculation. 

• Perimeter and Cost: Ignore these boxes. 

 
Managing building elements 

To add a new element: 

 
1. Click the New button; the New Element dialogue opens. 

2. Enter the data for the element then click OK. JPA Designer shows the summary data 
new element in the element   list. 

 
To edit an element:- 

 
1. Click the element to edit then click the Edit button. The Edit Element dialogue 

opens. 

2. Make the changes to the element, then click OK. 

To duplicate an element:- 

1. Select the element to duplicate by clicking on it once. 

2. Click the Duplicate button. A copy of the element is  created. 

3. Select the new element and click Edit to make changes. 

 
To delete an element:- 

 
1. Select the element to delete by clicking on it once. 

2. Click the Delete button.  A confirm dialogue appears. 

3. Click Yes to delete the element, or No to cancel the deletion. 

 
The summary data on all the elements defined for a dwelling can be exported to an Excel 
spreadsheet by clicking Send to Excel. 
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21.2 Linear thermal bridging 

SAP calculates the heat loss from thermal bridging at junctions between elements, which 
is usually referred to as Htb (heat loss by thermal bridging)1. There are three methods of 
calculating Htb for a  dwelling: 

 
1. Calculating the total heat loss from the length and  linear  thermal  transmittance 

value for each junction type (section     21.2). 

2. Use a simplified method based on a calculated y-factor (section 21.2). This method 
is not valid for compliance calculations for new dwellings. 

3. Use a simplified method based on a default y-factor (section 21.2). This method is 
not valid for compliance calculations for new dwellings in Scotland. 

 
Further information on the treatment of linear thermal bridging can be found in Appendix 
K of the SAP document. 

 

The Htb calculation 

The linear thermal transmittance, or ψ-value (pronounced psi-value) for a junction is the  rate 
of heat loss through a one metre length of the junction, measured in units of W/mK. Junctions 
are categorised as junctions between walls and other elements or components (e.g.  
windows). 

Ψ-values can be obtained from three sources: 

 
1. Where an accredited construction detail2is used, you can use the ψ-value which has 

been calculated for that detail. Table K.1 in the SAP 2012 document lists values for 
accredited construction details. 

2. Where a ψ-value has been calculated for a specific construction detail, by suitably 
qualified person, you can use that psi-value. That might be a detail supplied by a 
manufacturer of a construction product featured in the detail. 

1This is heat loss additional to that which takes place through the elements. 
2Accredited construction details for England and Wales are available on the Planning Portal: http:// 

www.planningportal.gov.uk/. 
Those for Scotland from the Scottish Government web site: http://www.scotland.gov.uk/Topics/Built- 
Environment. 

 

 

 

http://www.planningportal.gov.uk/
http://www.scotland.gov.uk/Topics/Built-
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Figure 21.3:  The Calculate Htb  dialogue 

 

3. The default ψ-value from the final column of table K.1 in the SAP 2012 document. 
The defaults are worst-case values which represent constructions where little atten- 
tion has been paid to continuity of insulation or airtightness. 

 
To calculate Htb requires the length and ψ-value of each junction in the dwelling. The junction 
length should be obtained by measurement from the design drawings. It is ac- ceptable to 
sum the length of separate junctions of the same type, for example, adding together the 
lengths of all the window    jambs. 

The data for the Htb calculation is entered using the Calculate HTB dialogue (Figure 21.3) 
which lists all the junction types assigned to the dwelling, showing for each one: 

 
• the accredited linear thermal transmittance, which represents the ψ-value for the 

corresponding  accredited  construction  detail; 

• the achieved linear thermal transmittance for the junction, which is the ψ-value 
used in the calculation; 

• the length of the detail, in  metres; 

• the rate of heat loss through the junction, in W/K. 
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Figure 21.4:  The Junction dialogue 

 

When you first open the Calculate Htb dialogue the program adds one of each junction 
type in the junction list, with the length at zero and the ψ-value set to that of the corre- 
sponding accredited detail. The buttons at the bottom of the dialogue allow you to Add, 
Edit and Delete junctions. The Flush button can be removed unused junctions from the 
standard set. 

To  use the Calculate Htb dialogue: 

 
1. In the Thermal Bridging section select    Enter HTB value manually. 

2. Click the Calculate it button.  The Calculate Htb dialogue  opens. 

3. Edit the length of each junction which is found in the dwelling, and adjust the 
ψ-value if necessary. 

4. Click Flush to remove all unused  junctions. 

 
To  add a junction: 

 
1. Click Add. The Junction dialogue opens. 

2. Select the Junction type from the    drop-down. 

3. Enter a Description; this is optional, but adding a description will make it easier to 
manage the calculation. 
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4. Enter the Achieved linear thermal transmittance:      this is the ψ-value. 

The program will offer standard values based on the junction  type. 

5. Enter the Detail length, the total length of the junction, in metres. 

6. Set the Source of value, which will be one of: 

• Table K1: the value for an accredited detail from Table K1 of the SAP 2012 
document. The value is based on the junction type and cannot be edited. 

• Accredited detail: An accredited detail from a source other than Table K1.  
This can be used for a detail accredited by a third party scheme. 

• Not accredited detail:  use this for a calculated  ψ-value. 

• Default: the value for the non-accredited detail in Table K1. The value is based 
on the junction type and cannot be edited. 

7. Click OK. The  junction is added to the Calculate Htb   dialogue. 

A report summarising the junction data can be included in the calculation outputs (see 
section 29.2). 

There are two additional points to note when adding junctions: 

• there is a distinction between junctions to exposed walls and junctions to party 
walls: the latter commonly have lower ψ-values. 

• if the dwelling has curtain walling there is no need to include the lengths of the 
window surrounds as the thermal bridging heat losses will have been included in 
the overall U-value for the curtain wall system. 

 
User-calculated y factor 

An approximate value for Htb can be obtained by multiplying the total area of the exposed 
elements (floors, walls and roofs) by a factor, y.  However, with the introduction of Part L 
2013 (England), Part L 2014 (Wales) and Section 6 2015 (Scotland) the method is not valid 
for building regulations compliance for new dwellings. 

The method may be used for dwellings where the original SAP 9.81 or 9.90 calculation 

has been upgraded to SAP 9.92 in order to lodge an EPC. To use a user-defined y-value: 
This procedure may be used where y has been calculated for that type and configuration 

of dwelling.  To use a calculated value for  y: 

1. In the Thermal Bridging section select Enter y value manually. 

2. Tick Imported SAP 9.81/9.90 for EPC issue  only 

3. Enter the value for y in the box. 

4. Enter a reference for the calculated value of y in the Calc ref box.  The  reference  
must refer to the calculation used to obtain the stated value. 

If you choose this option the program will not display the TER worksheet nor the Com- 
pliance report as it is presumed you are producing an EPC for the dwelling, so will not 
require those two documents. 
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Default  y factor 

An approximate value for Htb may obtained by using the simplified calculation method 
with a y factor of 0.15: this represents the use of details which are not accredited con- 
struction details, and will give a poor result. 

To use this method select Not accredited construction details in the Thermal Bridging 
section. No other data is required. 

In Scotland this method is not valid for dwellings with building warrants issued on or after 
1 October 2015. It may only be used for lodging EPCs for dwellings which have the original 
building warrant issued before 30 September 2015. 

 
21.3 Thermal mass 

There are three methods for entering data on the thermal mass of the building fabric: 

 
1. Set the κ-value for all exposed,  party and internal elements.  The  program calcu-  lates 

the thermal mass parameter (TMP) from those values and the areas of those elements; 
the result is displayed in the TMP    box. 

This is the most accurate and straightforward method. 

2. Enter a TMP value which has been calculated elsewhere. Tick User defined Ther- 
mal Mass Parameter then enter the value in the TMP box. 

3. Use one of the three default thermal mass parameters. Tick User defined Thermal Mass 
Parameter then select a thermal mass category from the Thermal mass drop down  (see 
Table  1e  of  the  SAP 2012 document for definitions of the   categories). 



 

 
 
 

22 Openings 
 

 
 
 
 
 

 

Openings in walls and roofs – windows, doors and rooflights – affect three aspects of the 
SAP calculation: 

 
• Heat  loss:  assessed  through  the U-value. 

• Solar gain: assessed through the g window value. 

• Daylighting:  assessed  through  the  type  of glazing. 

 
Data on openings is entered using the Openings tab of the SAP Worksheet Values dia- 
logue (Figure 22.1). The tab lists the dwelling’s windows, doors and rooflights, grouping 
them according to the building element in they sit. You can enter each opening individu- 
ally, or you can group the openings on each face of the building into one area, provided 
they have the same frame and glazing type. 

The buttons below the openings list allow you to create, edit and delete openings. For 
each opening the data is entered using the Doors, Windows & Rooflights dialogue (sec- 
tion 22.1). 

To define a new opening: 

 
1. In the Openings tab click the New button. The New Doors, Windows & Rooflights 

dialogue opens. 

2. Enter the data for the opening and click OK. 

 
To  duplicate an opening: 

Duplicating an opening creates a new copy of the original opening which can then be 
edited: as most openings will share the same glazing and frame type, using the duplicate 
facility can speed up data entry. 

 
1. In the Openings tab select the opening you want to duplicate. 

2. Click the Duplicate button.  A copy of the opening is created. 

3. Double click on the duplicated opening to edit  it. 

 
To edit an existing opening: 
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Figure 22.1:  The Openings tab 

 

1. Double click on the opening in the list in the Openings tab. The Edit Doors, Win- 
dows and Rooflights dialogue opens (alternatively, you can select the opening then 
click the Edit button). 

2. Make your changes then click OK. 

To delete an opening: 

1. Select the opening in the list in the Openings tab. 

2. Click the Delete button.  A confirmation dialogue appears. 

3. Click Yes to delete the opening, or No to retain it. 

 
You can export the summary data for all openings to an Excel spreadsheet by clicking 
Send to Excel. 
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Figure 22.2:  The Edit Doors, Windows \& Rooflights  dialogue 

 
22.1 Adding and editing openings 

The  Doors, Windows & Rooflights dialogue (Figure 22.2 is used to enter the data about    the 
openings  within  the  dwelling:  the  dialogue  is  headed  either  New Doors, Windows  & 
Rooflights or Edit Doors, Windows & Rooflights). The dialogue requires the following data: 

 
• Opening Type: Use the drop-down to select whether it is a window, rooflight or 

door. 

• Opening within: Use the drop-down to select the element (wall, roof) which con- 
tains the opening. The software uses this information to calculate the net areas of 
the elements. The elements offered in the drop-down will only be those appropriate 
for the Opening type. 

For example, if you have set the Opening type to Window, the Opening within drop-
down will show only walls. Similarly, if you chose Rooflight, then Opening within 
will show only roof   elements. 

• Glazing: Use the drop-down to select the type of glazing, considering the number 
of leaves of glass, the gas within the cavity or cavities and any low emissivity (low-E) 
coating. 
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Even if you go on to enter a manufacturer’s U-value and/or g window value you 
must still make a selection here to set the correct parameters for  daylight. 

• If you have selected a rooflight at a pitch of less than 70º there will be an additional 
Pitch box which must be completed. It is enough to give the window pitch to the 
nearest 5º. 

• Double-glazing air gap: Use the radio buttons to select one of the default values or 
enter your own value. If the gap is greater than 16 mm select Other and enter a 
width in the box. 

• Frame type: Use the radio buttons to select the frame material and, for metal frames, 
the depth of the thermal  break. 

• Source of U-value: there are three configurations for the U-value and g window 
values: 

– Default: the software will use the built-in values for the U-value and solar 
transmittance based on the glazing, double glazing air gap and frame type 
selection. 

– Manufacturer: you should enter a U-value for the opening, but the solar trans- 
mittance will be based on the glazing and frame type. 

– BFRC data: you should enter a U-value and solar factor (g window value). The 
g window value must be certified by the British Fenestration Rating Council. 

• U-value: If source of U-value is set to Default this box will be greyed out. Otherwise 
enter  the  manufacturer  supplied U-value. 

• g window value: Only enter a g window value in here if it is BFRC certified, other- 
wise leave the default value. 

• Area: You can enter the opening area directly into the Area box, or you can select a 
size from the Window size drop-down, or you can enter the Width and Height  of 
the opening. 

Note: the Area is entered in metres square, but the values for Width and Height 
are entered in millimetres (mm). Where there is an overhang above the window  you 
should use the Width and Height boxes, to ensure the software correctly takes 
account of the overshading in the summer overheating  calculation. 

• Description: The Description box allows you to enter a text description for the 
element. The description does not affect the outcome of the calculation. If you have 
set the source of U-value to manufacturer or BFRC you must enter a description. 

We strongly recommend you use the description box to enter a short description for 
every opening, such as its number on the window and door schedule: it is much 
easier to keep track of openings in the calculation when you have a description. 

• Opening orientation: The direction in which the opening faces determines how 
much light it will receive and will therefore affect how much solar flux will pass 
through the opening. The orientation of an opening is set relative to the front eleva- 
tion of the dwelling: usually that which contains the front door. Set the orientation 
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using the radio buttons. Rooflights always face Top. If you are unsure which way 
the building will be facing then select Unspecified. 

Make sure the Front elevation here is the same one you selected in the Building    
faces drop-down in the Dimensions  tab. 

• Overhang: Features such as overhanging balconies or brise soleil will reduce the 
amount of sunlight falling on an opening in summer, and so reduce the solar gain. 
Where there is an overhang enter its Width and Depth, both in mm. The depth is 
measured from the outer edge of the overhang to the external face of the glazing. 

• Blinds, curtains and external shutters: These will reduce the amount of solar gain 
and the risk of overheating in summer. Use the drop-down to select the type of 
shading and then set the Fraction of daylight hours closed. 

Appendix P of the SAP documentation gives some guidance of reasonable assump- 
tions for these occupant-determined  values. 

• Overshading: The extent to which the sky is obscured by trees and neighbouring 
buildings will determine the amount of sunlight and solar flux passing through the 
glazing.  Set the degree of overshading using the radio buttons.  Select Average   or 
unknown if you cannot establish the amount of overshading. The SAP guidance 
disallows the use of the Very little overshading category for new dwellings as it does 
not take account of conditions likely to apply over the whole life of the  building. 

 

 

22.2 Editing multiple openings 

Changing the specification for openings once they have been added to a calculation can 
be a time consuming process. JPA Designer has two tools to make the process quicker, 
by enabling you to copying certain parts of the window data for one window to other 
windows in the dwelling or project. The only data items copied to the windows  are: 

 
• Glazing. 

• Double glazing air gap. 

• Frame type. 

• g window value. 

 
To copy values between openings: 

 
1. Open one window in the Edit Doors, Windows & Rooflights dialogue (Figure 22.2). 

2. Adjust the data for the window, if necessary. 
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3. Click one of two buttons: 

• Copy these values to all this building’s windows: clicking this button sets the 
window data for all windows in the dwelling to that the currently viewed win- 
dow. 

• Copy these values to all the buildings in this project: clicking this button  sets 
the window data for all windows in all the dwellings in the JPA Designer project 
to that the currently viewed window. 

4. JPA Designer displays a confirmation dialogue. Click Yes to carry out the changes, 
or No to ignore them. 

The operation cannot be un-done automatically. 
 
 

 

Figure 22.3: The Change Multiple U-values dialogue 

 
You can also change the U-values of several openings at the same time, without adjusting 
any of the other settings: 

 
1. In the Openings tab click on the first opening you want to change. Press and hold 

the <Shift> key then click the last opening to change. Those two openings, and all 
the ones between will be selected. 

2. Click Change U-value of  selected. 

3. In the Change Multiple U-values dialogue (Figure 22.3) enter a new U-value and 
click OK. The U-values will be set to the new   value. 



 

 
 
 

23 Water  heating 
 

 
 
 
 
 
 
 

 

Figure 23.1: The Water heating tab, showing settings for a hot water storage tank 

 
SAP considers the amount of energy used to heat domestic hot water such as that used     for 
bathing, laundry and dishwashing. The demand for hot water is based upon the floor area of 
the dwelling.  Data on domestic hot water is entered using the Water heating tab    of the 
SAP Worksheet values dialogue (Figure     23.1). 

The  first step is to select the type of water heating system using the Source of domes-        tic 
hot water drop-box. Once you have made a selection the program will display the appropriate 
data entry fields.  The  hot water sources  are: 

 
• Hot water storage  tank. 

• Instantaneous water heating at point of   use. 

• Combination boiler. 
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• Community heating scheme. 

• Multi-point gas water heater or heat exchange built into a gas warm air system. 

• Boiler  with  thermal store. 

• Combined primary storage unit (CPSU). 

• MicroCHP or Heat  pump. 

Use this option for heat pump with data taken from the Product Characteristics 
Database (section 24.2.      For all other heat pumps use Hot water storage tank. 

• Community heating scheme providing domestic hot water only. 

 
23.1 Hot water storage tank 

Select this system for the hot water which is heated by the central heating boiler or immer- 
sion coil, then stored in a tank or cylinder ready for use (Figure 23.1). Enter the following 
data for the tank: 

 
• Hot water tank volume: select one of the default values or enter the actual volume 

in the Volume drop-down. 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

 
The means of heating the hot water must be specified using the Hot water tank heater 
radio buttons: 

 
• Single electric immersion heater: a single coil electric immersion heater in the tank; 

• Dual electric immersion heater: a dual coil electric immersion heater in the tank: 
this will usually be associated with an off-peak tariff, in which case tick Off peak 
electricity immersion heaters. 

• Boiler feed:  this indicates a heat source which also provides space heating, such  as 
an oil or gas boiler, or a default efficiency heat pump. The initial presumption is that 
the primary space heating system which is providing the domestic hot water, but 
this may be modified by using one of the tick boxes to indicate: 

– the hot water is provided by the second main heating system (see section 24.1); 

– the hot water is provided by the secondary heating system, which might be a 
solid fuel room heater with a back boiler (see chapter 25); 

– a default efficiency heat pump is supplemented by an immersion heater in the 
summer. 

• Hot water only boiler: a dedicated unit which supplies domestic hot water only. 
Use the drop-down to select the type of boiler, then specify the Fuel. 
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Use the three lower boxes to indicate    whether: 
 

• the hot water tank (cylinder) is in the heated space; 

• there is a thermostat in the hot water tank or cylinder (this is required by the Do- 
mestic Building Services Compliance   Guides); 

• there is a separate timer for domestic hot   water. 
 

Use the Primary insulation list to specify the extent of insulation to the primary pipework 
(the pipework between the heat source and the hot water storage vessel). 

If the dwelling has solar panels complete the Solar panel details section of the Water 
heating  tab  (section 23.10). 

 
23.2 Instantaneous water heating at point of use 

For a system which heats the water on-demand at the point of use, you need only select 
the Fuel using the radio buttons. 

 

Figure 23.2:  Entering an instantaneous hot water   heater 

 

 

23.3 Combination boiler 

Combination boilers provide heating and hot water:  they may be instantaneous (with up    to 
15 litres storage), or they may contain small primary or secondary storage tanks (see 
Appendix B of the SAP 2012 document for definitions). Use the Combination boiler type radio 
buttons to select the  type. 

If you have selected Instantaneous there is no further data to enter.  For a boiler with a 
primary or  secondary store  enter  the  following data: 

 

• Hot water tank volume: select one of the default values or enter the actual volume 
in the Volume drop-down. 
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Figure 23.3: Hot water options for combination boilers 

 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

 
If the dwelling has solar panels complete the Solar panel details section of the Water 
heating tab (see section 23.10). 

 
23.4 Community heating scheme 

The hot water for dwellings heated by community heating schemes can provided by im- 
mersion heaters or by a heat exchanger fed from the scheme. In all cases specify the hot 
water tank heater. There may be additional data required, depending on the configuration 
of the system: 

 
• Where there is neither a hot water tank nor a heat exchange in the dwelling no 

further data is required. 

• If there is a hot water tank within the    dwelling: 

– tick DHW cylinder within  dwelling; 

– enter the tank details (section   23.1); 

– tick DHW cylinder within  dwelling; 

• If there is no tank and the hot water is provided by a heat exchanger: tick Plate heat 
exchanger in Community Heating; 

 

– tick DHW cylinder within  dwelling; 

– enter the volume of the heat exchanger in the Hot water tank Volume box; 

– enter the insulation type and thickness; 

 
If the dwelling has solar panels complete the Solar panel details section of the Water heating  
tab  (section 23.10). 
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Figure 23.4: Data entry for gas water heaters or heat exchangers 

 
23.5 Multi-point gas water heater or heat exchange built 

into a gas warm air system 

This represents systems with one gas-fired water heater providing hot water to a number    of 
outlets, or a water heater which uses a heat exchanger built into a warm air heating system.  
Enter the following  data: 

 
• Hot water tank volume: select one of the default values or enter the actual volume 

in the Volume drop-down. 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

 
Use the three lower boxes to indicate    whether: 

 
• the hot water tank (cylinder) is in the heated space; 

• there is a thermostat in the hot water tank (cylinder) (required by Domestic Building 
Services  Compliance Guide); 

• there is a separate timer for the domestic hot   water. 

 
Use the Primary insulation list to specify the extent of insulation to the primary pipework 
(the pipework between the heat source and the hot water storage vessel). 

If the dwelling has solar panels complete the Solar panel details section of the Water heating  
tab  (section 23.10). 

 
23.6 Boiler with thermal store 

Use this option for thermal stores containing water heated by a separate boiler, with 
domestic hot water provided by means of heat exchanger within the store. 

Enter the following data for the  store: 
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Figure 23.5:  Data entry for a thermal store hot water    system 

 

• Hot water tank volume: select one of the default values or enter the actual volume 
in the Volume drop-down. 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

 
The hot water tank heater will always be Boiler feed. 

Use the radio buttons and tick boxes to indicate whether: 

 
• The thermal store is integrated or hot water    only. 

• The thermal store is in an airing cupboard. 

• The thermal store is close coupled. 

Close coupled means the store is either within the same casing as the boiler, or 
separated from the boiler by no more than 1.5 m of insulated pipework. 

• There is a separate timer to the thermal store for the heating   store. 

 
Use the three lower tick boxes to indicate    whether: 

 
• the hot water tank (cylinder) is in the heated space; 

• there is a thermostat in the hot water tank (cylinder) (required by Domestic Building 
Services  Compliance Guide); 

• there is a separate timer for the domestic hot   water. 

 
If the dwelling has solar panels complete the Solar panel section of the Water   heating 
tab (see section 23.10). 
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Figure 23.6: Data entry for CPSU hot water  supply 

 
23.7 Combined primary storage unit  (CPSU) 

A Combined Primary Storage Unit provides hot water by means of heat exchanger within 
the primary store. Enter the following data for the tank: 

 

• Hot water tank volume: select one of the default values or enter the actual volume 
in the Volume drop-down. 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

 

Use the radio buttons and drop-downs to indicate: 
 

• whether the CPSU is in an airing cupboard; 

• the winter operating temperature of the    CPSU; 

• the size of the CPSU cylinder. 
 

Use the lower boxes to indicate    whether: 
 

• the CPSU as a separate timer for the heating store; 

• the hot water tank (cylinder) is in the heated space; 

• there is a thermostat in the hot water tank (cylinder) (required by Domestic Building 
Services  Compliance Guide); 

• there is a separate timer for the domestic hot   water. 
 

If the dwelling has solar panels complete the Solar panel details section of the Water 
heating  tab  (section 23.10). 
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23.8 MicroCHP or heat pump 

Use this option for systems in which the hot water is provided either by a domestic-sized 
combined heat and power (microCHP) system or by a heat pump with efficiency data 
from the Product Characteristics Database (section 24.2). (If the heat pump has been 
entered using the default efficiency figures in SAP and not the Product Characteristics 
Database then you should select Hot water storage tank as the source of domestic hot 
water.) 

For a microCHP system the only options are whether there is: 

 
• a summer time immersion heater for hot   water; 

• a hot water vessel within the microCHP system; 

• a separate timer for domestic hot  water. 

 
For heat pump the standard method is to accept the database values, in which case it is 
only necessary to specify whether there is: 

 
• a summer time immersion heater for hot   water; 

• a hot water vessel within the microCHP system; 

• a separate timer for domestic hot  water. 

 
However, it is possible to override the values by ticking Override heat pump database 
values. The tab now shows the Hot water tank data boxes: 

 
• Hot water tank volume: select one of the default values or enter the actual volume 

in the Volume drop-down. 

• Storage tank insulation: use the radio buttons to select the type of insulation, then 
enter its Thickness in mm. 

• Declared loss factor: Use the box to enter a heat loss factor supplied by the tank 
manufacturer, instead of relying on the default values in SAP 2012. 

• Heat pump heat exchanger area: Enter the area of the heat exchanger plates in m2. 

 
If the dwelling has solar panels complete the Solar panel section of the Water   heating 
tab (section 23.10). 
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Figure 23.7: Settings for a community heating scheme which supplies only domestic hot 
water 

 
23.9 Community heating scheme providing domestic hot 

water only 

Use this option for a community heating scheme which provides domestic hot water, but 
does not provide the space heating. Typically, such system are found in flats or sheltered 
housing. 

To specify a system: 

 
• Set the Source of domestic hot water to Community heating - domestic hot water 

only (Figure 23.7). 

• Set the Heat Sources for the system (section    23.9). 

• Set the method of charging for the hot water supply, using the drop-down: this will 
either be a flat rate charge for the heating, or will be linked to hot water usage. 

• Set the distribution method using the    drop-down. 

• If there is a solar panel linked to the system enter its details (section 23.10). 

• If there is a hot water tank or cylinder within the dwelling tick DHW cylinder within 
dwelling: additional data boxes will be displayed  for: 

– Hot water tank volume: select one of the default values or enter the actual 
volume in the Volume drop-down. 

– Storage tank insulation: use the radio buttons to select the type of insulation, 
then enter its Thickness in mm. 

– Declared loss factor:  Use the box to enter a heat loss factor supplied by the  
tank manufacturer, instead of relying on the default values in SAP 2012. 

 

• If there hot water is provided by means of plate heat exchangers: 
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– Tick the box Plate heat exchanger in community heating. 

– Tick DHW cylinder within dwelling. 

– Enter the volume and insulation details of the heat exchangers as the hot water 
tank. 

 
Heat sources 

 

Figure 23.8:  Setting a heat source for community heating/hot    water 

 
Community heating and hot water schemes can be fed by a variety of heat sources in- 
cluding conventional boilers, heat pumps, combined heat and power systems and even 
geothermal. The Heat sources box lists the sources for domestic hot water (Figure 23.7): 
sources can be added and edited using the buttons next to the box: 

 
• the New button, which opens the Heat source dialogue ready for new data; 

• the Edit button, which opens the Heat source dialogue showing the selected heat 
source. 

• the Delete button which removes the selected heat    source. 

 
The Heat Source dialogue (Figure 23.8) requires: 

 
• the type of heat source, selected from the Heat source drop-down. 

• the fuel, selected from the Fuel drop-down. 

• the proportion of the total energy load provided by that source. Enter a fraction 
between 0 and 1 in the Heat fraction box. 

• the efficiency of that heat source. Enter as a percentage in the Efficiency box. 

For most sources the efficiency will be less than 100, but for heat pumps the effi- 
ciency may  be considerably higher. 
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23.10 Solar panels 

Solar panels use sunlight to pre-heat water for the domestic hot water system. Guidance 
on including solar panels in the calculation is given in Appendix H of the SAP documen- 
tation. Where possible data from the panel’s test certificate should be used. 

 

Figure 23.9: Data entry for solar panel water heating 

 

Where a dwelling has solar panels, specify: 

• The net Aperture area of solar collector, in square metres. 

• The Zero-loss efficiency of the collector,  η0. 

• The heat loss coefficient of the collector, a1 

• The second order collector heat loss coefficient, a2. 

• The volume of the dedicated solar storage. See figure H2 of the SAP documentation 
for definitions. 

• Whether there is a separate solar   cylinder. 

• The solar collector type, using the radio buttons. 

• The pitch of the panels, measured from the horizontal, and their orientation. 

• The amount of overshading on the panels; generally this will be less than the over- 
shading of windows facing the same direction. 

• Whether there is a solar powered pump. This will reduce the amount of electricity 
used for pumping water. 

• The configuration of Showers. 
 

 

 
   

 

 



 

 
 
 

24 Primary heating 
 

 
 
 
 
 

 

The primary heating system is the main heating system for the dwelling, which will often 
provide hot water as well as space heating; it is usually not based on individual room 
heaters. Data on the primary heating system is entered using the Primary heating tab 
(Figure 24.1). 

 

Figure 24.1: The primary heating tab showing two main heating systems 
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24.1 Dwellings with two main heating systems 

SAP 2012 can account for the uncommon case of a dwelling having two main heat-     ing 
systems, which are designed to heat the house together1. The two systems may be 
configured to heat the all the dwelling together, or to heat parts of it separately. 

 

Figure 24.2: Configuring a dwelling with two main heating systems 

To specify two heating systems: 

1. Tick Dwelling has two main heating systems.  The program now displays a pair  of 
radio buttons, Main heating system 1 and Main heating system 2 (Figure 24.2). 

2. With Main system 1 selected, enter the proportion of the dwelling’s space heating 
demand which is provided by that system in the Fraction box (the fraction should      be 
in the range   0.0–1.0). 

3. If both systems heat the whole house tick the box Both systems heat whole house. 

This affects the treatment of the hot water system. 

4. If the systems share the same pump tick System 2 uses System 1’s pump. 

This affects electricity use and heat gains for pumps. 

5. Specify the first system in the Primary heating    tab. 

6. Click Main system 2 and specify the second system in the Primary heating tab. 

 
You  can always switch between the systems using the radio buttons:  the large number       at 
the top right of the Primary heating tab indicates which of the two systems you are working  
on. 

 

 

1This should not be confused with secondary heating appliances, such as gas fires or wood-burning 
stoves, which are designed to provide additional heat for individual rooms. 
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24.2 Efficiency data for heating systems 

There  are three possible sources of efficiency data for heating    systems: 
 

• default values given in Table 4 of the SAP 2012  document. 

• data from the Product Characteristics Data File ( the PCDF, see below): this gives 
the most accurate values for specific appliances. 

• user-entered efficiencies: this can be useful at the design stage when no appliance 
has been specified. User-entered efficiencies may not be used for gas and oil boilers 
in final ‘as-built’ SAP calculations and EPCs: the values must be replaced by PCDF 
figures. 

 

For some systems (for example, gas-fired warm air systems) only the default SAP 2012 
efficiencies may be used, whilst for others (for example, gas condensing boilers) any of 
the three sources is acceptable. Note that heat pumps can be specified either using the 
PCDF, or by accepting the default efficiencies: microCHP systems can only be specified by 
means of the PCDF. 

 
The Product Characteristics Data File 

The Products Characteristics Database (PCD) contains performance data for gas, oil and 
solid fuel boilers, heat pumps, mechanical ventilation systems and some renewable tech- 
nologies (section 28.4). The database is maintained by the BRE and a revised version of 
the database is issued at the end of every month. 

To ensure you are using an up-to-date version of the database, JPA Designer checks the 
issue date every time you start the program: if the database is more than a month old 
the software prompts you to download the latest version. You can prompt a check of the 
PCDF: on the File menu click Download and re-load Product Characteristics Data    File. 

 

Figure 24.3:  Updating the  PCDF 

 
The procedure for updating the PCDF is the same for automatic or manual checks: 
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1. In the Product Characteristics Data File Download dialogue click Start update. JPA 
Designer downloads the latest data files for SAP 9.90 and SAP 9.92 and displays an 
Update  complete message. 

2. Click OK. 

3. At the information dialogue which asks Would you like to load the new database 
click Yes.  JPA Designer loads the new data  file. 

4. Click Close to finish the  process. 

 
The data in the PCDF can be viewed at http://www.ncm-pcdb.org.uk/sap/ 

 
SEDBUK efficiencies 

One measure of boiler efficiency used in SAP is the SEDBUK rating (Seasonal Efficiency of 
Domestic Boilers in the UK). There was a change in the calculation method for SEDBUK 
efficiency ratings with the introduction of SAP 2009 which resulted in a general lowering 
of efficiencies. Whilst JPA Designer allows you to enter either 2005 or 2009 SEDBUK 
ratings, you should be ensure you do not enter a value compatible with the 2005 rating if 
you have selected the 2009 rating; you may find you have entered a value which cannot 
be achieved by any boiler in the database. 

 
24.3 The main primary heating systems 

There are seven main groups of primary heating system2: the following sections describe 
how to enter data for the each group. In all cases (except community heating schemes), 
start by using the drop-boxes to set the: 

 
• Group; 

• Sub-group; 

• System; 

• Fuel; 

• Heating controls. 

 
Always work from Group downwards, as the options in the lower drop-boxes change 
according to the selections made higher up. Once you have set all the drop boxes you  should 
enter any other requirements for that type of heating, then enter any additional data. 

2Note that none is not an acceptable heating option for a new  dwelling. 

http://www.ncm-pcdb.org.uk/sap/
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Heating controls 

The heating controls for the primary heating system is set using the Heating controls list. 
The control options listed will depend on the Group, Sub-group, System and Fuel 
settings. 

The SAP 2012 document contains descriptions of control options in section 9.4. Broadly 
speaking, in JPA Designer, the control options towards the bottom of the list will do better 
than those at the top of the list. For dwellings with a floor area greater than 150 m2 the 
heating controls must include time and temperature zone controls. 

The efficiency of some heating systems may be improved by load or weather compen- 
sators. These may be specified using the load, weather or enhanced load compensator 
boxes.  

 
 

Central heating systems with radiators or underfloor   heating 

This group covers wet central heating systems with radiators, underfloor pipes, or fan coil 
units, with the heat can be provided by gas, oil, solid fuel or electric boilers, heat pumps 
or microCHP units.  To specify such systems, set: 

• the Group, Sub-group, System, Fuel, Heating controls and Electricity tariff; 

• the Heat emitters; 

To combine underfloor heating on the ground floor with radiators on the first floor 
set the Heat emitters to one of the underfloor options and tick Underfloor heating 
also has radiators. 

• the efficiency of the boiler (section    24.3); 

• additional items such as heating controls (see section 24.3) and: 

– is the central heating pump in a heated space? 

– is the central heating pump manufactured  in  2013  or  later?  Always  tick the 
box  for  a  new dwelling. 

– for an oil-fired boiler, is the oil pump in the heated space? 

– is there a boiler interlock? That is, the system is configured to prevent the 
boiler firing when there is no demand for heat. 

 
In SAP 2012 it is possible to select the load or weather compensator from the PCDF (see 
section 24.2), to give more accurate results using the Load/weather compen- sator 
select button, then in the Heating Controls Database selecting the Manufac- 

   

 

 
 to select.  
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Boiler efficiency 

The efficiency of the boiler or other heat source can be entered in one of three ways. 
 

Figure 24.4: Using the Product Characteristics Database to set the boiler efficiency 

To  use the PCDF: 

1. Select the Select from the boiler database radio  button. 

2. Click the Select boiler button. The  BRE Boilers Database dialogue opens (sec-  
tion 24.2). 

3. Select the Boiler manufacturer from the drop-down. The program then displays the 
list of available boilers. 

4. Scroll down the list and click on a boiler to select it. You can scroll sideways to 
view the details of each boiler, such as its efficiency and configuration. 

You can use the Filters to ensure the program shows only boilers over a certain 
efficiency, or with a specified mounting position. Ticking and unpicking the Filter 
box activates and deactivates the filtering. 
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The program only shows boilers which match the criteria you specified using the 
drop-downs on the Primary heating tab. As a manufacturer does not necessarily 
offer a boiler in every category the database may not display any   boilers. 

5. Click the Use selected boiler button.  The Boiler database window closes and  the 
Primary heating tab shows the summary details for the chosen boiler. 

There is no need to enter flue, draught, or keep hot details as all that information is 
present in the database entry for the  boiler. 

 
To  enter a SEDBUK value  directly: 

 
1. In the Boiler efficiency section select the Use manufacturer’s declared SEDBUK 

value radio button. 

2. Enter the Make and Model of   boiler. 

3. Use the radio buttons to specify whether a SEDBUK 2005 or 2009 value is being 
used and enter the Declared SEDBUK value. 

4. Specify the type and fuel of any Keep-hot facility. 

5. Set the Flue and Draught type. 

6. For range cookers you must also enter the values for ϕcase and ϕwater. 

 

To  use the default  value: 

 
1. In the Boiler efficiency section select the Use default value radio button. The soft- 

ware shows the default value for that boiler type. 

2. Use the radio buttons to enter the details of the Flue and Draught type. 

3. For range cookers you must also enter the values for ϕcase and ϕwater. 

 
Note that the default values are generally too poor to comply with the standards in the 
Domestic  Building  Services  Compliance Guide. 
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Storage radiator systems 

Storage radiator systems are heated with off-peak electricity during the night and release 
that heat throughout the day. For most configurations, the only data required is that from 
the primary heating drop boxes. 

 

To  specify high retention storage  heaters: 

 
1. Set : 

• Group  to  Storage  radiator systems; 

• Sub-group to Off-peak tariff ; 

• System to High heat retention storage heaters; 

• Fuel to the appropriate  tariff. 

• Heating controls to Controls for high heat retention storage heaters. 

2. At Source of efficiency click Select from the product    database. 

3. Click Select product.  The BRE Boilers Database dialogue  opens. 

4. Select the manufacturer from the Brand   list. 

5. Click on the model then click Add storage heater to  list. 

6. In the Quantity dialogue enter the number of that model of storage heater. 

7. If there is another model of storage heater in the dwelling repeat steps 4–6. 

Note there cannot be more than five storage heaters in the   dwelling. 

8. Click OK. 

 
If you need to remove a storage heater from the calculation, select it in the Selected 
storage heaters list then click Delete selected storage heater. 

 
Warm air systems 

The heat for warm air systems is provided by gas, oil, electricity or heat pumps. For most 
systems the only data required is that from the primary heating drop boxes. 

If you are specifying a warm air system powered by a condensing gas heater or a heat   pump 
it is possible  to use efficiency data  from  the PCDF (see section 24.3  for guidance    on  the 
procedure). 
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Room heater systems 

This group includes room heaters such as gas or solid fuel fires3. In most cases, the only 
data required is that from the primary heating drop-boxes. However, where the declared 
efficiency of the heater is known. tick the box Use manufacturer’s declared efficiency 
then complete the Make, Model and Declared efficiency boxes and select the BS Test 
Method used to obtain the efficiency. 

 
Other space and water heater systems 

Electric ceiling heating is currently the only system in this category. The only data re- 
quired is that from the primary heating drop boxes. 

 
Community heating scheme 

Community heating schemes use central heat generators to heat water which is then cir- 
culated through pipes to supply space heating and hot water to more than one dwelling. 
The heat may be provided by a number of different systems, and community heating 
schemes may often include Combined Heat and Power (CHP) systems, which will pro- 
vide heat and generate electricity. Appendix C of the SAP 2012 document contains 
further information on the treatment of community heating schemes in SAP. 

 
 
 
 
 
 
 
 
 

Figure 24.5: Data entry for a community heating scheme with two heat sources 

To specify a community heating scheme in JPA  Designer: 

 
• set Group to Community heating scheme. JPA Designer displays the Community 

heating section of the Primary heating tab (Figure 24.5). 

• set the heat sources; 

• set the heating  controls; 

• set the heat distribution  system. 

 
To  set the heat sources: 

3Some of the options will not be appropriate for new-build, but are included for compatibility with the 
Reduced data SAP (RdSAP) used for EPCs for existing  dwellings. 
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Figure 24.6: Setting a heat source for community heating 

 
• Click the New button: the Heat source dialogue opens (Figure  24.6). 

• Select the type of heat source from the Heat source drop-down. 

• Select the Fuel from the   drop-down. 

When specifying a fuel which is not listed, use the Special fuel name, emission 
factor and primary energy factor to enter its details. 

• Set the proportion of the total heat load provided by that source: enter a fraction 
between 0 and 1 in the Heat fraction box. 

The total heat fraction from all the heat sources must total  1.00. 

• Enter the percentage Efficiency of the heat   source. 

Note the efficiency should be entered as a percentage. 

• For a CHP system enter the heat to power ratio, which will typically be in a range 
of 1.25–1.5. 

• Click OK to close the   dialogue. 

• Repeat the procedure for multiple heat sources: use the Edit and Delete buttons to 
adjust or remove heat sources. 

To  set the controls: 

• Set the Heating controls and the Electricity tariff. 

Systems which rely on flat rate charging will usually be less efficient than those     
where charging is linked to   use. 

The heat distribution setting is used to determine the distribution losses for the system. 
You can either: 

• Use a default value based on the type of pipes used to circulate hot water: select 
the pipe configuration from the Heat distribution system list. 

• Use a calculated distribution loss factor which is specific to the project (there is 
guidance on calculating such a loss factor in Appendix C of the SAP 2012 docu- 
ment): select calculated from the Heat distribution system list, then enter the loss 
factor in the neighbouring box. 
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Electric underfloor heating 

This option reqpresents underfloor heating systems based on electric cables in the floor  
slab or integrated into   flooring. 

The only data required is that from the primary heating drop boxes. 

 

24.4 Additional data 

There are two items of additional data which the software collects for producing the EPC 
which appear on the Primary heating    tab: 

 
• Separated conservatory with fixed heater: Tick this box if the dwelling has a ther- 

mally separated conservatory (see SAP guidance section 3.3.3 for the definition of 
thermally separated) which has a fixed heater within it. 

• Dwelling in smoke control area:  This  box is only relevant if solid fuel is set as the   fuel 
for the primary or secondary heating. If the dwelling is within a smoke control zone the 
use of house coal and dual fuel is not permitted, and wood is permitted for an exempted 
appliance only. For further information on smoke control areas see 
http://smokecontrol.defra.gov.uk/index.php4. Tick  the  box  if  the  dwelling  is  within 
a  smoke  control area. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
4There does not appear to be a central source on smoke control areas:  the only means of finding out 

is to contact the local   authority. 

http://smokecontrol.defra.gov.uk/index.php4
http://smokecontrol.defra.gov.uk/index.php4
http://smokecontrol.defra.gov.uk/index.php4


25  Secondary heating 
 

 
 
 
 
 

A secondary heating system is an additional space heating system for the dwelling: com- 
mon examples are gas fires or wood burning stoves. Where a secondary system is pro- 
vided it should be included in the calculation:  guidance on when to include a system     is 
given in Approved Document L1A paragraph 2.14. The fraction of space heating pro- 
vided by the secondary system is defined in table 11 of the SAP 20012 document. Data 
on secondary heating is specified using the Secondary heating tab (Figure 25.1). 

 
 
 
 
 
 
 
 
 
 
 
 

Figure 25.1: The Secondary heating tab 

To specify secondary heating: 

1. Set the Group drop-down to Room heater systems. 

2. Select the Sub-group. 

3. Select the System. 

4. Select the secondary heating Fuel. 

If the solid fuel room heater has been approved by HETAS1 tick the box. The calculation 
will then use a higher default efficiency for the heater. 
Where the actual efficiency for a solid fuel heater is known, tick the Use manufacturer’s 
declared efficiency box then enter the Make, Model and Declared efficiency. The BS Test 
Method used to obtain the efficiency value should also be entered. 

1Heating Equipment Testing and Approval Scheme. 
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26 Overheating 
 

 
 
 
 
 
 

 

 
 

Figure 26.1: Overheating data on the Overheating and cooling  tab 

 
Dwellings must not have an excessive risk of high internal temperatures in summer as    a 
result of solar gain. The test for overheating risk is set out in Appendix P of the SAP 2012 
document; overheating risk depends on the predicted amount of solar gain and the 
thermal mass of the dwelling. The result of the overheating assessment is shown in the 
main SAP window: a dwelling with a high risk of overheating will not comply with 
regulations. 

Most of the data for the calculation is entered elsewhere in the SAP calculation from data, 
so the only information required is the Effective air-change rate. You can either tick the 
Enter value box and enter a design air change rate, in air changes per hour (ach), or use 
the Building and Window opening list to set default values. 
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27 Cooling 
 

 
 
 
 
 
 

 

 
 

Figure 27.1: Settings for air conditioning systems 

 
The energy used for space cooling must be included in the SAP 2009 calculation when- 
ever space cooling is present. The data for the system is entered in the Overheating & 
cooling tab (Figure 27.1). The Cooled fraction: the proportion of the dwelling which is 
served by the cooling system. This can be determined by dividing the floor area of the 
cooled part by the total floor area. 

The efficiency of the system can either be set to default values by setting: 

 
• System type:  The  system can be Split or multi-split, or   Packaged. 

• Compressor control: This can be set to On/off or  Modulating. 

• Energy label class: Select A to G (with ND for no data). 

 
Where the Energy Efficiency Rating (EER) is known, tick the User defined Energy Effi- 
ciency Ratio and enter the value in the EER box. 
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28  Renewables and special features 
 

 
 
 
 
 
 

 

 
 

Figure 28.1: The Photovoltaics and Alternative Technologies  tab 

 
SAP 20012 takes account of the contribution of certain renewable sources of energy and 
some heat recovery technologies, including: 

 
• photovoltaic panels (section 28.1); 

• wind turbines linked to one dwelling (section 28.2); 

• hydro-electric generators (section 28.3); 

• waste water heat recovery units (WWHRS) (section 28.4); 

• flue gas heat recovery systems (FGHRS) (section 28.5). 
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The data for all those systems is entered in the Photovoltaics and Alternative Technologies 
tab (abbreviated to PV & Alt Tech, Figure 28.1). That tab is also used for entering the 
amount of any additional energy generated by other means (section 28.6). 

 
28.1 Photovoltaic panels 

Photovoltaic panels (PV) generate electricity from sunlight. JPA Designer enables you to 
include three different sets of panel,  which may  be at different orientations or pitches.     For 
blocks of flats the benefits from PV are applied as follows: 

 
• where the PV is connected to an individual flat the output contributes to CO2 emis- 

sions calculations and ratings calculations. 

• where the PV is connected to all dwellings (usually by the landlord supply) the 
benefit is applied CO2 emissions calculations, but not to ratings calculations. The 
total PV rating – the Peak kW value – should be divided between the dwellings in 
proportion to their total floor areas. 

 
For each installation: 

 
1. Enter the Peak kW of the system (obtain this value from the manufacturer or sup- plier); 

2. Select the Pitch of the panels; 

3. Select the Direction which the panels face; 

4. Select the amount of Overshading (which is likely to be less than that of any win- 
dows facing in the same direction.); 

5. If the PV array is connected directly to the electricity supply of the dwelling tick 
Connected to electricity meter. Do not tick the box for a flat where the PV output 
feed to the landlord supply. 

 
28.2 Wind turbines 

The electricity generated by a wind turbine attached to a building or on a mast within  its 
curtilage (grounds) can included in the SAP calculation. However, where a turbine 
supplies electricity to more than one dwelling, or is connected to a development by 
private wire, the electricity can not be included in the SAP calculation: see Appendix  M3 
of the SAP 2012 document for further details. 

To specify a wind turbine: 

 
1. Enter the Number of  turbines. 

2. Specify the Rotor diameter in metres. 

3. Select the type of  terrain which surrounds the    dwelling. 
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4. Enter the height of the hub of the turbine above the ridge of the roof, in metres. 

 
As part of the process of producing the improvement recommendations for an EPC, JPA 
Designer must calculate the notional benefit gained from installing a wind turbine. You 
must therefore specify the Terrain type even if there is no wind turbine on the dwelling. 

 

 

28.3 Hydro-electricity 

The electricity from hydro-electric units can be included in the SAP calculation, pro- vided 
the total amount generated has been calculated and signed off by an appropriately 
qualified engineer. The amount of electricity is entered in Hydro-electric generation 
(kWh/year). Where electricity is supplied to several dwellings it should be assigned in 
proportion to their floor areas. See Appendix M4 of the SAP 2012 document for further 
details. 

 
28.4 Waste water heat recovery systems 

Waste water heat recovery systems (WWHRS) use heat exchangers to recover heat from 
the heated water passing out of the wastes of showers and baths. WWHRS are either: 

 
• Instantaneous, recovering heat from waste water from mixer showers as it is dis- 

charged, in one of three ways1: 

– System A: output of the heat exchanger is fed to both the shower and the combi 
boiler or hot water  system 

– System B: output of the heat exchanger is fed to the shower only 

– System C: output of the heat exchanger is fed to the combi boiler or hot water 
system but not to the  shower 

• Storage, recovering heat from multiple appliances to a store which then pre-heats  
cold water to combi boiler or hot water    system. 

 
To  specify instantaneous WWHRS: 

 
• In the PV & Alt Tech tab tick WWHRS and click the Lookup button. The WWHR 

Database dialogue opens (Figure 28.2). 

1See Figure G1 in the SAP 2012 document for illustrations of these systems. 
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Figure 28.2: Entering data on WWHR  systems 
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• Use the Manufacturer drop-down to select the manufacturer, then highlight the 
specified product in the list and click Select as system 1. Repeat this process if there 
is a second system, but click Select as system 2. 

• Enter the total rooms with shower and/or   bath. 

• For each system specify the number of mixer showers to which the system is linked    in 
rooms with a bath and without a bath (do not count instantaneous electric show- ers 
in the number of mixer   showers). 

• Click OK. 

 
To  specify storage WWHRS: 

 
• In the PV & Alt Tech tab tick WWHRS and click the Lookup button. The WWHR 

Database dialogue opens (Figure 28.2). 

• Use the Manufacturer drop-down to select the manufacturer, then highlight the 
specified product in the list and click Select as storage system. 

• In the Storage System 1 section enter: 

– the Total  number of baths and  showers 

– the Number of baths and showers whose waste water is routed through the 
WWHRS. 

– the Dedicated WWHRS storage volume in litres. 

• Click OK. 

 
28.5 Flue gas heat recovery systems 

Flue gas heat recovery systems (FGHRS) recover heat from the combustion products of 
condensing boilers to pre-heat the domestic hot water supply.  To specify FGHRS: 

 
1. Tick FGHRS and click the Lookup button. The FGHRS database dialogue opens 

(Figure 28.3). 

2. Select  the Manufacturer. 

3. Select the type from the Available list. 

4. Click OK. 

 
Where the FGHRS has a photovoltaic array feeding directly into a close coupled store the 
PeakkW, Pitch, Direction and Overshading of the PV array should be set in the FGHRS 
PV Module section. 
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Figure 28.3: The flue gas heat recovery systems (FGHRS) database 

 
28.6 Other allowable generation 

There are some sources of electricity which cannot be included in the calculations for 
Building Regulations compliance, but can be included for other calculations, particularly 
those to demonstrate zero carbon homes status, Code for Sustainable Homes level 6, and 
for the Northern Ireland low and zero carbon homes scheme. 

Electricity from such sources should be entered in the box Additional allowable elec- 
tricity generation for box (ZC6). ZC6 is the box number on the zero carbon homes 
calculation (see section 16 of the SAP 20012 document). Electricity generated by wind 
turbines linked to a development by private wire may be entered here. 

 
28.7 Special features 

SAP 2012 includes a procedure for including new technologies in calculations in the 
intervals between revisions of the SAP. The Appendix Q procedure (which is named after 
the appendix of the SAP document in which it is described) may only be used for prod- 
ucts which have been independently assessed and are listed on the Appendix Q web site 
at http://www.ncm-pcdb.org.uk/sap/page.jsp?id=18. The web site has a calculation 
spreadsheet for the various product types2 and, in some cases, data sheets for individual 
products. 

To incorporate a technology using the Appendix Q  procedure: 

 
1. Carry out the SAP calculation as  normal. 

2There are separate spreadsheets for different versions of SAP: make sure you use the  appropriate 
version. 

http://www.ncm-pcdb.org.uk/sap/page.jsp?id=18
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2. Complete the the appropriate Appendix Q spreadsheet: this may require informa- 
tion on the product taken from a datasheet, and may involve changes to the SAP 
calculation. The Appendix Q spreadsheet will contain instructions specific to the 
calculation. 

3. Transfer the results from the spreadsheet to the Special features section of the Pho- 
tovoltaics  and  Alternative Technologies  tab  (Figure  28.1), entering: 

4. a brief Description of the technology. 

5. the Energy saved figure, using the drop-down to select the Type of fuel saved. 

6. the Energy used figure, using the drop-down to select the Type of fuel used 

 
Where there is more than one Appendix Q technology use the New and Edit buttons to 
add those technologies to the calculation. 

Note that all the technologies which required Appendix Q with SAP 9.81 can all be 
entered directly in JPA Designer in SAP  2012. 



 

 
 
 

29 Compliance and reports 
 

 
 
 
 
 

 

Once you have entered all the data for the dwelling you can check its compliance status 
and produce worksheets and compliance reports as PDFs or in hard  copy. 

 
29.1 Checking compliance 

Once the program has enough data to complete a SAP calculation it will show the cal- 
culation results– including the TER and DER – and display pass (green) or fail (red) in the 
compliance zone at the bottom right corner of the main SAP window. If the dwelling fails 
you can hold your curser over over the compliance zone and the software will display a 
tool-tip will show the primary cause of failure (see Figure 18.2). 

You can see a more detailed report on the compliance status on the Compliance Checklist 
which lists the main criteria the SAP module tests and shows the status of the dwelling 
against each one. The compliance check window is particularly useful when the dwelling 
has failed on one of the secondary criteria, such as the efficiency of heating controls, or 
excessive losses from the hot water cylinder. 

To open the compliance checklist double click on the Compliance zone or on the View 
menu click Compliance checklist. You can use the tabs at the bottom of the Compliance 
Checklist to view all the calculation worksheets and reports. 

JPA  Designer checks: 

 
1. The TFEE and TER status for England and TER status for Wales and Scotland. 

2. Backstop values for fabric and services including: 

• maximum permissible fabric U-values; 

• maximum permissible air leakage rates; 

• design limits for fixed building services. 

3. Summer  overheating. 
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Figure 29.1:  The Sections To  Print dialogue for SAP 2012 

 
29.2 Outputting SAP results 

You can print the results of SAP calculations or produce a PDF file which is ideal for 
emailing.  The results1  can include: 

 
• SAP worksheet:  the worksheet for the SAP calculation.  The  figures here are used      

in  the EPC. 

• SAP worksheet for improved dwelling: the SAP calculation with EPC recommen- 
dations implemented. 

• TER worksheet:  the  worksheet  for  the TER calculation for the notional    dwelling. 

• DER worksheet:  the worksheet for the DER calculation for the actual dwelling. 

• FEE worksheet:  the worksheet for the DFFE calculation for the dwelling. 

• Standard case: the SAP worksheet for the CSH Ene7 standard case. This is no long 
relevant and the CSH is being abandoned. 

• TFEE: the worksheet for the notional dwelling fabric energy efficiency. 

• Heat demand: worksheet for the calculation of space and water heating energy 
demand.  The  results are used in the   EPC 

• EPC costs: worksheet for the calculation of EPC costs, emissions and primary en- 
ergy. 

• Input data:     a reflection of the information you have entered into the software. 

1Because the calculations in the various worksheets are based on slightly different assumptions  for 
climate and heat gains the results will differ, even for the same dwelling. 
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• Regulations checklist: shows the compliance status of the dwelling in a checklist 
which follows the criteria in Approved Documents L1A 2013 (England) and L1A 
2014 (Wales) and Section 6 of the Scottish Technical Standards  (2015). 

• Summer overheating:  results of the overheating  assessment. 

• Energy performance certificate (EPC): a draft energy performance certificate. As the 
SAP 2012 EPCs are produced by the Landmark or EST registers JPA Designer is no longer 
able to produce a draft    EPC. 

You must be a member of an appropriate accreditation scheme to produce a final EPC 
– see the separate guidance document for instructions. 

• Predicted Energy Assessment (PEA): the energy assessment required for off-plan sales. 

• Assessment of Zero Carbon Home: a calculation of the total emissions from a 
dwelling, including emissions associated with  appliances. 

• Code for Sustainable Homes: a calculation of items Ene1, Ene2 and Ene7.  Again,  is 
is largely redundant. 

• Htb values:  calculation of linear thermal bridging for the dwelling. 

 
To  create a PDF file of the   results: 

 
1. From the menu bar select File>Create PDF. A dialogue asks if you want to open the 

PDF when it is created. 

2. Select Yes or No.  The Sections To  Print dialogue opens (Figure 29.1). 

3. Use the tick boxes to select the outputs you want to produce. 

4. Click OK. The Print preview window opens. 

5. Use the buttons on the tool bar to view successive pages of the print out, then click 
the Print button to print the pages (Figure 12.2). The program will then create a 
PDF file of the  calculation. 

The name of the PDF file will include the JPA  Designer file name and  the  calcu-  lation 
name,  so the calculation Plot 28 in a project The  Meadows will be called    The 
Meadows.JDPtile hung wall.Plot 28.PDF. The file will be saved into the JPA 
Designer program folder or in the start-up folder you have specified. 

Note: as Windows does not allow certain characters to be used in file names you 
should ensure the calculation names in JPA Designer do not contain those char- 
acters, otherwise PDF creation will fail.  The restricted characters are ‘/   :  * ?     > 

|. 

 
To  print the results: 

 
1. Select File>Print from the menu bar (or click the Print button on the tool bar). The 

Sections To  Print dialogue opens ((Figure 29.1). 
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2. Use the tick boxes to select the outputs you want to produce. 

3. Click OK. The Print preview window opens. 

4. Use the buttons on the tool bar to view successive pages of the print out, then click 
the Print button to print the pages (Figure   12.2). 

 
You can change the printer settings by selecting File>Printer setup from the menu bar. 



 

 
 
 

30 Multiple dwellings 
 

 
 
 
 
 
 
 

Figure 30.1: The SAP window for a multiple dwellings calculation 

 
The comparative compliance methods specified in. Approved Document L1A can make  it 
more difficult for mid-floor flats and mid-terrace houses to pass, even with the same 
fabric and services standards as ground and top-floor flats and detached houses. The 
multiple dwelling calculation allows you to test the compliance on a whole block or 
terrace using average TFEE/DFEE and TER/DER values for the dwellings which comprise 
the block or terrace. The multiple dwellings calculation enables end-terrace houses or 
ground and top floor flats to compensate for mid-floor flats or mid-terrace houses. 
JPA Designer includes a multiple dwelling feature to carry out the average TER and DER 
calculations. The Multiple dwellings SAP window (Figure 30.1) has two panes: the left- 
hand one (labelled Available SAP V99 Dwellings) lists all the SAP 9.92 dwellings within 
the project which are eligible for inclusion in the multiple dwellings calculation. The right-
hand pane (labelled Dwellings in this multiple dwelling) lists all the dwellings which are 
currently included in the multiple dwellings  calculation. 
The Add and Remove buttons transfer selected dwellings between the panes.  The results   of 
the multiple dwellings calculation are shown below the panes, together with the com- pliance 
status. In order to pass the Average DFEE and Average DER must be equal to or less than 
the Average TFEE and Average TER  respectively. 
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To  carry out a multiple dwelling  calculation: 

 
1. Carry out normal SAP calculations for all the units in the  block. 

2. On the Project Manager Insert menu click Dwelling > SAP (v9.92) 2012 calcula- 
tion > Multiple dwelling. 

3. Type a name for the calculation in the Description dialogue, e.g. Block B all flats, 
and click OK. The new calculation is added to the   project. 

4. In Project Manager, double click on the new calculation. The Multiple dwellings 
SAP window opens (Figure 30.1). 

5. Click on a dwelling in the Available  SAP v99 Dwellings pane to select it,  then click 
the Add button. The dwelling is transferred to the Dwellings in this multiple 
dwelling pane. 

6. Repeat the previous step until you have all the dwellings you need in the right-hand 
pane. 

 
If you need to remove a dwelling from the multiple dwelling calculation simply select it 
and click the Remove button. 

You can print the results of multiple dwelling calculations and produce PDFs by following 
the procedures in section 29.2. 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Part VI 

Importing dwelling data from IES Virtual 
Environment 
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31 Overview of VE import 
 

 
 
 
 
 

 

The IES Virtual Environment software (VE) can be used to demonstrate Part L compliance 
for non-domestic buildings according to Approved Document L2A but does not directly 
address compliance for dwellings. Instead, VE processes the data for dwellings into a 
format which the JPA Designer SAP module can import. JPA Designer then creates a SAP 
calculation for each of the dwellings, which can then be used to demonstrate compliance 
with Part L. 

There are three stages to the import  process: 

 
1. Creating the model in VE. While this for most part follows the standard methods 

for modelling in VE, there are several additional points which are explained in 
chapter 32). 

2. Sending  the  data  from VE to JPA  Designer (see chapter  33). 

3. Finalising calculations in JPA Designer and checking compliance. This step is re- 
quired because the data formats for building services differ between VE and the SAP 
methodology. chapter 34 describes the additional data required in JPA Designer. 

 
The import process is particularly useful for apartment blocks, including schemes where 
part of a block falls under Approved Document L2A and part under  L1A. 

Note that the procedure does not make any changes to the VE model. 
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32  Preparing  a VE model for SAP 
 

 
 
 
 
 

 

The VE model is defined in the normal way in ModelIT, with the geometry and construc- 
tions. A model may include one or more dwellings and may also include non-domestic 
spaces for mixed use schemes. 

Once the model has been constructed there are two additional settings required for the 
conversion  procedure: 

 
• assigning rooms to dwellings using the UK dwellings room  groups; 

• identifying the dwelling living area. 

 
32.1 Defining dwellings with room  groups 

 
 

 

Figure 32.1: Setting the regulations to UK Dwellings for  export 
 

 

 

Figure 32.2:  Adding room groups 

 
Prior to export the rooms in each dwelling have to be assigned to the appropriate dwelling 
in the UK Dwellings room grouping scheme.  To  define  dwellings: 

 
1. Save the project and switch to the VE Compliance (UK & Ireland)  module. 

2. On the toolbar set the Regs list to UK Dwellings (see Figure 32.1).  VE now adds a  
new room group scheme:  UK  Dwellings. 
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Figure 32.3: The assign button for assigning rooms to a room group 

 
3. Click the Edit Room Groups button. 

4. In the Edit Room Groups dialogue create a room group for each of the dwellings in 
the model in the UK Dwellings scheme: Click the plus button to add room group 
and assign it a name (Figure 32.2). 

5. Select the rooms which comprise the first dwelling. 

6. Click the Assign button (Figure 32.3). 

7. In the Assign Room Group dialogue make sure the Room Grouping Scheme is set 
to UK Dwellings, then select the group (dwelling) . Click OK. 

8. Repeat the previous three steps to assign rooms to other dwellings. 

Once you have assigned all the rooms you intend to export (which may well only be a fraction 
of the rooms in the model) you can review the assignments by setting the Room group list to 
UK Dwellings. 

 
32.2 Identifying the dwelling living area 

 
 

 

Figure 32.4: Defining the living area 

 
For  SAP calculations one part of the dwelling is defined as the living area (see sec-   tion 
19.2), which is heated to a slightly higher temperature than the rest of the dwelling. 
Before export, you must identify the room, or rooms, within each dwelling which will be 
treated as the living area in JPA Designer by changing the Room type from Heated space 
(the standard setting for rooms in a dwelling) to Dwelling living area. 
For each dwelling: 

1. Select the room(s) which will form the living area. 

2. In the Room settings section set the Room type to Dwelling living area (Figure  32.4). 



 

 
 
 

33 Exporting from VE 
 

 
 
 
 
 
 

In the export process VE creates a several files containing the geometry data for the se- 
lected dwellings and passes them to JPA Designer, which then imports the data and cre- 
ates a SAP calculation for each dwelling. During import stage JPA Designer offers two 
options which affect the import format: 

• the SAP version, and 

• how individual elements of the VE model are treated. 

 

33.1 SAP version 

Currently, there are two different versions of SAP in use across the UK: 

• SAP V9.90 (2009): this version is valid for Scotland (until October 2015) and for 
Northern Ireland. 

• SAP V9.92 (2012): valid for England to Part L 2013, and for Wales to Part L 2014. SAP 
V9.92 will be used in Scotland from October 2015, although it may be used  for 
preliminary calculations prior to that date. 

 

33.2 Consolidation of elements 

VE defines each bounding surface of a room as a separate element, potentially producing 
a large number of elements in the JPA Designer Walls, roofs and floors tab. JPA Designer 
can reduce the number of elements by consolidating elements of the same type into one 
element with an area equal to the total area of the originals. There are three ways of 
importing  elements: 

• Each element in VE becomes an element in JPA Designer. This one-to-one corre- 
lation produces a large number of elements in the Walls, roofs and floors tab, but 
allows individual elements to be tracked between the two programs. 

• All the VE fabric elements of the same type within a room are consolidated into one 
element in JPA Designer. For example, if a room is bounded by two internal partition 
elements of the same construction with areas of 10 and 15 m2 then in JPA Designer 
there will be one internal wall element with an area of 25 m2. This option reduces 
the number of elements in JPA Designer while allowing bounding elements of rooms 
to be distinguished. 
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• All the VE fabric elements of the same type within a dwelling are consolidated into 
one element in JPA Designer. For example, all the internal partition elements of  the 
same construction within all rooms of the dwelling will be consolidated. This 
minimises the number of elements produced in JPA Designer, making it easier to 
see the overall picture and to adjust the U-values of elements when required. 

 
However, no matter which consolidation option is chosen, JPA Designer does not con- 
solidate wall elements which contain openings. 

 
33.3 The export procedure 

 

 

Figure 33.1:  Starting the export   process 
 

 

 

Figure 33.2: The IES Import Options dialogue 

To export a dwelling or set of dwellings: 

1. In VE, in the UK Dwellings - Analysis tab click Compare Dwelling and Target Emis- 
sion rates (Figure 33.1). 

2. At the IES Import Options dialogue (Figure 33.2): 

a) Select the version of SAP which you want to be used to create the SAP calcu- 
lation. 

b) Select the consolidation method. 

c) Click OK. 
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3. The import is completed. 

You may see a warning about the boiler database being out of date. You can ignore 
the warning at this stage. There are instructions for updating the boiler database at 

4. JPA Designer displays the Description dialogue (see Figure 3.5). Either accept the 
suggested name for the calculation (which is derived from the VE file name), or type 
your own and click OK (see section 3.7 for more details about adding calculations 
to projects). 

5. A SAP calculation is created for each dwelling, and is listed in the JPA  Designer 
Project Manager window. 



 

 
 
 

34 Completing the calculation 
 

 
 
 
 
 

 

Because of the differences in data structure between VE and SAP the export process does not 
transfer all the information required for a SAP calculation,  the additional data has         to be 
entered to complete the calculation. This section identifies the additional data required. 

 
34.1 Dwelling dimensions 

For England and for Wales the only additional data required in the Dimensions tab is the 
fraction of low energy lighting. Enter the total number of lamps and the number of low 
energy lamps. Lighting conventions are described in section  19.3. 

In addition, for Scotland, the number of dwellings above and below a flat or maisonette 
are also required. These values are entered in the Number of dwellings above and Num- 
ber of dwellings below boxes (see section 19.5). 

 
34.2 Ventilation 

Most of the data in the Ventilation tab has to be entered in JPA Designer, including: 

 
• Pressure testing details; 

• Ventilation strategy; and, where relevant, 

• Ventilation efficiency data. 

 
Ventilation data is described in chapter 20. 

 
34.3 Walls, roofs and floors 

There are three sets of data for the building fabric which are entered in the Walls, roofs 
and floors tab: 

 
• Element areas and U-values:These are imported from VE. The only time further data 

will be required is if the U-value of an element has to be adjusted to take account 
of the effect of an adjoining unheated space. This can be done using the procedure 
described in section 21.1. 
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• Thermal mass data: This is currently not exported from VE so has to be entered in 
JPA Designer. The simplest method is to set the Thermal Mass Parameter to one of 
the default values offered in the Thermal mass list: 

 

– Tick User defined Thermal Mass Parameter. 

– Set the Thermal Mass to low, medium or heavy. 

Those categories are defined in Table 1e of the    SAP 2012 document. 

• Junction heat loss data: this is currently not imported from VE. It should be entered 
either: 

 

– using the default y-value of 0.15 for the dwelling; or, 

– by entering the length and psi-value for all junctions in the dwelling using the 
Calculate Htb dialogue, which is accessed from the Calculate it  button. 

 
34.4 Openings 

 

 

Figure 34.1: The Copy buttons for openings 

 
The import process brings in much of the data about openings. For each opening in the 
dwelling that includes: 

 
• the element the opening belongs   in; 

• its area; 

• its U-value; 

• the glazing type. 

 
The remaining data, which has to be entered in JPA Designer, is: 

 
• the frame type; 

• the width of the air gap in double glazing; 

• the g-window value (a measure of the transmission of solar energy through the 
glazing). 

• the over shading; 

• data on blinds, curtains and internal shutters. 
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As setting these items can be time-consuming – particularly if you are working on several 
dwellings at the same time – there are two buttons in JPA Designer which allow you to 
copy settings from one opening to: 

 
• all the other openings in the same dwelling; or, 

• all the other openings in the same project. 

 
The buttons are found at the bottom of the Doors, windows and rooflights dialogue 
(Figure 34.1. 

 

Figure 34.2: Import status for the sections of the Doors, windows and rooflights dialogue. 
Sections in blue are imported from VE. Sections in red need to be checked.  The  section       in 
green contains the Copy   buttons. 

 
To enter the additional data on openings: 

 
1. In the Openings tab double click on one of the listed openings. The Doors, Win- 

dows and Rooflights dialogue opens (Figure 34.2). 

2. The following items will already be completed: Opening type, Opening within, 
Glazing, U-value, Area, Opening orientation. There is no need to change the val- 
ues. 
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3. Set the Double glazing air gap and the Frame type. 

4. Check the g-window value, which is usually defined automatically from the Glaz- 
ing. If you have specific values for the project set the Source of U-value to BFRC 
data and enter a g-window value. 

5. The Overshading (which is the extent to which the sky is obscured by trees and 
neighbouring buildings) may be left at Average or unknown: you need only adjust 
this if the degree of overshading is greater. 

You should never reduce the overshading to Very little for a new dwelling: there is 
no way of telling this will be the case throughout the life of the  dwelling. 

6. The Blinds, curtains and external shutters settings affect the amount solar flux 
reaching the inside of the dwelling. Adjusting the settings can reduce the risk of 
solar gain. However, unless initial analysis indicates there is a significant risk of 
overheating there is no need to inserting this data. 

7. With the changes made click either Copy these values to all this building’s windows 
or Copy these values to all the buildings in this project. 

8. Click OK. 

 

34.5 Building services 

The parameters for building services are different in VE and SAP, so you must enter build- 
ing services data in JPA Designer, following the guidance in the SAP section of this man- 
ual: 

• Water heating: chapter 23. 

• Primary heating: chapter 24. 

• Secondary heating: chapter 25. 

• Overheating: chapter 26. 

• Cooling: chapter 27. 

• Renewables: chapter 28. 

 

34.6 Checking compliance 

Once you have entered all the data for the dwelling you can check its compliance status. 
The program will display pass (green) or fail (red) in the compliance zone at the bottom 
right corner of the main SAP window. If the dwelling fails you can hold your curser over 
over the compliance zone and the software will display a tool-tip will show the primary 
cause of failure (see Figure 18.2). 
Click on the compliance zone to open the Compliance Checklist which lists the status   of 
the dwelling against each of the criteria defined in Approved Document L1A. This is 
particularly useful when the dwelling has failed on one of the secondary criteria, such as 
the efficiency of heating controls. 
You can use the tabs at the bottom of the Compliance Checklist to view: 
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• the  SAP worksheet; 

• the  TER worksheet; 

• the  DER worksheet; 

• the  Overheating  risk assessment. 

 
Once you have reviewed the results you can then make changes to the calculation. 
Changes to the building services can be carried out within JPA  Designer.  Changes to   the 
building geometry should be made in VE and then re-importing the dwelling into JPA 
Designer. 

On exporting the dwelling a second time JPA Designer will give you an option to either 
re-import the data into the selected dwelling or create a new dwelling. 

 
34.7 Reporting results 

You can print the results of SAP calculations or produce a PDF file which can be opened 
on any computer with the free Adobe Reader software installed; PDF files are ideal for 
emailing. For both print and PDF you can select which parts of the results you want to 
include in your output. 



 

 
 
 

35 Exporting several dwellings at  once 
 

 
 
 
 
 

 

One of the benefits of the VE import is the ability create SAP calculations for many 
dwellings at once. However, the services and other parameters have to be set in JPA 
Designer to complete the calculations. To  speed up that process JPA Designer includes  a 
number of functions which can copy data between several dwellings. 

 
35.1 Openings 

As section 34.4 explains, incompatibilities between the definitions of openings in VE and 
JPA Designer means several of the items for openings have to be set in JPA Designer. As 
each dwelling in a project will have six or more openings that could be a time consuming 
process, but there are two buttons on the Edit Doors, Windows and Rooflights which can 
speed up the process: 

 
• Copy these values to all this buildings windows: using this button copies the fol- 

lowing items to all other other windows in the dwelling: 
 

– Double-glazing air gap. 

– Frame type. 

– BFRC g-window value. 

– Overshading.  It does not change the Glazing, U-value or Orientation. 

• Copy these values to all the buildings in this project: using this button copies the 
same items to all other windows in all other dwellings in a project. That allows you 
to define those items once, but have the setting applied to multiple dwellings. 

 
Also, if you need to adjust the U-values of several openings you can select the openings 
(use the <Shift> key to make a multiple selection) then click Change U-value of selected 
openings to re-set the U-values. 

 
35.2 Building services 

Once you have set up the building services (hot water, primary and secondary heating) 
for one dwelling you can return to the Project Manager window and copy those values 
to all the other dwellings: 
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1. In the Project Manager window click once on the dwelling which has its services 
configured. 

2. On the Edit menu click Copy non-geometry details to all other 9.90  dwellings. 

3. At the confirm dialogue click  OK. 

4. The building services data for that dwelling will be copied to all the other dwellings. 

 

Note: the copy non-geometry option should only be used on 9.90 calculations, 
not 9.92 calculations. There is a separate option for 9.81 calculations. 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Part VII 

Program options and reference 
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36 Program options 
 

 
 
 
 
 
 

There are many ways in which you can customise the performance and outputs of JPA 
Designer.  Most of the options are controlled from the Options dialogue. 

The Options dialogue box has five  tabs: 
 

• General; 

• Logo and signature; 

• Email; 

• Other; 

• Defaults. 
 

The tabs are described in the following sections. 

Above the tabs is the Identity selector which is used to switch between identities for 
editing (see section 2.8). 

To open the Options dialogue, in Project Manager select Options from the menu bar. 
Any changes you make to the program options will be saved when you click OK. If you 
close the dialogue by clicking Cancel the changes will not be   saved. 

 
36.1 General 

The General tab has the following controls (those shown in blue in the dialogue are 
associated with user identities (see section 2.8):: 

 

• Printer margins:  enables you to set the page margins for printing and for PDFs.    If 
you are using headed paper you can set the top margin for the first page to be 
greater than that of the second page, which can be printed on continuation paper 
or blank paper. 

• Company name and address: the details entered here will appear on print outs and 
PDFs of U-value and  SAP  calculations.  The  data  which  appears  here  depends  on 
the identity which has been been selected at the top of the Options dialogue. 

• Options: select which items which should appear on the print outs and determine 
whether the program should attempt to make a back up copy of the project file.  There 
is unlikely to be a need    to 
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• CSH Assessor Name and CSH Assessor No: Code for Sustainable Homes assessors 
can enter their details here to have them appear on CSH reports in the SAP module. 

• Uvalue Disclaimer: the disclaimer text to appear on print outs and PDFs of U-value 
and calculations. 

• SAP/Nondwell disclaimer: the disclaimer text to appear on print outs and PDFs of 
SAP calculations. 

• Default SAP location: determines the country which will be used for all new SAP 
calculations.  This setting can be overwritten for individual calculations. 

• Start-up folder:  sets the default folder for saving and opening JPA  Designer files.    Use 
the Select button to set the start-up   folder. 

• User data folder: Specifies the folder in which user configured data is stored. This  
includes user categories and materials for U-value calculations, client address data, and 
user defined mechanical fixing and bridging defaults. By default, for Windows 7 
onwards this will be C:\ProgramData\JPA\JPA Designer. 

You can view the folder using the Open button, or change its location with the 
Select button. However, you must be sure to have permissions for your chosen 
folder. It is best to keep the user data folder on the PC and not on a network drive. 

• Show start-up dialogue: determines whether the program will display the dialogue 
offering different actions when the program    launched. 

• Open destination folder after print to PDF: if this option is ticked then after creating 
a PDF from a calculation JPA Designer will open a window for the folder which 
contains the new PDF. 

• Check for programme updates: lets you specify whether or not the software will 
check for updated versions of JPA Designer. For more information see section 2.5. 

• Suppress project region message: prevents JPA Designer asking if you want to use 
the same project region when inheriting user data which has been defined at the 
project level. If you work exclusively in one region then it best to tick this  option. 

• Use proxy server: in some organisations access to the internet, which JPA Designer 
requires for licence checking, is managed through a proxy server. It may be neces- 
sary to enter the proxy server details in order to enable licence checking. 

 
36.2 Logo and signature 

The Logo and signature tab contains the following controls (those shown in blue in the 
dialogue are associated with user identities (see section 2.8): 

 
• Logo position: JPA Designer can add your company logo to print outs. Use these 

settings to determine the position of the logo. The logo file must be a 256 colour 
bitmap with the file extension BMP, and it must be in the JPA Designer folder. Enter 
the name of the file in the text box: do not include the path (e.g. enter logo.bmp 
not c:\Program files\JPATL\JPA Designer 981\logo.bmp). 
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The logo details can be different for each identity you have set up in JPA Designer, 
enabling you to customise reports for each one. 

• Address position:  These settings determine the position of your company address    on 
print outs and PDFs. Enter the address itself in the General tab. 

Used together the logo and address positions can be used to match company sta- 
tionery. 

 
Certificate signature position: originally used to add a scanned in signature to the SAP 
certificate these option now has no function. 

TIMSA Logo: if you are issuing U-value calculations under the BBA/TIMSA U-value com- 
petency scheme you can use these boxes to include the scheme logo on reports. If you 
tick the default box the logo will be selected for all reports in the Sections to Print dia- 
logue: you can override the default option for individual  calculations. 

 
36.3 Email 

In future versions of the program you will be able to email calculations directly from JPA 
Designer. There is no need to provide this information in the current version of the 
program. 

 
36.4 Other 

The Other tab lets you set various calculation options. The options for U-value calcula- 
tions are: 

 
• Beam and block screed conductivity: sets the default conductivity used for sus- pended 

ground floors. The standard conductivity of 1.15 W/mK represents a stan- dard  
cement:sand screed. 

• Mechanical fastener calculations: JPA Designer can calculate the correction for 
mechanical fasteners using the method in ISO 6946:1997 or ISO 6946:2007. There 
is no reason not to use the latest version. 

• Two directional heat flow: building codes and standards in Australia and New 
Zealand require the thermal resistance of fibrous insulation to be adjusted down- 
wards at temperatures above 23ºC to allow for the observed decrease in perfor- 
mance at higher temperatures. This feature is not applicable to the UK. 

• Round thermal resistance down: the ISO product standards for factory formed in- 
sulation require resistances for those products to be rounded down to the nearest 
0.05 m2K/W. Ticking this box activates rounding for products which are marked as 
thermal insulation (see section 7.2). 

• Set vapour resistance of layers above vented cavity to zero: when this option is 
chosen adding a vented cavity to a calculation will result in the vapour resistances 
of all layers outside of the cavity being reduced to zero. The option is derived from 
BS 5250:1989 and is intended to replicate the effect of ventilation in reducing the 
risk of interstitial condensation. 
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As the approach was not included in subsequent editions of BS 5250 it is best not to 
use the option unless you have a good reason to do so, and are aware of the effects 
on condensation risk analysis. 

• Print total thickness: when selected, the U-value report will show the thickness of 
the construction, based on the total thickness of the individual layers. 

• Print water mark text: prints the selected text as a light grey watermark across the 
calculation report. Specify the wording, angle and size of the watermark. Typically used 
to show ‘draft’ across a    calculation. 

 
The options for SAP calculations: 

 
• Move preview form to top left of screen: changes the default location of the results 

preview   window. 

• Very  long preview form:  a long preview  form  gives enough space to see all the   data 
for dwellings with numerous elements and openings. 

• Omit SAP worksheet box numbers: the SAP worksheets, such as those for the TER  and 
DER normally include the box numbers, to make it easier to track through the 
calculations.  Use this option to prevent the box numbers form being displayed. 

 
EPC test environment: used when testing EPC lodgement systems. For normal lodge- 
ments leave this box unpicked. 

XML version: sets the format of the data submitted for  EPC  lodgements.  This  should 
always be set at V15  17. 

 
36.5 Defaults 

The Defaults tab allows default values to be set for some items in U-value and SAP cal- 
culations.  Any values set here will automatically applied to any new  calculation. 

Currently there are no values which apply to U-value calculations, but for SAP calcula- 
tions you can set default values for: 

 
• Solar panel over shading: see section 23.10; 

• Over shading of openings: see chapter 22; 

• Window opening condition for the overheating assessment: see chapter 26; 

• Terrain  type for wind turbines:  see section   28.2. 
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37 Customising  JPA Designer 
 

 
 
 
 
 

 

37.1 Creating environmental conditions data sets 

You can build up and save sets of internal and external environmental conditions to use 
in condensation risk analysis. This is particularly useful when examining air-conditioned 
buildings which have design values for temperature and humidity. 

User data is stored in a file Env_user.txt which is kept with the other user data files in 
c:\ProgramData\JPA\JPA Designer (file location correct for Windows 7 - see Technical 
note 2012/01 for other versions of Windows). Currently, the only way to add data sets  is 
to edit Env_user.txt in a text editor, such as Notepad (Figure 37.1). Before editing 
Env_user.txt make sure JPA Designer is not running. 

 

Figure 37.1:  Editing the Env_user.txt   file 

 
Within Env_user.txt the data for an external location or an internal design condition is on one 
line,  with each line separated by a return.  On each line, the different items of data   are 
separated by the pipe character, |, with no spaces before or after the pipe. The final character 
on every line is also a     pipe. 

The data items  are: 

 
• Item 1: whether the set is for internal conditions, 0, or external conditions, 1. 

• Item 2:  whether the set is system data, 0, or user data,   1. 

• Item 3: a text description of the data set. This appears in the Building location or 
internal conditions lists, which are sorted alphabetically using the text description. 
This item can start with the tilde character ( ), which does not appear on lists, but 
controls the way in which items 4–27 are interpreted. 
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• Items 4–27: these are the monthly temperature and relative humidity figures. Tem- 
peratures should be entered in degrees centigrade and relative humidity as a per- 
centage. The order of the data depends on whether item 3 starts with a tilde (∼). 

– If item 3 has a tilde the mean monthly temperatures should be entered in a se- 
quence starting with January,  followed by the relative humidity figures,  start-  ing  
with  January  (so:   Jan temp|Feb temp| … |December temp|Jan 
%rh|Feb %rh| etc.) 

– If item 3 has no tilde the temperature and relative humidity values for each month  
should  follow  each  other  (so:  Jan temp|Jan rh|Feb temp|Feb 
%rh| etc). 

• Item 28: the country code. UK, 0. Republic of Ireland, 1. Australia, 2.  New  
Zealand, 3.  Asia, 4.  Middle East, 5. 

• Item 29: applies to external environmental sets and indicates whether internal con- 
ditions should be calculated on the basis of continental conditions, 1, or maritime 
conditions, any other value. This item is used only when internal conditions are to 
be derived from the external conditions: it is not used if fixed internal conditions 
are specified. 

As an example: 
1|1|Newcastle Airport|3.4|92|…|4.2|89|0|0| 

This shows: 

• External data (1). 

• User data (1) 

• Location, with no tilde. 

• Paired monthly values for temperature (3.4 and 4.2) and relative humidity (92 and 
89). 

•  UK (0) 

• Maritime climate (0). 

Once the environmental conditions have been entered and saved in Env_user.txt and JPA 
Designer started, the new data sets will show up in the internal conditions list. Note that 
the conditions will only show if their region matches the region selected for analysis. 
If there are several users of JPA Designer within the same organisation the Env_user.txt 
file can be set up on one PC then copied to the others, ensuring everyone is using the 
same data sets. 

 

37.2 Sharing a user-defined materials between computers 

The user-defined database of materials in the JPA Designer U-value module enables users 
to build a library of commonly-used materials. Where there are several users running JPA 
Designer in the same organisation it is helpful for everyone to use the same material 
library to provide consistently in calculations. This section describes how to do  that. 
The user categories and materials are stored in two files:  USERCATS.TXT and USER- 
MATS.TXT1. By default these files are stored in the JPA Designer program data folder, 

1Depending on how Windows is configured the TXT extension may not be visible: that doesn’t matter. 
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which is usually (Windows 7) in c:\ProgramData\JPA\JPA Designer.  The easiest way of 
ensuring to computers have  the same user-defined materials is to copy those two files   from 
one PC and then paste them into the corresponding folder on the other. 

You can transfer the files by email, across a network, or by using a plug-in USB stick drive 
(also known as a ‘thumb drive”. 

To  copy the files between PCs using a USB  stick: 

 
1. Make sure JPA Designer is not running on either computer. 

2. Open Windows Explorer on the PC with the data and go to c:\ProgramData\JPA\JPA 
Designer. 

3. Select and copy USERCATS.TXT and USERMATS.TXT. 

4. Insert a USB stick and paste the two files onto it. 

5. Remove the USB stick from the first PC and insert it into the second. 

6. Open Windows Explorer on the PC and go to the USB  stick. 

7. Copy USERCATS.TXT  and USERMATS.TXT. 

8. In Windows explorer go to c:\ProgramData\JPA\JPA Designer. 

9. Past the two files into the folder. Windows will ask if you want to replace the existing 
files with the same name. Select  replace. 

10. Open JPA Designer: the products database will now include the copied user-defined 
products. 

 
If you want to transfer the files by email, copy and paste the files into an email and send 
it to the second PC, then copy and past the files from the email onto the second PC. 

You may find that your PC seems to be missing c:\ProgramData\JPA\JPA Designer: this 
is because theWindows ProgramData folder as a hidden folder, so by default it is not 
shown in the folder list. If you can’t see the folder you will need to set Windows to show 
hidden folders before copying the data across. The following instructions apply to 
Windows 7, but similar procedures will apply to other versions of  Windows: 

 
• Open the Folder Options Control panel. 

• Select the View tab (Figure 37.2). 

• In the Advanced settings list set Hidden files and folders to Show hidden files, 
folders and drives. 
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Figure 37.2: Changing the View settings for hidden  folders 



 

 
 
 

38 Menu reference 
 

 
 
 
 
 

 

38.1 Project manager window 

File: 

 
• New project:  Creates a blank JPA Designer project. 

• Open project:  Opens an existing JPA Designer  project. 

• Save project: Saves the current project. 

• Save  project as:  Saves the current project with a different   name. 

• Save project as Template: allows you to save the project as template file for use 
with the template feature, see section 3.8. 

• Merge a project from disk into this Project: Copies all the calculations from the 
selected  calculation  to  the  calculation  which  is  currently open. 

• Print all U-value calculations in this project to PDF: produces PDF reports of all 
U-value  calculations. 

• Import JPA U-value file into this Project: Imports a U-value calculation from JPA 
Uvalue 

As JPA Uvalue was superseded by JPA Designer in 2002 this function is unlikely to 
be  used. 

• Import JPA SAP file into this Project: Imports a SAP 9.60 calculation from JPA SAP 
v2 into JPA Designer as a SAP 9.70   calculation. 

As JPA SAP v2 was superseded in 2002 this function is unlikely to be used. 

• Import IES file: Imports data from IES’ VE software into JPA Designer SAP calcula- 
tions. 

• Import XML: imports SAP EPC lodgement data in XML format as a SAP 2009 or SAP 
2012 calculation. 

• Download and re-load product characteristics datafile: downloads the latest ver- 
sion of the SAP product data files (SAP 2005 boiler database, SAP 2009 and SAP 
2012 PCDF) and loads  them. 
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• Re-load Product Characteristics Data File: loads a new copy of the data files from 
an existing download. 

• Exit:  closes JPA Designer. 

• Export all SAP summaries to Excel:  Exports the summary data for all SAP calcula-  
tions in the project to an Excel    spreadsheet. 

• Export selected to XML: Exports the data for the selected SAP calculation to the     
XML  format  used  for  lodging EPCs. 

• Export all to XML: Exports the data for all SAP calculations in the project to the XML 
format  used  for  lodging EPCs. 

• Export Condensation to Excel: exports the results of a condensation risk analysis to 
an Excel spreadsheet 

• Journal path: Sets the path for storing the Journal file used by JPA Designer to store 
some user data. 

• Clear journal: Deletes the user data stored in the journal. 

 
The menu finishes with a list of recently opened files. 

Edit 

 
• Project address: Opens the Project address dialogue. 

• Edit selected item: Opens the selected calculation. 

• Duplicate item: Creates a copy of the selected calculation, offering you the oppor- 
tunity to rename it. 

• Rename selected item:  Changes the name of the selected calculation. 

• Copy non-geometry details to all  other  9.81  dwellings:  Sets  the  building  services 
for all SAP 9.81 calculations to those of selected calculation. 

Used when importing multiple dwellings from   VE. 

• Copy selected SAP 9.70 2001 dwelling to a V9.80 2005 dwelling:  creates a copy    
of the selected SAP 9.70 calculation and updates it to version 9.80 of  SAP. 

• Copy selected SAP 9.8x 2005 dwelling to a V9.90 2009 dwelling: creates a copy 
of the selected SAP 9.80 or 9.81 calculation and updates it version 9.90 of SAP. 

• Copy selected SAP 9.90 2009 dwelling to a V9.92 2012 dwelling:  creates a copy    
of the selected SAP 9.90 calculation and updates it version 9.92 of  SAP. 

• Copy selected SAP 9.90 2009 dwelling to a V9.8x 2005 dwelling:  creates a copy    
of the selected SAP 9.90 calculation and downgrades it to version 9.8x of  SAP. 

• Copy selected SAP 9.92 2012 dwelling to a V9.90 2009 dwelling:  creates a copy    
of the selected SAP 9.92 calculation and downgrades it to version 9.90 of  SAP. 

• Main screen font: Changes the font used in JPA Designer. 
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• User & Security codes:  Opens the User & Security codes  dialogue. 

Insert 

• U-value calculation:  Adds a blank U-value or R-value calculation to the   project. 

• Psi-value calculation: adds a blank psi-value assistant calculation to the  project. 

• Dwelling/SAP  (V9.92/2012) calculation 

– Single dwelling:  adds a blank SAP 9.92 calculation to the  project. 

– Building containing multiple dwellings: adds a blank calculation for average 
TFEE/DFEE and TER/DER to the project. 

• Dwelling/SAP  (V9.90/2009) calculation 

– Single dwelling:  adds a blank SAP 9.90 calculation to the  project. 

– Building containing multiple dwellings: adds a blank calculation for average 
TFEE/DFEE and TER/DER to the project. 

• Dwelling/SAP  (V9.81/2005) calculation 

– Single dwelling:  adds a blank SAP 9.81 calculation to the  project. 

– Building containing multiple dwellings: adds a blank calculation for average 
TFEE/DFEE and TER/DER to the project. 

• Dwelling/SAP (V9.80 2005) calculation 

– Single dwelling:  Adds a blank SAP 9.80 calculation to the   project. 

– Scottish simplified approach single dwelling: Adds a blank SAP 9.80 calcula- 
tion using reduced data set for Scotland. 

– Building containing multiple dwellings: Adds a blank calculation for average 
TER/DER calculations for flats or terraces. 

• Dwelling/SAP (V9.70 2001) calculation: adds a blank SAP 9.70 calculation to the 
project. 

• rdSAP: adds a blank rdSAP calculation to the  project. 

Feature in development 

• Water efficiency calculation: adds a blank water efficiency calculation to the project. 

Feature in development. 

• Solar Panel & Wind Turbine  payback calculation:  adds a payback calculation to  
the project. 

Options 
Opens the Options dialogue. 
Help 

• Help:  opens the on-line help for JPA Designer. 

• About: displays program version and build number and registration details. 
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38.2 U-value module 

File 

 
• Return to project manager: exits U-value calculation and returns to Project Manager 

window. 

• New project:  Creates a blank JPA Designer project. 

• Open project:  Opens an existing JPA Designer  project. 

• Save project: Saves the current project. 

• Save  project as:  Saves the current project with a different   name. 

• Print:  print  the  calculation report. 

• Create PDF: create a PDF of the calculation report. 

• Printer setup:  set up a printer for use with JPA    Designer. 

• Font: select the font used for printing and for PDFs. 

• Exit:  closes JPA Designer. 

• About: displays program version and build number and registration details. 

• Journal path: Sets the path for storing the Journal file used by JPA Designer to store 
some user data. 

• Clear journal: Deletes the user data stored in the journal. 

• Help:  Opens the on-line help system. 

 
Edit 

 
• Project information: opens the Project information dialogue. 

• Construction type: opens the *Edit construction dialogue. 

• Environmental conditions: opens the Environmental conditions dialogue. 

• Layer: opens the Edit material dialogue for the layer selected in the layer list. 

• Move selected variable layer into construction: converts a variable layer calculation 
into a normal calculation by transferring the selected layer into the layer list and 
removing the variable layer place holder. 

• Database: opens the Edit database dialogue for editing. 

• Cut layer to clipboard: removes the selected layer from the layer list but leaves the 
information on the clipboard. 

• Delete layer: removes the selected layer from the layer list without saving the infor- 
mation  to  the clipboard. 
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• Copy layer to clipboard: copies the data on the selected layer into the  clipboard. 

• Paste layer from clipboard: creates a new layer above the selected one, using the 
layer data held in the clipboard. 

 
Insert 

 
• Layer  from database:      opens the Product database dialogue for adding layers. 

• Variable layer: inserts a variable layer into the layer list above the selected layer. 

• Tapered layer: inserts a tapered layer into the layer list above the selected layer. 

• Blank layer: inserts a blank layer into the layer list above the selected layer. 

 
View 

 
• Dewpoint graph: opens the dewpoint window to show the dewpoint graph. 

• Results table: opens the pre–2003 condensation results window. 

• ISO 13788 Condensation table: opens the results window for the latest condensa- 
tion risk method. 

 
Help 

Opens the on-line help for JPA Designer. 

 
38.3 Psi-value assistant 

File 

 
• Return to project manager: exits psi-value calculation and returns to Project Man- 

ager  window. 

• Print: prints a calculation report. 

 
Edit 

 
• Project  Information:  opens  the  project  information dialogue. 



CHAPTER 38.  MENU REFERENCE 205 
 

 
 

38.4 SAP modules – single dwellings 

New 

 
• Return to project manager: exits SAP calculation and returns to Project Manager 

window. 

• New project:  Creates a blank JPA Designer project. 

• Open project:  Opens an existing JPA Designer  project. 

• Save project: Saves the current project. 

• Save  project as:  Saves the current project with a different   name. 

• Print:  print  the  calculation report. 

• Printer setup:  set up a printer for use with JPA    Designer. 

• Create PDF: create a PDF of the calculation report. 

• Export checklist to RTF: creates an RTF file of the regulations compliance checklist 
(RTF = Rich Text Format, which can be opened by Word and other word processors. 

• Export XML: create and XML file of the calculation data. 

• Font: select the font used for printing and for PDFs. 

• Exit:  closes JPA Designer. 

• Journal path: Sets the path for storing the Journal file used by JPA Designer to store 
some user data. 

• Clear journal: Deletes the user data stored in the journal. 

 
Edit 

 
• Project information: opens the project information dialogue. 

• Dwelling dimensions: opens the Dwelling dimensions tab of the SAP Worksheet 
dialogue. 

• Ventilation: opens the Ventilation tab of the SAP Worksheet dialogue. 

• Walls, roofs and floors: opens the Walls, roofs and floors tab of the SAP Worksheet 
dialogue. 

• Windows, doors and rooflights: opens the Openings tab of the SAP Worksheet 
dialogue. 

• Water heating: opens the Water heating tab of the SAP Worksheet dialogue. 

• Primary heating:  opens Primary heating tab of the SAP Worksheet dialogue. 

• Secondary heating system: opens the Secondary heating tab of the SAP Worksheet 
dialogue. 
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• Summer overheating: opens the Overheating tab of the SAP Worksheet dialogue. 

• Photovoltaic and alternative technologies: opens the PV & Alt Tech tab of the SAP 
Worksheet dialogue. 

 
View 

 
• Compliance checklist:  opens the Results window at the compliance checklist. 

• SAP worksheet:  opens the Results window at the SAP rating worksheet. 

• TER worksheet:  opens  the  Results  window  at the TER worksheet. 

• DER worksheet:       opens the Results window at the DER worksheet. 

 
Help 

 
• Help:  opens the on-line help for JPA Designer. 

• About: displays program version and build number and registration details. 

 
38.5 SAP modules – multiple dwellings 

File 

 
• Return to project manager: exits the multiple dwellings calculation and returns to 

Project Manager window. 

• Open project:  Opens an existing JPA Designer  project. 

• Save project: Saves the current project. 

• Save  project as:  Saves the current project with a different   name. 

• Print:  print  the  calculation report. 

• Printer setup:  set up a printer for use with JPA    Designer. 

• Create PDF: create a PDF of the calculation report. 

• Font: select the font used for printing and for PDFs. 

• Exit:  closes JPA Designer. 

• About:  shows version number and registration details for     JPA  Designer. 

• Journal path: Sets the path for storing the Journal file used by JPA Designer to store 
some user data. 

• Clear journal: Deletes the user data stored in the journal. 

• Help: opens on-line help. 


